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Introduction

Overview

Traditionally many OS 2200 clients have used editors like ED and IPF to maintain their 3GL
programs such as COBOL, FORTRAN and C. Eclipse is the leading open source IDE and is based on
Java. Unisys has added a plug-in to Eclipse to support the development of legacy 3GL programs
developed in COBOL, FORTRAN, C and other languages. The Unisys plug-in also assists in the
development of composite applications.

The Unisys ClearPath OS 2200 IDE for Eclipse provides many features including:
¢ Windows containing the entire program source
e Easy navigation being open windows
o Windows GUI features like search, copy/paste & drag/drop
e Content Assistant to provide COBOL structures and statements for the programmer
e Use of different colours for reserved words, comments and variables
e Error windows for compilations with links to source code lines
e Ability to update OS 2200 source files including ECL and COBOL
o Ability to build a project (e.g. compile programs) with compilation on the OS 2200 host
e Compare differences with older code versions
e Support COBOL, Java, Java EE, C and other development languages from a single tool
e Supports interactive PADS debugging for UCS programs.

As the ClearPath OS 2200 IDE for Eclipse runs on the programmer’s PC, OS 2200 CPU cycles
associated with editing code are off-loaded from the OS 2200 host. The productivity of OS 2200
programmers is expected to improve from using the IDE. The ClearPath OS 2200 IDE for Eclipse
should also assist OS 2200 clients in finding new programmers as many OS 2200 proprietary
commands and tools are not used.

Purpose

The purpose of this document is to assist OS 2200 programmers in understanding and using the
Unisys ClearPath OS 2200 IDE for Eclipse for 3GL development through screen snapshots and
written descriptions. This document is based on the Unisys ClearPath OS 2200 IDE for Eclipse 4.6.0
IC1 release. This document is based on the All-In-One release.

Note: This document is not an official Unisys manual and not subject to formal support. Best
efforts will be used to address reported errors or future updates.

This document was compiled with the help of numerous Unisys colleagues both in the Eclipse
engineering team and field delivery staff. Any changes or suggestions to this document should be
emailed to OS2200Eclipsel DESupport@unisys.com or to robert.jamieson@unisys.com.

Projects are the Core of an IDE

Eclipse is an open source IDE that Unisys has developed plug-ins for so it works with OS 2200

environments. IDEs are designed to work with projects and Eclipse is no different. However Unisys
has provided some additional features like the OS 2200 File Explorer (OFE) to assist to the OS 2200
developer. OFE does not use Eclipse projects and therefore some functionality may not be available
when using OS 2200 files and elements that do not belong to an OS 2200 project in your workspace.

Terminology

Throughout this document, the Unisys ClearPath OS 2200 IDE for Eclipse is often referred to as
simply Eclipse.
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Related Documents and Information
ClearPath OS 2200 IDE for Eclipse Installation Guide (47292107-011)

CIFS for ClearPath OS 2200 User, Programmer and Administrator Reference Manual (78596137-
nnn)

Definitions and Acronyms

Acronym ‘ Definition

Eclipse Open Source IDE

IDE Integrated Development Environment

Dorado Unisys ClearPath Plus server running OS 2200 and Windows OS
ACOB ANSI| COBOL-74 compiler with Unisys extensions

UCOB ANSI COBOL-85 compiler with Unisys extensions

CIFS Common Internet File System

MHFS Multi-Host File Sharing

OFE OS 2200 File Explorer

TOC Table of Contents

Table 1 - Definitions and Acronyms
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Installation

This section describes how to install the Unisys ClearPath OS 2200 IDE for Eclipse and related
software products on a developer’s workstation. For a more detailed description of the installation
process please refer to the related production information mentioned earlier.

Hardware Requirements

The workstation should have at least 2GB memory to perform at a satisfactory level. However 4GB
memory is recommended. Please refer to the PC Hardware and Software Requirements section of the
Installation Guide.

Install the Java Environment

Install Java SE 8. Installable is available from http://www.oracle.com/index.html. While installing use
the defaults (recommended).

Checking the Java Version
Check that JRE 1.8 is installed by submitting command “java —version” from the command prompt:
C:~>Jjava —version

java version "1.8_B_121"
Java<TH> SE Buntime Environment <huild 1.8.8_121-hi3>

Java HotSpot<TH>» Client UM <huild 25.121-hi13,. mixed mode?

G

Note that the bitwise version of Java dictates what version of the Eclipse OS 2200 IDE to install. The
above example is for the 32 bit version. The 64 bit version has the line with:

Java Hotspot(TM) 64-Bit ...

Download Files to Install

Download for the ClearPath OS 2200 IDE for Eclipse All-In-One is available from official channels.
Select either the 32 or 64 bit folder depending of the version of Java installed.

There are two options for installing Eclipse.
Choose one of the following options:

1. Install ClearPath OS 2200 IDE for Eclipse All-In-One — either 32 or 64 bit
eclipse-2200-4-6-0-170220.zip
A package containing a complete installation of Eclipse, Web Tools, Data Tools, and other
associated features including the Unisys Composite Application. For details and configuration
instructions, see Section Three of the Installation Guide.
Use this option if you are not currently using Eclipse as an IDE.

2. Install ClearPath OS 2200 IDE for Eclipse Composite Application Feature
eclipse-2200-ca-4-6-0-170220-updatesite.jar
The ClearPath OS 2200 IDE for Eclipse Composite Application Feature is ready to install in
your existing installation of Eclipse. For details and configuration instructions, see Section
Three of the Installation Guide.
Use this option if you are using Eclipse already as an IDE and just want to add the Unisys OS
2200 feature.

Installing ClearPath OS 2200 IDE for Eclipse using the All-In-One

o Identify a folder under the root (e.g., C:\ or D:\) on your workstation to install Eclipse.
e Unzip the eclipse-2200-all-in-one-4-6-0-170220.zip file to this folder.

Page: 10 of 158
Version: 4.1 File: Eclipse OS 2200 IDE Getting Started v4.1.docx



L]
UN [SYS ClearPath OS 2200 IDE for Eclipse Getting Started Guide

Host OS 2200 Software Dependencies

The host OS 2200 Software Dependencies can be found in the Installation Guide. Basically you need
CIFS (6R3 or later) and CPCOMM/CPCOMMOS.

Configuring an OS 2200 Telnet Session

Eclipse uses a Telnet session to the OS 2200 host for some functions so a Telnet process needs to be

configured in CPCOMM/CPCOMMOS. An example is:

PROCESS, TELRST PASSWORD,RST . Telnet

SILAS also needs to be configured for Telnet. For example:

PROCESS,RSDCSU  INTERNET-ADR, INTADD ;
TELNET-ATTACH-NAME, TELRSI TELNET-ATTACH-PASSWORD,RSI ;
TPO-ATTACH-NAME, TPORST TPO-ATTACH-PASSWORD, RST

CIFS Parameter Setting

The CIFS parameter CIFSSWAITROLBAK determines how long before CIFS responds to Eclipse
when the OS 2200 file is rolled-out. By default, this parameter has a value of 600 seconds. It is
recommended to set this value to 1 in the CIFS-BACK runstream so the user gets an immediate
response.

With the introduction of local cache for TOC timestamps, it is important for CIFS to be using the
correct time zone and time offset to GMT/UTC. These parameters are TZ and TIMEBASE. CIFS uses
these settings to determine the local time for the OS 2200 timestamp.

Refer to the CIFS manual for more details but these parameters are often located on the system profile
that can be a data file or element. The OS 2200 system administrator will configure the system profile
name in APEX, SecAdmin or SIMAN.
An example for Roseville, USA is:

TZ=CST6CDT

TIMEBASE=6
An example for Malaysia is:

TZ=UTC-8

TIMEBASE=-8
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Starting ClearPath OS 2200 IDE for Eclipse

Eclipse 4.6.0 Migration Considerations
Refer to the release notes for any migration considerations from previous releases.

Note that there are special migration considerations for workspaces created prior to version
3.7.2.A1 build 1C1-20140520.

Launching Eclipse
Eclipse can be launched by the following steps:
o Use Windows Explorer to expand the folder where Eclipse was installed

Name Date modified Type Size
configuration 3/17/2017 1210 PM  Filefolder
dropins 6/13/2016 7:29PM  Filefolder
. features 3/7/2017 418 PM File folder
p2 3/17/2017 1211 PM  File folder
plugins 3/7/2017 4:22 PM File folder

readme 74:22 PM File folder

wscite 3/7/2017 4:22 PM File folder
| -eclipseproduct 5/1/2016 10:37 PM ECLIPSEPRODUCT... 1KB
' artifacts.xml 3/7/2017 9 XML Document 250 KB
m eclipse.exe 6 Application 39 KB
o | eclipse.ni 3/7/2017 9 Configuration sett... 1KB
"] eclipsec.exe 6/13/2016 7:31 PM  Application 31 KB
’:« eclipse-clean.bat 3/19/2014 1:38 PM Windows Batch File 1KB
2] notice.html 8/17/2015 213 PM HTML Document 7 KB

e Double-click on the eclipse.exe file
Note: It is recommended to create a short-cut from the Eclipse.exe file and place on your desktop.

Eclipse will display the following screen. Note that Eclipse 4.6 is based on the Neon release from the
Eclipse Foundation.

CleankRath

©S 2200 IDE for Eclipse

2 oclips

neon

] P Copyright © 2016 Unisys Corporation
UN lSl S Thig Program is protected by US and internaticnal copyright laws
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Selecting the Eclipse workspace

Eclipse will display the following window asking for the workspace location. Normally this is found
in the Documents and Settings folder for the user but you can use another location. In the example
below, the workspace is C:\eclipse-2200-4-6-0-160920 WS.

Eclipse Launcher LX)

Select a directory as workspace

Eclipse uses the workspace directory to store its preferences and development artifacts.

(RSl N eclipse-2200-4-6-0-1605920 W5 - | Browse...

[7] Use this as the default and do not ask again

b Recent Workspaces

[ QK ] ’ Cancel

Check the box if you don’t want this window to appear in future.

The start-up option to prompt for the workspace can be set in the Eclipse preferences. Go to Window
-> Preferences - General - Startup and Shutdown.

@ Preferences - - -—
type filter text Workspaces
G [ &
4 hEnera — Prumptfnrwnrkspace on startup

. Appearance
Build Mumber of recent workspaces to remember: 10
Capabilities Recent workspaces
Compare/Patch Checlipse-2200-4-6-0-160920 W5
Content Types ChUsershjamiesrjyworkspace

- Editors

Error Reporting

m

Globalization
Keys
» Metwork Connectior
Motifications
Perspectives
Search
- Security
Service Policies
4 Startup and Shutdoy
Workspaces

No Workspace Prompt

On occasions, Eclipse will launch with a Workspace even when the user has requested to prompt for
the workspace. There have been issues with the prompt for workspace at the startup. Some of the
forums they have been discussing about this and one of them is:
http://stackoverflow.com/questions/7058782/eclipse-default-workspace-problem

One option is to start Eclipse with the following option.

<eclipselnstallDir>/eclipse.exe -clean
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If you have created a shortcut on the desktop, right click on the shortcut and click on properties and
append the key “-clean” to the target path.

Selecting the Eclipse workbench
For first time users, Eclipse will display the OS 2200 perspective similar to the following.

m eclipse-2200-4-6-0-160920 WS - OS 2200 - Eclipse

File Edit Navigate Search Project Run 052200 Window Help

= E [ e ; (= @em>- B [eEBi=-0-Q-E 5~ - G- Quick Access || 05 | [#)&!
o Hm

lo

4+ 052200 Explorer 52 [£2] 05 2200 File Explorer = ml

(2 APPSVNPROCS
(£ DORADOROB
(# DPSPROCS

(#* QRPROG

&% roB)

%, 052200 Host Manager View - CIFS 53
User-ID 0s Connection Name

BYRAPPDK 052200 RS02
secret 052200 SOCDR
SECRET 052200 S0CS0

Host Name
&, rs02.rsvlunisys.com
%108.20122
%101210.23

- e e i il el il e

At the top right, you will see the area where the Eclipse perspective can be selected:

= ()&

The first icon allows the user to select a perspective while the 2" icon is for the OS 2200 perspective
as shown by the hover text:

= | W

Note that other perspectives such as Java and Debug are often used with the OS 2200 IDE.

OS 2200 IDE for Eclipse Information
Various information on the Unisys IDE are available from the Eclipse Welcome page (Help ->
Welcome).
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[ eclipse-2200-4-6-0-160920 WS - OS 2200 - 0-BREAK*SECRET(-1). ON 10.121.0.23 - Eclipse
File Edit Source Navigate Search Project Run 052200 Window Help

{® Help (@ Welcome 52

= Al
+
Ll e Eclipse Java EE IDE for Web Developers
Review the IDE's most fiercely contested preferences Get an overview of the features
- Create a new Eclipse project for Java EE Web development T Go through tutorials
- Create a new Edlipse project for Javascript development Try out the samples

Checkout Eclipse projects hosted in a Git repository o Find out what is new

Import existing Eclipse projects from the filesystem or archive

Enhance your IDE with additional plugins

Open a file from the filesystem

¥ Aways show Welcome at start up

198Mof256M |

i — e ———

Check the Overview, What’s New and Tutorial links. The following is from Tutorials:
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Tutorials

Ja

=

a Development

-

Learn how to create a simple Java application that prints "Hellc

Create a Hello World SWT application
Learn how to create a standalone SWT Java application that di:

ClearPath OS 2200 IDE for Eclipse

Learn how to create an ©S 2200 project.

Learn how to create a TIP RA project.
Learn how to Debug a COBOL program on OS 2200 system.

I'Q""" Learn how to create C and C++ projects

Additional information can be found under Help -> Cheat Sheets:
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E)) Cheat Sheet Selection e |

.

Select the cheat sheet to open:

@ Select a cheat sheet from the list:

» = C/C++ Development
4 = ClearPath O5 2200 IDE for Eclipse
U Create a TIP RA project
U Create an 05 2200 project
" || Eclipse 05 2200 Debug Setup
» = Java Development
» = Team/Git

[] Show all

(71 Select a cheat sheet from a file:
Browse...

(71 Enter the URL of a cheat sheet:

@' [ OK ] ’ Cancel

Eclipse Help for Unisys Plug-ins
Go to Help - Help Contents.
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - Eclipse
File Edit MNavigate Search Project Run 052200 Window | Help |

ﬁ - -.é} | |:|1q; | iy | E:Ea:' Welcome
+ 052200 Explorer &3 05 2200 File Explorer = (@) Help Contents

Then expand the Unisys Composite Application (CA) User Guide and then expand the Traditional
Development Environment Help to get the OS 2200 IDE information. Note that context help can be
invoked by clicking F1 or clicking the help icon when shown:

@
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m Help - Eclipse =SANCE X
Search: Scope: All topics
Contents = | - B g o el g0

 Workbench User Guide
- Java development user guide

Unisys Composite Application (CA) User Guide

®

- Plug-in Development Environment Guide

> $

= C/C++ Development User Guide
@ cor Plug-in Developer Guide Contents
* COBOL Development User Guide

> §

-~ Data Tools Platform User Documentation +» What's New in this Release

@ Eclipse Marketplace User Guide + Traditional Development Environment Help
" EGit Dacumentation « PLUS Editor Help

~ Fortran Development User Guide + Logging Plug-Tn Help

@ JavaScript Development Guide + Telnet Plug-In Help

> JavaServer Faces Tooling User Guide + Java Application Integrator Plug-In Help

@ Oomph P2 M Doc i

@ Oomph Setup Documentation

$

T H & EHEHEEE @ EHEEE
®

is posite Applicatio
Bl What's New in this Release =
=l (A Traditional Development Enviranment Helg

= [ Traditional Development Environment H
B Overview
B Documentation Updates
Bl What's New?
B Getting Started
= [3 Working with 05 2200 Perspective
# 3 Working with Unisys Common Edito
# 3 Working with the COBOL Editor
7 (3 Debugging a COBOL Project
El Legal and Copyright Motices
& [ pLUS Editor Help
& (A Logging Plug-In Help
& LA Telnet Plug-In Help
& (3 Java Application Integratar Plug-In Help
# € Web Tools Platform User Guide

7 €% ¥Dath 7 N Bracacenr lear Manal
f] 11l ;

2] = = o

Configuring Eclipse Memory Management

Eclipse runs within a Java Virtual Memory (JVM) so this means it has a maximum heap memory size.
If an application reaches the maximum heap memory, the JVM throws an OutOfMemoryException
error.
The main aim of this feature is to check for memory availability before performing an operation.
Memory availability check is performed while opening a file using File Open with

e from the project in OS 2200 Explorer

o from OS 2200 File Explorer

Additional memory availability check is performed in:
e UDT Editor
e COBOL editor

The feature provides early warning to the users about low memory to assist in avoiding Eclipse
running out of memory. For certain cases, it allows the opening and editing a file in an external editor
in the event of low memory when the file is opened from:

File -> Open File with... menu option

Project Explorer

OS 2200 File explorer

Search operation

To configure memory management, use Menu -> OS 2200
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E eclipse-2200-4-6-0-160920 WS - O5 2200 - 0-BREAK*SECRET(-1). ON 10.121.0.23 - Eclipse

File Edit Mavigate Search Project Run [ (052200 | Window Help

,|,u1{tf LI

A E

+ 05 2200 Explorer i3 @5 2200 File Explore |

. ¥ APPSYNPROCS
4 * DORADOROB
4 %% DORADO*ROB.
R, DEFMAS.COB MAR 19, 2017 6:25
[} MLFTN.FOR MAR 19, 2017 4:59 P
5, DORADOROB.ELT MAR 15, 2017
5, ALLOC-COMP-DEBUG.ELT MAR
[ ALLOC.COB MAR 14, 2017 5:05 P
[ ALLOC-COMP.ELT MAR 14, 2017
[, ALLOC-COMPACOB.ELT JUN 18,
. ¥ DPSPROCS
. * QRPROG
a ¥R
4 %% ROBJFWORKFILE.

Select Configure Editor Scalability

= &l

Set ECL Mapping

¢ v AddaTelnet Session bound to this project.

& & ¥ 0l

Reload Editor

View Log
Save Log
Set Log Level

Clear Problem List Markers
Update 05 2200 Project
Configure Compare Tool

05 2200 Compare

R 052200 Resource Adapters »

W Setto Java 1.6

—c
&
=&

Setto Java 1.7

Configure Editor Scalability

[ Configure Editor Scalability

HE—

Free Memory Factor

File Size Factor

ko

6

@ [ |

Cancel

L

Free Memory Factor (FMF)

e Itis the percentage of free memory against the total available memory required to perform a

memory-intensive operation.
File Size Factor (FSF)

e Itis the free memory to the file size ratio. The default value is 6. A value between 6-15 is

sufficient.
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Understanding OS 2200 Projects

Configuring Eclipse Preferences

Before we start defining an OS 2200 project, we have to configure Eclipse to support the OS 2200
environment. In the menu bar, go to Window -> Preferences and click.

Mew Window

Editor r
Appearance [
Show View L
Perspective k
Mavigation k
Preferences

The following screen will appear:
rm Preferences = ﬁz-1

type filter text General =1 * v

. General -
- Ant

- CfC++

. COBOL [¥] Show heap status

[] Always run in background
[ Keep next/previous editor, view and perspectives dialog open

- Code Recommenders Waorkbench save interval (in minutes): 5

- Data Management FpEmorses

- Fortran .
@ Double click

- Help

- Install/Update

. Java Select on hover

) Single click

m

. Java EE Open when using arrow keys
+ JavaScript Note: This preference may not take effect on all views
- JSON
- Log Viewer
- Mylyn
. Oomph
052200
> Plug-in Development
Plus Preferences
- Practically Macro Optio
» Run/Debug
- Server

Team -
¢ m b IRestore Defaults] [ Apply ]

@ @ [ ok |[ canca |

S )

%

Displaying the Java Heap Status
The “Show heap status” option in the General Options can be checked to show the the heap status:

E Preferences

type filter text General
» [ 13 | -
AE:EFE [] Abways run in background
- An
C/Ces [] Keep next/previous editor, view and perspectives dialog open
. COBOL [¥] Show heap status

Eclipse will show the Java heap status in the status line:
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203Mof256M |

This information can be useful to provide in some cases as requested by Engineering. Clicking the
garbage bin icon will initiate a Garbage Collection task.

Configuring the Unisys COBOL preferences
Click on the entry COBOL (and not the ‘“+’ sign) to display this screen:

=

I kype Filker bext COBOL g - v

- General

COBOL Settings:

I+ —
Urisys LS COBOL

+

=
]
=

-Fortran

‘Help

-InstalfUpdate

-lava

-Java EE

- Java Persistence

- Javascripk

Mylvn

-Plug-in Developrment
i Plus Preferences
-Remote Systems
-RunDebug

- Server

-Team

i Terminal

- Usage Data Collector
- Yalidation

- Weh

- Web Services

- XML

@:I Ok I Cancel

Check the Unisys UCS COBOL entry. This selects the editor template that matches UCOB — the
ANSI COBOL-85 compiler on the OS 2200 system. Note that ACOB (ANSI COBOL-74) source can
be used with the COBOL editor as there are only minor differences between the compilers regarding
the language structure e.g. format of statements. For example, TALLY is an ACOB verb but not a
UCOB verb so it will not be handled as a verb when the COBOL editor displays the source.

COBOL Code Guidelines

Expand the COBOL entry and select COBOL Code Guidelines to allow Eclipse to provide some
guidance when working with COBOL sources. Each options has a priority of 1, 2 or 3 to control the
order in which the guidelines are displayed.
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-
@ Preferences -

- -_—

type filter text

»

» General

> Ant

s C/C+H+

a COBOL
Code Guidelines
Editor
Templates

Code Recommenders

Data Management

Fortran

Help

Install/Update

Java

Java EE

JavaScript

JSOMN

Log Viewer

Mylyn

Oomph
052200
Plug-in Development

Plus Preferences
> Practically Macro Optio =
4 (1] ]

@®

Code Guidelines

Duplicate Paragraph and Section Names

Discouraged GO TOs
Mull Perform
Indentation Issues
MNumber of Spaces

Mo Error Check

Unreferenced Section

1 -

Rl = TR B R R R
4 4 4 A

[ Restore Defaults] [ Apply ]

[ ok || Ccancel ]

COBOL General Editor Preferences

Now expand the COBOL entry and click the Editor entry.

M ~
@ Preferences - - - 5 ||
type filter text Editor oG~ v -

G |
- henen | coBOL Editor settings:
> Ant
» C/C++ General Colorsl Reference Format
a4 COBOL . __
Code Guidelines Text font: <Using Workbench Text Font> Change..
Editor X
Templates [¥] Show horizontal ruler
» Code Recommenders [7] Show print margin
- Data Management
. Fortran Print margin column:  6,7,72,80
> Help = [¥] Show overview ruler
> Install/Update [¥] Show line numbers
> Java [¥] Highlight current line
Java EE
: J:::Script [¥] Use custom caret
. JSON [¥] Enable thick caret
> Log Viewer [¥] Trirn trailing spaces on Save
> Mylyn
. Oomph Appearance color options:
052200 Line number foreground Color: E
> Plug-in Development | |Eurrtentllne highlight
rint margin
Plus F’references ) Selection foreground color
> Practically Macro Optio Selection background color
> Run/Debug
- Server
. Toam k%
4 1 | » ’Restore Defaults] ’ Apply ]
® Ce) [ OK J ’ Cancel ]
[

The General tab is used to set various options on how the COBOL edit pane is prepared and handled.
Modifying these settings affects only the current workspace, so each user can have their own

preferences.

Preference ‘ Description

Show horizontal ruler

Displays a horizontal rules in the edit pane

Show print margin

Puts vertical divider lines as the margins mentioned

Show overview ruler

Version: 4.1
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Show line numbers Line numbers are displayed on the left edge of the edit window
Highlight current line Highlights the current line for easier identification
Use custom caret Cursor being used

Trim trailing spaces on When a COBOL file is saved, Eclipse will trim trailing spaces from
save each line

On the top of the General tab, Eclipse displays the current font. You can change the font by clicking
on the Change button:

Editor = - -

COBOL Editar setkings:

zeneral ICDIDrs I Reference Format I

Texk Font:  =Using Workbench Text Fontz Change... |

Eclipse allows you to set the font. This might be important when Character Conversion is used. For
example, with Japanese it might be preferred to use the MS MINCHO or MS Gothic font. If you want
to preserve columns etc then use a fixed font rather than proportional.

Fant: Font style:
a1 Mew IHeguIar
m
Curlz MT [talic
Dratiam 1 |Bold
B DaturnChe Bold Italic
{} Edwardian Script ITC
{} Elephant
{} Engravers MT LI
— Effectz — Sample
[ Shikeout
LaBbh¥yvs
[ Underline AERiLE
Color:
I- Black ;l Script;
IWestern ;I

COBOL Colors Preferences
Click the Colors tab.
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COBOL Editor settings:

General ':'3|'3'f5| Reference Format|

Foreground:

Color: | I

In-line comment
Reserved words [C] Bold
Figurative constants
Special register

Strings

Sections

Paragraphs
Working-5Storage Variables
Unreferenced Variables
Others

Preview:

* Line comment
IDENTIFICATION DIVISION.
PROGRAM-ID. PROGMAME.
PROCEDURE DIVISION.
*» Inline comment
DISPLAY "Hello!™.
MOVE ZERD TO PROGRAM-STATUS.

Fl

Note that Sections, Paragraphs and Working-Storage Variables do not have their colors set in real-
time. From the COBOL editor, you must do a F4 to refresh the colors.

COBOL Reference Format Preferences
Click the Reference Format tab.

COBOL Editor settings:

| Generall Colors| Reference Fu:urrnat|

Reserved word level: ’Unisys UCS COBOL -

Tab width
Set Tab Columns:  7,8,1216,20,73

Settings for AutoTag

Tag in Columns 1-6
Default to Aute Tagging

The developer can modify the Tab Columns as required.

The Auto Tag feature allows you to end a value to a placed in columns 1-6 of any COBOL code
updated using the Eclipse editor. The Default check box allows the feature to be turned on or off. Got
to Help and search for Auto Tag for more information.
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COBOL Templates
The topic is discussed later in this guide.

Configuring the Proxy Preferences

Some sites use a proxy server to provide internet access. When this is configured on the workstation,
Eclipse will get an error message when trying to connect a telnet session to the OS 2200 host.

£ Connection Properties Warning @

Connection refused, %1
: Malformed reply from SOCKS server

d

The problem can be resolved by setting the Eclipse network settings to the correct value.

Go to Window - Preferences and then expand General in the tree structure. Then highlight Network
Connections. Set the Active Provider to Direct.

Refer to the figure below.

=

|tv|:'E filker texk Metwork Connections =l -

[=]- General -
[+ Bppearance Active Provider;
- Build
- (Zapahilities Proxy entries

- Compare/Patch | Schema | Host | Fort | Prov. ., | Auth | |Jser Edit, .. |
- Zonkent Types

. ﬁ HTTF Manal | False
- Editors O H1TPS Manal | False iZlEar |
- keys O s=ocks Manal | False

[+ Metwork Connections
- Perspectives

- Search

[+]- Securiby

- Service Policies

- Skartup and Shukdown 4 |
- Web Browser
[+ Workspace Proxy bypass

H- Ank | | Host | Provider | add Host. ..
|- CfC+H+ O localhost Manual

0
-COBCL O iz7.001 Marual Edit. .. |

I+

I+

- Editor

i Temnplakes
-Daka Management
-Fortran
‘Help
-InstalfUpdate
-lava

-] EE
= | _plll Restore Defaulks | Apply |

:I (0] 4 I Cancel

F

()

Setting the OS 2200 Preferences
Select the 0S2200 entry:
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m Preferences

type filter text 0% 2200
. General -
. Ant Clear Cache
o T+ Clear residual files on 1 « | of every month.
- COBOL
. Code Recommenders Host Manager View
. Data Management Run host status check every 10 | minutes,
- Fortran
- Help Cache Synchronization
. Install/Update @ Off On
- Java
. Java EE Elements in Upper Case
. JavaScript - Upper Case ]
. JSON I
. Log Viewer 05 2200 File Explorer
- Mylyn Show Absolute Elernents
. Qemph
052200 Mumber of Retry Attermpts 2
 Plug-in Development Debugger Wait Time
Plus Preferences . o
. Practically Macro Optic Madmum Wait Time 10" minutes.
. Run/Debug

Search the Help for each of the topics but some information is provided below.

Clear Cache
This is the day of the month when Eclipse will clear the unreferenced cache elements in a project.

Cache Synchronization

This feature enables the elements that are added to the project to be downloaded while creating,
updating, or importing an OS 2200 project. This happens in the background.

Cache Synchronization is turned off by default. If Cache Synchronization is turned on, the elements
are downloaded automatically to the cache. If Cache Synchronization is turned off, the user must open
the elements by clicking them, and then they will be downloaded instantly. Once it is downloaded, the
element will remain in the cache.

Using the OS 2200 Logging Feature

This feature maintains a log file for OS 2200 related activities.

Setting the Log Level

Eclipse writes a log file for the Unisys plug-ins to a file called unisys-ca.log into the selected
workspace folder:

Address |I0) C\Eclipse 2200 3.7 Woarkspace!, metadatal, pluginsicom, unisys . kde, core

Folders X | _Mame
j . . .
=l ) Eclipse 2200 3.7 Workspace ;I Junfsys Fa.2ip
5 03 metadata @ unisys-ca,log
I mvlyn
=1 12 . plugins
o, Unisys. tde, core

This log file could grow in size so the ability to set the log level was introduced. To set the log level,
go to Menu = 0OS2200 = Set Log Level:
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E eclipse-2200-4-6-0-160920 W5 - OS5 2200 - Eclipse
File Edit Mavigate S5Search Project Run | Q52200 | Window Help
w4 B i E] SetECL Mapping

- ==
o2 Add a Telnet Session bound to this project.
+ 052200 Explorer &3 05 2200 File Explore 5

| 01g -

Clear Problem List Markers

- ¥ APPSVNPROCS ®  Update 05 2200 Project
. t: EESR;{%:I]CZGE 4% Configure Compare Tool
. C* QRPROG BR 052200 Compare
. |s* ROBJ " Reload Editor
View Log
Save Log
Set Log Level

The current log level setting is displayed.

x

 Fatal
i~ Errar
 Warn
" Info

¥ Debug

) I—I
|\3 ) Ik Zancel

The user can choose the logging level to be logged. There are 5 different options arranged according
to the priority.
e Fatal
This level will designate very severe error events that will presumably lead the application to
abort. Logs only Fatal data.
e Error
This level will designate error events that might still allow the application to continue
running. Logs Error and Fatal data.

e Warn
This level will designate potentially harmful situations. Logs Warn, Error and Fatal data.
e Info

This level will designate informational messages that highlight the progress of the application
at coarse-grained level. Logs Info, Warn, Error and Fatal data.

o Debug
This level will designate fine-grained informational events that are most useful to debug. Logs
everything (Info, Warn, Debug, Error and Fatal ).

Debug is the default setting.

If the Eclipse OS 2200 IDE encounters a problem or issue, the user can change the log level
accordingly to gather more information to assist in analyzing the issue. Unisys may recommend
clients to set the log level in response to reported problems.
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Log File Size and Number of Log Files

When a log file reaches its’ maximum size (default is SMB), Eclipse saves the current log in the same
folder with a name of unisys-ca.log.<n> where <n> is an integer:

Mame Date modified Type Size

=] unisys-ca.log 4792017 10:46 PM Text Document 380 KB
|| unisys-ca.leg.2 4/8/2017 1:59 AM 2 File 5121 KE
|| unisys-ca.log.5 3/19/201711:33 PM 5 File 5121 KE
|| unisys-ca.log.b 3/15/2017 231 PM 6 File 5121 KB
|| unisys-ca.log.? 3/14/2017 505 PM T File 5121 KB
|| unisys-ca.log.8 11/26/2016 8:12 PM & File 5121 KE
|| unisys-ca.log9 6,/18/201611:27 AM 9 File 5121 KB

The Log File Size and Number of Log Files can be updated by editing the properties. Open the
following file with an editor like Notepad++:

C:\eclipse-2200-4-6-0-170220\plugins\com.unisys.tde.core_4.6.0.20170220\logger.properties

[= logger properties E3

1 # For the general syntax of property based configuration files see the
2 % documenation of org.apache.log4j.ProperctyConfigurator.
3 % The root category uses the appender called Al. Since no priority is
5 # specified, the root category assumes the default priority for root
& $# which is DEBUG in log4j. The root category is the only category that
7 # has a default priority. 211 other categories need not be assigned a
8 $ priority in which case they inherit their priority from the
9 % hierarchy.
11 log4j.rootLogger=, A3
12 log4]j.debug = false
1LE) log4]j.logger.com.unisys.0s32200=,41 42 , A3
15 $ L1 is set to be a PluginFilelppender
16
17 log4d]j.appender.Al=com.unisys.logging.core.PluginFileAppender
18 log4]j.appender.Al . MaxFileS5ize=5MB
15 log4]j.appender.Al . MaxBackupIndex=10
20 log4j.appender.fl.File=/unisys-ca.log
21 log4d]j.appender.Al.layout=0rg.apache.log4j.PatternLayout
22 log4d]j.appender.Al.layout.ConversionPattern=%d:3p:3C{3} :$F:3L:3M:Fc:3x %m 3In
23 log4j.appender.fl. threshold=DEBUG

Edit the MaxFileSize and MaxBackuplndex variable values as appropriate.

Viewing the Log File
The OS 2200 Log file can be viewed by going to Menu -> OS 2200 -> View Log:
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052200 | Window Help

@ Set ECL Mapping
[+

Add a Telnet Session hcuncl[ ViewLogCommand L
[ Clear Problem List Markers
#  Update 05 2200 Project
4% Configure Compare Tool
BRy 052200 Compare
"l Reload Editor

View Log
Save Log
Set Log Level

The Log Viewer view is opened:

5., 0S5 2200 Host Manager View - CIFS | Tasks [#] Problems (1] Log Viewer 32 S =N ® | % =08
unisys-ca.log
2017-04-10 16:06:33,005:DEBU G:052200.util. TDECoreltilities: TDECoreUtilities java:1069: get052200FormatfromCachePath:main: : Segment count 5 -

2017-04-10 16:06:33,005:DEBU G: 052200, util. TDEC oreUtilities: TDEC oreUtilities java:1081: get 052200 FormatfromCachePath:main: :Retuming robj*workfile.test on rs02.rsvl.unisys.com
2017-04-10 16:06: DEBUG:tde.core.052200GeneralEditListener: 052200 GeneralEditListener java:177:partOpened:main: :part opened trace 1

2017-04-10 16:06:41,152:DEBUG:jai.core.RAGroup:RAGroup.java:l 35:checkEnabled:main: :mMenu is not null.

2017-04-10 16:06:43,486:DEBUG:jai.core.RAGroup:RAGroup.java:l 35:checkEnabled:main: :mMenu is not null.

2017-04-10 16:06:52,026:DEBU G:client.ui. TelnetView: TelnetView.java:1007:setFocusimain: :

2017-04-10 16:06:52,045:DEBU G:client.ui. TelnetView: TelnetView.java:1007:setFocus:main: :

2017-04-10 16:06:52,049: DEBUG:jai. core.RAGroup:RAGroup.java:l 35:checkEnabled:main: :mMenu is not null.

2017-04-10 16:06:52,061: DEBUG:client. ui. TelnetView:TelnetView java: 00T setFocusimain: :

2017-04-10 16:06 DEBUG:client.ui. TelnetViewS4: TelnetView java:238:widgetDisposed:main:
2017-04-10 16:06:54,150:DEBUGiclient. ui.ClientPlugin:ClientPlugin,javail T0iremoveKey:main: :R502-2
2017-04-10 16:06:54,151: DEBUGitelnet.lib. Telnetl ogger: Telnetl oggerjava:3Silogimain: :Session Logout

Note the icons at the upper right:
58| ¢ | @% ~ =0
The key icons are:

B= | Loads the latest content from the unisys-ca.log file and appends the logs to the
Viewer as and when the logs are written in the unisys-ca.log file. This option is
selected by default and so is disabled.

[]

Stops tailing the log file. Logs are not appended to the Viewer. Click B to
append the logs.

Note: Clicking B appends the logs from where it was last stopped.

Enables you to set rules in the Log Viewer.

i

&

Refreshes the current log file.

Using the Log Viewer Rules

The Log Viewer Rules editor lets you define various rules to highlight matching text references. Click
the rules editor icon (see above). Or use Preferences -> Log Viewer.
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E Preferences v l 28 X

type filter text Rules - .-
> Data Management -

. Fortran rule type content Add...
e Edit

> Install/Update dit...
e Remowve

» Java EE

> JavaScript Up
o Down

4 Log Viewer W

e Export selected...

> Mylyn

Oomph Export all...

> Plug-in Development

1]

Plus Preferences

Practically Macro Optio

Run/Debug
» Server
> Team
Validation
: Web
> Web Services
» XKML -
Il T 3

’ Restore Defaults] [ Apply ]

|i?>| |C:| ’ QK l [ Cancel ]

Select Add

Enter the word to be matched. Change the foreground and background colors as required. Click OK
and then refresh the log.

&, 05 2200 Host Manager View - CIFS | J=| Tasks [%] Problems (1] Log Viewer 53 E B

unisys-ca.log

2017-04-10 16:06:33,005:DEBUG: 052200, util. TDECoreUtilities: TDEC oreltilities java:1069: get052200FormatfromCachePath:main: : Segment count 5
2017-04-10 16:06:33,005:DEBUG: 052200, util TDECoreUtilities: TDEC oreltilities. java:1081:get052200FormatfromCachePath:main: :Returning robj*workfile.test on rs02.rsvlunisys.com
2017-04-10 16:06:33, 215:DEBUG:tde.core 052200 General EditListener: 052200 General EditListener java:177:partOpened:main: :part opened trace 1
2017-04-10 16:06:41 152:DEBUG jai.core. RAGroupRAGroup java:1 35:checkEnabled:main: :mMenu is not null,

2017-04-10 16:06:43 486:DEBUG jai.core. RAGroupRAGroup java:135:checkEnabled:main: :mMenu is not null,

2017-04-1016:06:52,026: DEBUG: client.ui. TelnetView: TelnetView. java:1007:setFocusimain: :
2017-04-1016:06:52,045:DEBUG: client.ui. TelnetView: TelnetView. java:1007:setFocus:main: :

2017-04-1016:06:52,049:DEBUGjai. core.RAGroupRAGroup. java:1 35:checkEnabled:main: :mMenu is not null.

2017-04-1016:06:52,061: DEBUG: client.ui. TelnetView: TelnetView. java:1007:setFocus:main: :
2017-04-1016:06:54,149:DEBUG:client.ui. TelnetViewS4: TelnetView java:238:widgetDisposed:main: :

2017-04-10 16:06:54,150:DEBUG: client.ui.ClientPlugin: ClientPlugin.java:l 70:removekey:main: :R502-2

2017-04-1016:06:54,151:DEBUG:telnet.lib. TelnetLogger:TelnetLogger.java:35:log:main: :5ession Logout

The rules can be editing to add more rules, delete them or change their order.

Configuring OS 2200 connections
Eclipse uses two connection methods to the OS 2200 host:

1. Telnet is used to send commands to the host. You can open a demand session via telnet at any
time.

2. CIFS is used to access the OS 2200 program file that contains the program source and other
elements e.g. ECL. CIFS allows OS 2200 files to be exposed as network shares and then
accessed from Windows using mapped drives.

There are two methods to define OS 2200 connections as explained below.

0S2200 Host Manager View

At the bottom of your Eclipse window, you should a number of tabs including the 0S2200 Host
Manager View:
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5 052200 Host Manager View - CIFS 53 . w2 Tasksw 2 Problems} ‘& 05 2200 End Summary View} il Memorﬂ i Registersw T Eclipse 2200 Log}

| Hosk Mame I Conneckion Skatus I User-I0 I o5

If you do not see this tab, go the menu bar and select Window = Show View.

eclipse-2200-4-6-0-160920 WS - OS5 2200 - Eclipse
File Edit Mavigate Search Project Run 052200 [Window] Help

A E _|m| O T Mew Window »B"Ear_lihi’lﬁ?lﬁxéhg
Editor [
+ 052200 Explorer 23 05 2200 File Explorer Appearance R
. [ APPSVNPROCS .
. [* DORADOROE Shaw View | @ 052200 Console
. [* DPSPROCS Perspective b | e  TelnetView
* QRPROG
z o+ SOBJ Navigation v Other... Alt+Shift=Q, Q
Preferences

Click Other then scroll down to OS 2200 and expand the node.

i '1
Show View EET

type filter text

» = Mylyn -
> = Oomph
> [ org.eclipse.ed.secondaryDataStack
4 (= 052200
[Ei, COBOL Code Guidelines
4 065 2200 Breakpoint Console
& 052200 Console
& 052200 End Summary View
- 05 2200 Explorer
0S5 2200 File Explorer
B, 052200 Host Manager View - CIFS
':5' 05 2200 Search
& PDP Copy Proc View

o [elnetView

m

> = Plug-in Development -

Now click the OS 2200 Host Manager View- CIFS entry.
In the OS 2200 Host Manager View tab, right click. Eclipse will present a dialog:

Refresh
Properties

Wi R

Disconnect Host
Connect Host
Edit Host

Delete Host

@ AddHost
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Click Add Host

The Connection setting dialog appears with 2 tabs — one for Telnet and one for CIFS. As you fill in
the Telnet tab, the CIFS tab is also populated with the same details.

Il Connections Settings x|

Telnet | CIFS |

Hiosk

User ID

Passwiord

|

|

|
Retype I

r

Save Passward

f* 052200 = LN

"Operating Swsbem

Connection Mame |

Part Murnber I 23

Character Conversion I{NONE}- j

Prompt Characker I?

S5L Part -

MHFS |

Host Prompk Response Recaord |
| | Add

Remove
[Mave g

e Dawn

Fil

Edit

Ik | Zancel |

The Host field contains the DNS name or IP address for the OS 2200 host.

In the User ID field, enter your OS 2200 demand userid. Enter your demand password in the
Password and Retype fields. Check the Save Password box. Note: For Windows 7, your userid and
password must be entered in upper case.

Enter a Connection Name.

The port number must be 23 for Telnet so don’t change this value.

If your OS 2200 supports a language requiring character conversion e.g. Japanese, use the list box to
select the entry otherwise leave as <NONE>.

Check the SSL Port box if using secure Telnet.
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Check the MHFS box if your system uses Multi-Host File Sharing. This implies that your system runs
XTC or PAEXEC.

The Record button can be used to record your normal responses to OS 2200 generated prompts when
you sign-on to a demand session. For example, “Enter your project-identifier” might be a prompt.
After clicking the record button, Eclipse will open a demand session via Telnet. Perform your usual
steps and responses when using demand session.

Check the CIFS tab information and then click OK.
The following warning window appears when you finish the recording.

-I:}Eunnectiun Properties Warning 5[

' The host prompt daka may have to be edited ko remove data
W that waries From session ko session (such as time stamps).

To edit the OS 2200 Connection, you can highlight the connection in the OS 2200 Host Manager
View and right click. Then select Edit Host.

&, 052200 Host Manager View - CIFS 3 | J=

Host Mame

8, re012.revl.uni .

% 10820122 * Refresh

% 10121.0.23 Properties
@ Disconnect Host

Connect Host

&  Edit Host
@ Delete Host
éj’ Add Host

At the right side of these tabs are some icons. When OS 2200 Host Manager View is in focus, the
following icons are displayed:

He®SFR¥E 2O

The sixth icon from the left can be used to add a new host. Hover text will display the function of the
icon.

&2 - C
Add Host i
Or when using the Telnet Connection method below, highlight the Connection and then click Edit.

Using the Telnet Connection method

In the Icon menu, click the Telnet connection icon:
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=

Select a telnet host
Specify a host or select a preconfigured connection, H

" Manual &+ Configured

Hosk: | CO01 M, LIS, LNISYS, COM
Part; |23

Characker Canversion I{NONE}- j

SEL Port r

Conneckions

Hoaosk: 001, MNa, UIS, UNISYS, COM

ser I jamieson

Hew Delete |

@:I Finish Cancel

Click New to display the Connection Settings window as shown earlier. Follow the above steps to
configure a new connection.

Click Finish to open a Telnet session to the selected host. The recorded login details are applied.

i, 08 2200 Host Manager View - CIFS =] Tasks 3/ Problems E COBOL Code Guidelines @ 052200 End Summary View [ Memory [lf Registers #2 RS02 =+2 SOCSO 52

Enter your user-id/password:
>

Commands are submitted as if you are using a demand session such as via a terminal emulator except
that full screen mode is not supported. The session can be closed by clicking on the “X” in the tab.

If you want to save the contents of the Telnet pane, there is the following icon on the right side of the
pane title bar:

Note that if the session is closed, transmit again to sign into demand again:

>*TIMEOUT WARNING™
—————— Session Path Closed ------Enter your user-id/password and clearance lewvel:

*UNISYS 1188 Operating System Lewvel 49ML.177AAS2(RSIN*

Using Previous Telnet Commands

You can use Ctrl+UpArrow or Ctrl+DownArrow to resubmit previous commands. The Telnet session
stores the last 20 commands used.
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Using ECL Mapping with Telnet
Eclipse OS 2200 provides 25 shortcut keys that can be used to store ECL commands to be used in the

Telnet session.
Open the ECL Mapping by using Menu -> OS 2200 -> ECL Mapping or by using the & icon from
the Telnet view. This opens the dialog:

5 ECL Mapping

Key Stroke Command
Add
F2 @prt,t [X3XK]An
Update
Rermove
Execute

Click Add to see the shortcut keys available:

F N
B Add ECL Mapping e |

Key Stroke -

Command

Mote: Include \n for enter key and [XXX] for parameter

b

Expand the list box and select a shortcut key.

Then enter the command as required.
If a configured shortcut is selected then the option to execute the command is provided:
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1

-
ECL Mapping

Key Stroke Comrmand

P2 @prtt [OKLAn Add

Update

Remowve

Execute

@ o

Note that when the parameter field [XXX] is used, Eclipse prompts for the runtime value:

| afl ECL Parameter S

Command:  @prtt XOX]\n
Value of XXX : |

I
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Using the OS 2200 Perspective

Eclipse has different layouts for the IDE that are designed for the type of work being performed e.g.
Java, Debug, and OS 2200 etc. After the Unisys Eclipse OS 2200 features have been installed (and at
this stage they have), there is a perspective called OS 2200.

The perspective can be selected from the top right of the screen. In the following case, OS 2200 is
greyed out as it is the default perspective that is open.

7y 81 dava 35 Debug ?
A 05 z200
tr_? Java EE

You can also go to the menu and click Window = Open Perspective = Other

L] Open Perspective I. [=] ﬁ]
e

(3 Database Debug

({3 Database Development
'-’E?‘«Dval::lug

%Furtran

ek Git

%"Java

Ez?.la*.ra Browsing
L;'_‘,?_Iava EE

EJJava Type Hierarchy
gj”]avaicript

= 0S 2200 (default)

™ .
12 Planning

= Plug-in Development
I Resource
énTeam Synchronizing

@ Web

2 XML

L

Then select OS 2200
When the OS 2200 perspective is open, the IDE should look like:

[0 eclipse-2200-4-6-0-160920 WS - OS 2200 - Eclipse =) 28|

File Edit Navigate Search Project Run 052200 Window Help

Flm S E ) CEa ==
File E =]

Brew - [afE| B0 Q-5 -/~ G- QuickAccess | 3 | {8
=a

+ 052200 Explorer 73

, [# APPSYNPROCS
» (2 DORADOROB

» [ DPSPROCS

> [ QRPROG

. G RoBJ

%, 052200 Host Manager View - CIFS 2| 2] Tasks (#], Problems [, COBOL Code Guidelines @ 052200 End Summary View [] Memory 11} Registers 5 Uninitialized @2-=0
Host Name Connection Status User-D 05 Connection Neme
5 102zl p] BYRAPPDK 053300 RE03

%108.20122 Disconnected secret 052200 SOCDR
%10121023 Disconnected SECRET 052200 50CS0
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Or you can open a perspective by Windows -> Preferences -> General -> Perspectives.

rl |
E Preferences - i l B S

type filter text Perspectives oo - -
4 General - )
Open a new perspective
- Appearance _ ) . .
. @) In the same window () In a new window
Build
Capabilities o th sted ti h . et
en the associated perspective when creating a new proje
Compare/Patch _[:I i persp i g prel
Content Types () Always open () Meveropen @ Prompt
- Edit
rors ) Available perspectives:
Error Reporting
Globalization FEc/Ces Make Default
Keys |3 Database Debug
. Metwork Connectior = L3 Database Development Revert
Motifications %5 Debug Delet
Perspectives HE Fortran elete
Search o Git
» Security & Java
Service Policies E_:-\JJava Browsing
- Startup and Shutdoy ‘r.?]a*.ra EE
Tracing ) EJJava Type Hierarchy
LI Responsiveness b %‘j”]avaScript

User Storage Servicel 4 05 2200 (default)

Web Browser

5 Planni
- Workspace N ann.lng
Ant «J=Plug-in Development
; Ii75 Resource
s CfC++ ot < o
. COBOL 8- Team Synchronizing
+ Code Recornmenders @WEI‘]
- Data Management XML
> Fortran
+ Help Mote: 'Revert' rernoves the customization from the selected perspective,
» Install/Update This only applies to newly opened perspectives.
- lava -
. [—rrm— - [Restore Defaults] [ Apply ]
'i?;' @:l [ Ok ] [ Cancel ]

Preparing Your OS 2200 Program File

Your OS 2200 program file that contains the program source code needs to be shared with CIFS so
Eclipse can access the file. This is accomplished by creating a share using the CIFSUT processor in
an OS 2200 demand session.

@CIFSUT

share /0s2200/<qual>/<filename> <sharename>
In the following example, the OS 2200 program file is dorado*rob. The commands are:

@CIFSUT

share /0s2200/dorado/rob doradorob
In this example, a Windows network drive could be mapped to \\<server>\doradorob.
To unshare the program file, enter the commands:
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QCIFSUT
unshare doradorob

However it can be easier than this. A default share called “0s2200” is recommended to be created over
the OS 2200 MFD and we will use this share for the examples. This means that you don’t have to
define your own shares.

More details on CIFS can be found in the CIFS manual.

Creating an OS 2200 Project

Now that a CIFS share has been created for the OS 2200 program file to be used for OS 2200 3GL
development, Eclipse can be used to define the OS 2200 project. From the Eclipse workbench and in
the OS 2200 perspective, go to the menu bar and do File > New - OS 2200 Project and click.

E eclipse-2200-4-6-0-160920 W5 - OS5 2200 - Eclipse
File | Edit Mavigate Search Project Run 052200 Window Help

Mew Alt+Shift+M » {§ 05 2200 Project

Alternate Option: Right click in the OS 2200 Explorer View and choose New = OS 2200 Project.

3 eclipse-2200-4-6-0-160920 WS - OS5 2200 - Eclipse
File Edit Mavigate Search Project Run 052200 Window Help

Iw ZEE N e » B,
+ (052200 Expl = =
Rl New » | # 052200 Project
. [ APPSVN = -
. ¥ DORADC Open in New Window i | TR
+

+ 1 DPSPRO Remowve from Context Ctrl+Alt+Shift+ Down E 05 2200 Element

. [* QRPROC .

@ rop) |'E Copy i EBample..

Paste 5 Other.. Ctrl«N
W Delete

hmwre

The following Window appears:
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[ New OS 2200 Project E] | e

Create new OS5 2200 Project —

The project name cannot be empty.

05 2200 Project Mame

05 2200 Connection Name |Rs02 -
Hast Mame, User ID: rs02.rsvl.unisys.com, BYRAPPDK

| Mew || Edit ||Delete|

@ Use standard 05 2200 Share (os2200).

() Use a non-standard name for 052200 share,

Create Mew Work File

05 2200 Work File
@ STD® SHARED®
Qual*File(Cycle).

(71 Use if OS 2200 workfile has a unique share.

@ < Back Next > Finish

b

Enter a name for your project in the field “OS 2200 Project Name”.
Select the OS 2200 Connection to be used.
Check the radio button called “Use standard OS 2200 Share (0s2200)” if your site is using the 052200
share in CIFS. However if your site has used a different name for the share, then check the “Use a
non-standard name for 0s2200 share” and enter the share name in the Custom Share Name field. Both
of these options provide access to the entire OS 2200 MFD directory. However you may have a share
defined over a single OS 2200 file. For example:

@CIFSUT

share /0s2200/unisys/rob robj
would create a share called ‘robj’ over file unisys*rob. In this case, check the ‘052200 share cannot be
used” radio button.

If using MHFS, refer to the MHFS Considerations section later in this document.
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If using an existing OS 2200 Program File, enter the name in the OS 2200 Work File text box.
Creating your own workfile is described later.
Now click Next.

If Eclipse can’t access the OS 2200 Work File, an error will be presented. Check the Unisys-CA log
(access via the menu option OS2200->View Log if additional information on the cause of the error is

needed.
After associating an OS 2200 Work File with your Eclipse project, a wizard displays a screen for the
build runstreams and breakpoint files to be used as shown below.

[ New OS 2200 Project E] | e

Set the build runstream and breakpoint files list for this project ,=.af [rj :

Enter the ECL commands that will build this project into the Build Stream tab and add the cataloged
breakpoint files containing comppiler listings to the list in the Bript Files tab,

Build Stream | Brkpt Files

@, ENTER YOUR Q5 2200 BUILD STREAM HERE.

@ <Back || MNet> || Fnsh || Concel

%

We will define the build steam later.
Click the “Brkpt Files” tab.
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P ™
New OS 2200 Project =] B )

Set the build runstream and breakpoint files list for this project -
Enter the ECL commands that will build this project into the Build Stream tab and add the cataloged

breakpoint files containing compiler listings to the list in the Bript Files tab.

Build Stream | Brkpt Files

Zingle Share for all Brkpts

05 2200 Breakpoint Filename

View name (opticnal)

Delete after use, CIFS Mame

Add | | Replace | | Remove | | Move Up | | Move Down

@ <Back || MNet> || Finsh || Concel |

L=

We will return to define these later.

Click ‘Next’. It may take Eclipse a little time to access the OS 2200 program file and retrieve the
names of all the source elements in the file. (ABS, REL, OM, ZM elements are not returned.)
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[ New OS 2200 Project E] | e

Add elements p— .
Add program file elements to your Q5 2200 project.
Worldfile: ROBIFWORKFILE,

Work File Contents Project Contents
Element Link

Search Element Search Element
Include ?, * and % as Wildchars) (Include 7, * and % as Wildchars)

ALLOC
ALLOC/COMP
ROE)

TEST
TEST/COMP

TOC refreshed on 2017,/03/16 17:42:00

Add Element attributes, Change element attributes,
Editor Editor
<default= < default> Change
Character Conversion Character Conversion
<NOMNE= <MNOME>

':?:' Mext = Finish l [ Cancel

%

The left pane shows the OS 2200 source elements in OS 2200 format.

Now highlight the elements that you want to be part of this project. You can use standard Windows
selection methods to choose multiple elements. Note that after you have selected at least 1 element,
the “>" arrow is displayed and the drop-down boxes for ‘Editor’ & ‘Character Conversion’ are
enabled. The user may change the type (extension) for the selected elements from ‘Editor’ drop-down.

Use the Search Element text box to filter the elements you want to display by entering the starting
characters of the element name. Wildcard searches using ‘*’ for any number of characters and “?’ for
a single character. For example, using ‘?’:
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Waorlk File Contents
Elernent

Search Element
{Include 7, * and % as Wildchars)

ATL

ALLOC
ALLOC/COMP

Note all elements are set to same type and/or character conversion.

Eclipse shows the last timestamp when the work file table of contents (TOC) was refreshed. This can
be refreshed when creating a new project if required.

TOC refreshed on 2017,/03/16 17:42:00
Highlight the elements to move to the project work file.

Work File Contents
Element

Search Element
(Include 7, * and % as Wildchars)

ALLOC/COMP
ROE)
TEST

TEST/COMP

Click this arrow icon to add the selected files to your Eclipse project.

Note: Without selecting any elements, the user can create a project. Later, the user can either update
the workfile or create a new element. This can be done by clicking ‘Finish’ from any of the screens in

‘New OS 2200 Project’ wizard, provided the project-details (Name, workfile & connection) have been
furnished correctly on the first-screen.

Work File Contents

Project Contents
Elerment Link
Search Element Search Element
(Include 7, * and % as Wildchars) (Include 7, * and % as Wildchars)
ROE] ALLOC
TEST ALLOC-COMP
TEST/COMP

The selected elements are moved from the left pane to the right pane. At this stage also, we can define
the type of element. For example, for any COBOL source programs, highlight the element and select
‘COB’ from the Editor list box and then click ‘Change’. Change any elements containing ECL etc to
ELT editor type. Changing the type ensures that the element is opened in the desired editor, i.e. a
COB element would open in the COBOL-editor and an ELT element would open in the general Text-
editor. Eclipse will automatically detect COBOL source in most cases.
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Project Contents

Link

Search Element

(Include ¥, * and % as Wildchars)

ALLOC.COB
ALLOC-COMP

Note the Character Conversion should be set correctly if your OS 2200 supports a different language
like Japanese.

Note: Even before moving elements from right pane to left pane, a user can change the element type.
The user has to select file(s) and choose what type of element he wants from the drop down under
“Add Element attributes” and then move to left pane

Click ‘Finish’.

Eclipse opens your project in the OS 2200 Explorer View.

+ 05 2200 Explorer 35 05 2200 File Explorer

. ¥ APPSVMPROCS
. ¥ DORADOROB
. [* DPSPROCS
. [* QRPROG
a|l* R
4 %% ROBJ*WORKFILE.
[F ALLOC MAR 14, 2017 5:05 PM
[H ALLOC-COMP MAR 16, 2017 4:58 PM
. ¥ ROB)

Note the TOC timestamp for each element is displayed. This is the shown in the local workstation
time.

Element Caching
Eclipse will cache project work file TOC and elements. This feature allows developers to work on
local copies of the elements plus reduces network latency. The local cache and the OS 2200 file can
be synchronised as explained below.
When the elements are added to the project, elements have different states in the OS 2200 Explorer
tree structure:
e Uninitialized
[= Marked yellow, which indicates that the elements are not downloaded to the cached
folder
e |nitialized
= Marked white, which indicates that the elements are successfully downloaded and are in
the cached folder
e Conflict
== Marked red, which indicates that an element is modified either locally or remotely on the
host
The following example shows the three states for a project:
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- 'ﬂ‘ RAJESH*FILE,
m 1
m 1L.TXT
m 123456
I 2200.H e v
& 2201.H Initialized
m COBOLTEST
m EGG
it ELE-M-1.COB

5 L AEP,
dem FLAMNLH
w TEST
i TEST.COB
& TEST1
[& TESTLCOB
[@ TEST1253
[& TEST1254 P
o eriaes Uninitialized
& TEST1256
TEST1257
TEST1258

LER-ER]

;

(= 60
@ TEST1261

Conflict Resolution
The developer can perform conflict resolution at the project level or at the element level.

At the project level, right-click on the project name or work file in the OS 2200 Explorer view and
select Sync. This dialog is displayed:

Sync ¥ | &} Update Project Status

05 2200 | "¢ Syncfrom Local to Host
%‘" Run C/C++ Code Analysis o Syncfrom Host to Local

Teamn » Fetch Latest from Host

At the element level, right-click on the element name in the OS 2200 Explorer view and select Sync.
This dialog is displayed:

Sync k @ Update Project Status
Send Using E-mail %  Syncfrom Local to Host
%‘R Run C/C++ Code Analysis T Syncfrom Host to Local
Team k | Fetch Latest from Host
Compare With k [% Compare with Host copy

To use this feature, right-click on the selected project, work file, or element, and click Sync, and then
click one of the following relevant context-sensitive menus:

» Update Project Status: This option updates the work file or element icons in the project tree.
The color coding of the icons are updated accordingly depending on whether the elements are
synchronized with the OS 2200 system.

» Sync from Local to Host:
This option synchronizes the element, project, or work file that are modified locally by
copying the contents of the element, project, or work file in the cache to the OS 2200 system.
Note: If the selection is a work file or a project, this option lists all the elements that are
changed in the local cache.
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Sync from Host to Local:

This option synchronizes the element, project, or work file by copying the contents of the
element, project, or work file that are modified on the OS 2200 system to the cache.
Note: If the selection is a work file or a project, this option lists all the elements that are
changed on the OS 2200 system.

E Sync element(s) with host. &l

Select the resource to download element(s) from the Host:

List of Out-Off Sync Element(s): 6

#* \ROBNROBLELT

#% \ROBI\TEST.COB

#% \ROBITEST-COMP.ELT
#% \ROBNTEST-ECLELT

*

[ m

1

ol il mmmn a1 = —mme
1| 1] k
@' [ OK l ’ Cancel

Or if a single element is out of sync, the following dialog is shown:
(L4 Conflict

“ROBRTEST-PROC.ELT' is in conflict with the element on the host,

Do you want to continue downloading from Host?

Compare with Hostl ’ Download ] ’ Cancel

Fetch Latest from Host:
This option fetches the contents of the element, project, or work file from the OS 2200 system
to the cache. You can override all the local changes with that of the OS 2200 system.

E Sync latest from host, ﬁ

Select the resource to get latest from Host:

List of Out-Off Sync Elernent(s): &

#% \ROBMNALLOC.COB

#% \ROBMNTEST-ECLELT
#% \ROBMNTEST-PROC.ELT
#% \ROBI\TEST.COB

ol il mmmn e —me am e

1| 1] r

[T S

1

@' [ Ok ] ’ Cancel

Compare with Host copy: This option compares the cache copy with the OS 2200 system
copy of an element. The results are opened in an editor window the same as using OS 2200

Compare.
Note: This context-sensitive menu is available only for an element and not for a work file or

project.
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Sorting Project Files

The OS 2200 elements in the project work file can be sorted by Name or Date by right clicking on on
the project in the OS 2200 Explorer view:

Profile As »

Restore from Local History... hare | AR
Sort By P % Name
Sync » |72 Date
NS 220N p 19°

Name order is in ascending order while Date order is latest to oldest.

Automatic Open of a Single File

If a single source element is added to a project, Eclipse will automatically open the element with the
appropriate editor.

MHFS Considerations
When a new OS 2200 Host is defined, there is a check box to indicate if the host uses MHFS:

Port Murnber IE

Characker Conversion I <MNONE = j
Prompk Character I?

5L Port r

MHFS v

Eclipse does verify if the system is configured for MHFS. The incorrect setting for this option could
lead to unexpected errors during other operations.

Select STD# for files stored on local discs or SHARED# for files on shared storage. Note that the
same file name could exist in both STD# and SHARED#. Eclipse uses this setting to access to desired
file.

Creating a new OS 2200 Work File.

When running the Create New OS 2200 Project wizard, an existing OS 2200 work file can be entered.
However Eclipse has the option to create the OS 2200 work file. After entering the project name and
connection, click on the Create New Work File button.

Create Mew Work File

The next dialog allows you to enter the OS 2200 Work File name:

Page: 48 of 158
Version: 4.1 File: Eclipse OS 2200 IDE Getting Started v4.1.docx



.
UN[SYS ClearPath OS 2200 IDE for Eclipse Getting Started Guide

|

E Create Mew Work File

WorkFile Mame:

For sites that run MHFS
@ STD# SHARED#

Access
@ PUBLIC () PRIVATE

Type(Addressable)
@ SECTOR () WORD

Initial Reserve: 0

Granule
i@ TRK ) POS

Max Length: 256

Pack-1D:

ACR-Mame:

Enter the parameters as desired:

The ‘Composed entry:’ field can be further edited. Click OK.

After cataloguing the file on the 2200, Eclipse fills in the Work File name and then you proceed with
the wizard as explained above.

Deleting an OS 2200 Project
Right click on the project and select Delete. Eclipse displays the following dialog.
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{ ¥ Confirm Project Delete x|

€p | Are you sure you want to delete project "Exxx'?
\{'/
" flso delete contents under 'CEclipse3-7 Workspace! !

¥ Do not delete contents

Yes Mo

This operation does not delete the OS 2200 work file.

Maintaining your OS 2200 Project

The wizard is used to define the initial project properties but these can be maintained later. In a later
section there is an explanation of how to maintain the Build and Brkpt properties.

To maintain the existing project properties, right-click on the project name and then select OS 2200
and then Update OS 2200 Project as shown below.
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+ 0522 TEST.COB TEST-COMP.E
Mew
ey 1 @delete,c robj*brkpt.
4T Open in New Window 2 fdcat,p robj*brkpt.
o+ 3 @use brkpt,robj*brkpt
.= C Remove from Context Ctrl+Alt+Shift+ Down 4fibrkpt prints/brkpt
% . c 5[@UCOB,1 robj*workfile.al
4 RE W &f@link,1 ,robj*workfile.z
a Paste 7include tpf%.allocom
! % Delet g resoclve all references us
SISt 9 DELETE ALL DEFINITIONS E
. Move... 18 process for extended
’ &J f Rename... 1:} @?Gf i . e
4
s Import.. E B _
@ E}(F}ort,,, U LA HosT vianage |~ = A
URPUR 33R1 (168615 1654:25)
q}G:. Refresh
e {0BI*WORKFILE IS NOT CA
Close Project AC STATUS: 4ee8leaoeoss
cat,p robj*workfile.
U7 082200 Search ;802333 CAT complete.
ed,iq robj*workfile.dummy
[ | NDATES Scarch D 16R1E SUN-83/19/17-8@:44::
Ind MPUT
nesx I:>
Build Configurations r
DIT
Validate
. : >»INPUT
[F] Convert to Fortran Project - SEDIT
Run As Fo):zexit
MD ED. LINES:@ ASCIT
Debug A 3
= 'jjg : fiprt,t robj*workfile.
Profile As b fURPUR 33R1 (168615 1654:25)
Restore from Local History...
sort By » ITD#ROBI*WORKFILE(1) PF, 1/54
Sync ] ET DUWEB:' o
05 2200 v | [# Create New Element
%7 Run C/C++ Code Analysis =2 Update 052200 Project
Or click the icon in the menu bar.

This launches a wizard that is similar to the new project wizard.
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Updating 05 2200 Project (= |[E=f = |
Add or remove elements -

Add program file elements to your O5 2200 project.

Warkfile: ROBI*WORKFILE.

Waork File Contents Project Contents

Element Link

Search Element Search Element

(Include ¥, * and % as Wildchars) (Include ¥, * and % as Wildchars)
DUMNY ALLOC
TEST ALLOC-COMP
TEST/COMP

TOC refreshed on 2017,/03/19 14:25%:20

Add Element attributes, Change element attributes.
Editer Editor
< default> <default= Change
Character Conversicn Character Conversicn
<MNOME=> <MOME=

® [ Finish ] ’ Cancel

L &

Note the Search text boxes can be used to filter the contents of either pane. Use ‘*’ and ‘?” as wildcard
characters.

Note to change the editor for a file, you must highlight the file, select the required editor and click
Change. The available editors are:
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Editar

I “default> = I

“default
ELT

COB

i

H

1604
FOR
A5M
MsM

PLS

Adding a new OS 2200 Element to a Project

You can add a new element to your OS 2200 program file by creating an element in your Eclipse OS
2200 project. For example, you may want to write a new COBOL program. In the Explorer tree, right-
click on the project name and then select OS 2200 = New OS 2200 Element.

—

+ 0523
Mew 2
.+ 1 @delete,c robj*brkpt.
o+ Open in New Window 2ficat,p rebj*brkpt.
+ 3 [@luse brkpt,robj*brkpt
> 2 Remove from Context Ctrl+Alt+Shift+ Down 4 @brkpt printd/brkpt
o c SEUCOE,1 robj*workfile.i
44| B Copy 6 @link,1 ,robj*workfile
4 Paste 7 include tpf$.allocom
8 resolve all references |
% | Delete 9 DELETE ALL DEFINITIONS |
. Maove... 18 process for extended
> B Rename... "@ED{ i e
4
ixy  Import..
iy Export.
FURPUR 33R1 (1p@E15 1654:25
«%  Refresh
Bl ROBJ*WORKFILE IS NOT C
Close Project FAC STATUS: 4ea8lecaaose
»lcat,p robj*workfile.
U7 (S 2200 Search 1:@882333 CAT complete.
sled,iq robj*workfile. dummy
[Q TDATES Search ED 16R1E SUN-83/19/17-00:44
INPUT
Index " a1
Build Configurations 2
EDIT
Validate
. a:=INPUT
[F] Convert to Fortran Project b1 SEOET
Run As FolB:rexit
END ED. LINES:@& ASCIT
Debug A 3
= I_Jg : Hiprt,t robj*workfile.
Profile As ¥ |FURPUR 33R1 (168615 1654:25
Restore from Local History...
sort By » |STD#ROBI*WORKFILE(1) PF, 1/
Sync » [ELT  DUMMY(@)
05 2200 ¥ | [§ Create New Element
7 Run C/C++ Code Analysis =% Update OS 2200 Project
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An alternate option is to use the menu File > New = OS 2200 Element.

E eclipse-2200-4-6-0-160920 W5 - OS5 2200 - ROBPWORKFILEALLOC/COMP ON R302.RSVLUMISY:
File | Edit Mavigate Search Project Run 052200 Window Help
New Alt+Shift+M » | -® 08 2200 Project
= Mew Text File ™ Project...
Open External File With ...
M8 roate Mlew Flamment

Yet another option is to right click the OS 2200 Work File in the Explorer View and select New -
OS 2200 Element.

[# 052200 Element

¥ Test H L HOVE "#xsssn
‘ E| EW 99 STRIHG "ERE-3TL " ERROE-3TAL'
- G I d - 05 2200 Project
: c'\- o 3 .
= s Remove frann Context CErH-AlE+Shif- Do W
T Em
= [‘E-: R [# s 2200 Element

Yet another method is to click the [ icon in the Icon menu bar.
Eclipse will respond with the following wizard:

-

[ [ New OS 2200 Element B

Create a new element

Create a new element in your 0% 2200 project and work file,

=
05 2200 Work File: ROBJFWORKFILE.
Element Mame:
Project Entry:
Select Symbolic Sub-type:
Select Character Conversion: ’<NGNE:~ v]
@)

L

Enter your OS 2200 element name and select the symbolic subtype (choose COB for COBOL). If
Character Conversion is required, please select the appropriate language otherwise leave as <NONE>.
Note that the element name must comply with standard OS 2200 file naming conventions for syntax
and characters etc. Using element/version is valid. Note the status message displayed in the window.
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U New 0S5 2200 Element il New DS 2200 Element

Create a new element Create a new element

@ Elerment name already exisks in wark file, @ Ilegal &5 2200 elerment name
05 2200 Wark File: Unisys*rob, 015 2200 Work File: Unisys*rob,
Element Mame | DEFMAS] Element Mame My
Project enkry: DEFMAS Project enkry: b

After entering a valid element name, click Finish.

A new editor pane will be opened to allow the data entry of the source. Note the editor is based on the
symbolic subtype that was used when creating the element.

@ eclipse-2200-4-6-0-160920 WS - 05 2200 - ROBWORKFILE NEWELT ON RS02.RSVLUNISYS.COM -
File Edit Source Mavigate Search Project Run 052200 Window Help

- B S @il BN R S @ W B

+ 052200 Explorer 52 [(2] OS 2200 File Explorer = 0 |=| MEWELT.ELT &3

. % APPSVNPROCS 1
. [* DORADOROB
. [* DPSPROCS
. [* QRPROG
a * R
4 %% ROBJFWORKFILE.
[ ALLOC MAR 14, 2017 5:05 PM
E ALLOC-COMP MAR 16, 2017 4:58 PM
E, NEWELT.ELT MAR 19, 2017 4:00 PM

Note that the navigation tree has been updated as well.

Deleting OS 2200 Elements from your Project

Right click on the file in the project and select Delete. Eclipse displays a dialog to control the actions
to be performed. Select the appropriate option and click Yes.

@ Confirm Resource Delete &J

Are you sure you want to delete the linked resource, NEWELT?

@ [o not delete the element in G5 2200 work file
(71 Delete the elerment in the 05 2200 work file: ROBIFWORKFILE.
i) Delete the element and all its versions in the 05 2200 work file: ROBJWORKFILE.

Yes || Mo

Renaming or Changing the Type of OS 2200 Elements
Right click on the file in the project and select Rename/Type Modification.
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@ eclipse-2200-4-6-0-160920 WS - OS5 2200 - Eclipse
File Edit Mavigate Search Project Run 052200 Window Help

m L E Sl ENRE R
4 (05 2200 Explorer i3 05 2200 File Explorer = B
. [* APPSVNPROCS
. [* DORADOROB New >
. [* DPSPROCS
. (¥ QRPROG EEe
4 ¥Rl Open in Read-Only Mode
4 @ ROBI*WORKFILE. Open With *
a5 ALLOC MAR 14, 2017 5:05 PM
[H ALLOC-COMP MAR 16, 2017 4:58 PI Remove from Context Ctrl+ Alt+Shift+ Down
|75 MEWELT.ELT MAR 18, 2017 4:02 PM Mark as Landrmark Ctrl+ Alt+Shift+Up
4 ¥ ROE) = Copy
s @ ROBI*WORKFILE. Paste
3 Delete
Move...
= Import.
i Export.
.;;éh Refresh
':5 ' 052200 Search
[@ TODATES Search

Copy 05 2200 Path
[% 05 2200 Compare

Validate
Rename/Type Modification

Eclipse displays a dialog where you enter the new element name, symbolic subtype and character
conversion language.
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[} Rename/Type modification I. | [=] ﬂhJ

Rename/Type modification

Rename/Modify-Type for element in your O5 2200 work file,

05 2200 Work File: ROBI"WORKFILE.

Element Name: RENAMED]

Project Entry: REMAMED.ELT

Select Symbolic Sub-type: ELT A

Select Character Conversion: ’<NGNE> v]

@' Finish l ’ Cancel

Click Finish to action.

Moving OS 2200 Elements

A file in one project can be moved to another project. Right click on the file in the project and select
Move.
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i Folder Selection ;IEIEI

Select the destination:

| coo1-Rob

- =

-1 Co01-Rob
ILt cd01-sl

&% RS16E-RUN

@ O, I Cancel

Eclipse will try to move the element to the new project. If the element already exists in the destination
0OS 2200 work file, the following dialog is displayed.

-I::}Name Conflict x|

Enter a new name For TLETN

MLETH

Wou must use a different name
For 052200 elementversion, use element, version

o I Cancel |

After the move, the destination project is updated with the new element. (Note MLFTN3 was used to
overcome the name conflict in the example.)

Page: 58 of 158
Version: 4.1 File: Eclipse OS 2200 IDE Getting Started v4.1.docx



.
UN[SYS ClearPath OS 2200 IDE for Eclipse Getting Started Guide

El'[L,»+ Mewrob
E-E new*rob.
----- [ify ozE039-txt, COB
----- [y OzE059-txt, COR
----- [ify GETESE.COB
----- [F MLFTME.FOR
----- [ 02e039.C08
----- |5 robLELT
----- 5@y best.ELT
=¥ Rob
= unisys*rab,
=¥ Robz
EH-E= Unisys*rab,
=¥ Test
-2 unisys*rab.

- [y E-TESTELT
|g GETES#A-comp ELT
[if GETESA.COB
& MLFTN-COMPELT
G rLFTH. FOR

------ |5 files1r1-5gs. ELT
[+-T=F keskmlj
Note an element can’t be moved to a project using the same work file.
E Mowe 05 2200 Resources —— ﬁ

Move between the same workfile on the same machine is not allowed.

Copying OS 2200 Elements
Right click on a project file and select Copy.
Highlight the destination project, right click and select Paste.

Eclipse will copy the file to the new project. If the element already exists in the OS 2200 work file,
the following dialog appears.

{"¥Name Conflict x|

Enter a new name for 'E-TEST'

You must use a different name
For 052200 elementversion, use element. version

Ik I Cancel

Or you can highlight an element in one project and drag/drop to another project in the OS 2200
Explorer pane.
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Using the OS 2200 Explorer View

The Explorer View lists the OS 2200 Projects defined in this workspace. If you expand the node, the
next level shows the OS 2200 work file name. If you expand this node, you will see the source
elements that comprise the files in your project.

+ 05 2200 Explorer &3 (05 2200 File Explorer = O

. ¥ APPSVNPROCS
4 |* DORADOROB
4 %% DORADO*ROB.

|5, ALLOC-COMP-DEBUG.ELT MAR 15, 2017 11:11 AM
[y ALLOC-COMP.ELT MAR 14, 2017 4:49 PM
[ ALLOC-COMPACOB.ELT JUN 19, 2016 12:05 PM
[y, ALLOC.COB MAR 14, 2017 5:05 PM
L DEFMAS.COB MAR 19, 2017 6:25 PM
[, DORADOROB.ELT MAR 15, 2017 1:53 PM
[, MLFTN.FOR MAR 189, 2017 4:59 PM
[ TEST-SSG.ELT APR 4, 2017 2:29 PM

. [* DPSPROCS

. ¥ FTN

. ¥ 133P7UTIL

. ¥ LINCROB

. * QRPROG

. L* R

. ¥ ROBJ

The project type is indicated by the icon next to the project name. All of the above projects are OS
2200 Projects.

Note if the source element has a version, the version is appended to the element name after a hyphen.
For example, element ALLOC/COMP becomes file ALLOC-COMP.ELT. The extension on the file is
important as it determine what Eclipse editor is used. COB will launch the COBOL editor, FOR will
launch the Photran editor (Eclipse Fortran editor). ELT will launch the generic editor. The editor to be
used is displayed in the icon next to each file. Note that Eclipse will try to determine the editor to use
if the extension is TXT.

Supporting Multiple Projects

Follow the procedures above to add more projects. The projects are added to the navigation tree and
sorted in project name order.

+ 05 2200 Explorer &3 05 2200 File Explorer = O

. |* APPSVNPROCS
. ¥ DORADOROB

. ¥ DPSPROCS

. B FTN

. ¥ 133P7UTIL

. ¥ LINCROB

. [* QRPROG

L LR

. ¥ ROBJ

Note that the same OS 2200 Program File (Eclipse OS 2200 Project Work File) can be used in many
different projects.

Page: 60 of 158
Version: 4.1 File: Eclipse OS 2200 IDE Getting Started v4.1.docx



.
UN[SYS ClearPath OS 2200 IDE for Eclipse Getting Started Guide

Page: 61 of 158
Version: 4.1 File: Eclipse OS 2200 IDE Getting Started v4.1.docx



.
UN [SYS ClearPath OS 2200 IDE for Eclipse Getting Started Guide

Using the OS 2200 Project

This section will cover how to edit and build (compile) your project using Eclipse. The following
screen shows the OS 2200 Project perspective. This section focuses on using the COBOL editor. Later
sections discuss other editors like the Fortran editor and Generic editor.

+ 052200 Explorer &3 05 2200 File Explorer

. ¥ APPSVMPROCS
4 ¥ DORADOROB
4 '§ DORADO*ROE.

7, ALLOC-COMP-DEBUG.ELT MAR 15, 2017 11:11 AM
L ALLOC-COMP.ELT MAR 14, 2017 4:49 PM
5 ALLOC-COMPACOB.ELT JUN 19, 2016 12:05 PM
[l ALLOC.COB MAR 14, 2017 5:05 PM
Ry DEFMAS.COB MAR 19, 2017 6:25 PM
. DORADOROB.ELT MAR 15, 2017 1:53 PM
[f MLFTN.FOR MAR 19, 2017 4:53 PM

. ¥ DPSPROCS

¥ FTN

. ¥ QRPROG

LR

s % ROBJWORKFILE.

EL ALLOC-COMP.ELT MAR 22, 2017 1:33 PM
Iy ALLOC.COB MAR 22, 2017 1:33 PM
[l DEFMAS.COB MAR 18, 2017 6:25 PM
gy ROBJLELT MAR 22, 2017 2:18 PM
[ TEST-COMP.ELT MAR 22, 2017 2:19 PM
g TEST-ECLELT MAR 22, 2017 4:27 PM
L& TEST-PROC.ELT MAR 22, 2017 2:38 PM
[y TEST.COB MAR 22, 2017 2:24 PM

Note that the project name is the root of the explorer tree and the OS 2200 program file is shown but
only those elements selected as project files are listed.

The icon before the OS 2200 program file (i.e. the project work file) indicates if the OS 2200 host is

connected ® or not connected ® :
Note the cached OS 2200 TOC timestamp is displayed in local time.

Editing and Saving

Now double click on an element that represents a COBOL program. In the project navigation tree, the
file will have an extension of COB. In this example, ALLOC.COB is selected.
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4 ¥ ROEJ
4 % ROBIWORKFILE.

) ALLOC-COMP.ELT MAR 22, 2017 1:33 PM
I ALLOC.COB MAR 22, 2017 1:39 PM
[ty DEFMAS.COB MAR 19, 2017 6:25 PM
[ ROBLELT MAR 22, 2017 2:18 PM
5y TEST-COMP.ELT MAR 22, 2017 2:19 PM
[ TEST-ECL.ELT MAR 22, 2017 4:27 PM
15 TEST-PROC.ELT MAR 22, 2017 2:38 PM
[y TEST.COB MAR 22, 2017 2:24 PM

Eclipse will retrieve the source from the OS 2200 work file and open using the COBOL editor.

+ 052200 Explorer 2 05 2200 File Explore = 0 ALLOC.COB i3
. ¥ APPSVNPROCS - Y S S - S M
4 [+ DORADOROB i

IDENTIFICATION DIVISION.

4 ® DORADO’ROB. PROGRAM-TD. ALLOC.

2
3
[ ALLOC-COMP-DEBUG.ELT MAR 15, 2017 11:11 AM a
[ ALLOC-COMP.ELT MAR 14, 2017 4:49 PM 5 ENVIRONMENT DIVISION.
|54 ALLOC-COMPACOB.ELT JUN 12, 2016 12:05 P 8 CONFIGURATION SECTION.
8
a
o

[} ALLOC.COB MAR 14, 2017 505 EM égﬂiﬁffgf:ﬁﬂig' Hmiggjggg'rfmnv 3 MODULES
[ DEFMAS.COB MAR 19, 2017 6:25 PM : : : :

SPECIAL-MAMES.

5% DORADOROB.ELT MAR 15, 2017 1:53 PM 18 PRINTER IS PRINTER
[Ry MLFTN.FOR MAR 19, 2017 4:59 PM 11 CONSOLE IS CONSOLE.
. ¥ DPSPROCS 12
g 1 oRcmie-stomace secrion
+ [+ QRPROG iis Bl  WS-WORD PIC 1(36).
> (R 16 @1 WS-WORD6 REDEFINES WS-WORD.
4 ¥ ROB) i1z 83 WS-51 PIC 1(6).
4 % ROBJWORKFILE. i18 83 WS5-52 PIC 1(6).
[ ALLOC-COMP.ELT MAR 22, 2017 1:33 PM e g3 1s s PIC 1(6).
[y ALLOC.COB MAR 22, 2017 1:39 PM i ol gg zz; Eig ii:g :
[ DEFMAS.COB MAR 19, 2017 6:25 BM i22 63 WS-56 PIC 1(6).
|ES] ROBJ.ELT MAR 22, 2017 2:18 PM 23 @1 WS-WORD4 REDEFINES WS-WORD.
|54 TEST-COMP.ELT MAR 22, 2017 2:12 P i2a 83 WS-01 PIC 1(39).
TEST-ECLELT MAR 22, 2017 4:27 PM 1S 03 Ws-Q2 PIC 1(9).
== . = ize 83 Ws-Q3 PIC 1(9).
[ TEST-PROCELT MAR 22, 2017 2:38 PM a7 23 WS4 PIC 1(3).
[eg TEST.COB MAR 22, 2017 2:24 PM 28 b1 wWs-TEST.
izo 85 TEST-COMPL PIC 9(81) COMP.

Eclipse has now displayed the contents of the element in a separate tab in the editor window. Since we
had identified this element as a COBOL program, the editor uses the UCS COBOL template to
highlight the code in different colours for reserved words, statements, comments and user variables.
These were the COBOL preferences that we configured earlier.

One of the advantages of using Eclipse is that multiple files (OS 2200 elements) can be open at any
time. These could be from one project or multiple projects. You can double click a file in the
navigation tree to open or right click the file name and then select Open. Eclipse will open a new tab
for each file as it is opened as shown below.
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P
GETEGA, COB (|_| GETESA-comp . ELT (Iﬂ MLETM.FOR 52

WRITE (&, 1200)
1200 FORMAT (' Conwvert octal seconds since widnight (TDATEZ) to time')
100 WRITE (6,1100)
1100 FOPMAT (' Give octal time (& digits)')
BREAD (5, 1000, END=999) T
1000 FOBMAT (D8]
IHR=I/3 600
IREM=I-TIHR*3 600
ININ=IREM/ &0
IREM=IREM-IMIN¥*&0O
WRITE (&,1001) I, IHR, IMIN, IREN

1001 FORMAT (1X,'0',06,' = ', J2,':',J2,':',J2)
GO TO 100

299 STOP
EHD

Therefore you could have multiple files representing different source programs open at the same time.
It is a simple matter to click on the appropriate tab to change the focus to the required source for that
file. Code can be copy/pasted between panes — even if the files are in different projects.

Note that after you update the source code, an ‘*’ appears before the element name in the tab. See
below for an example.

( *ZETBSA.COB 53

These edits have only been made to the version of the file (element) stored on the workstation and not
on the OS 2200 host. When you save the element, the updates are applied to the element in the OS
2200 program file. Eclipse will also maintain a local history of saved versions that will be discussed
later.

Note that Eclipse does no syntax checking or compiling. The editor template provides assistance to
improve your productivity. We will discuss some of the editor features later. Incorrect syntax will be
reported after the program is compiled on the OS 2200 host when you build the project.

Opening an Element in Read-Only Mode

By default, Eclipse will open elements in update mode. If you want to open an element in read-only
mode, right click on the element in the Explorer View and select Open in Read-Only Mode.

E eclipse-2200-4-6-0-160920 WS - OS 2200 - DORADOROE/MLFTN.FOR - Eclipse
File Edit Refactor Mavigate Search Project Run 052200 Window Help

=1 |um§ > S Ei»[}v%I"Liz
+ 05 2200 Explorer &3 05 2200 File Explorer = B [
. (¥ APPSVNPROCS SERRRAY STt SOFOR i ST TSRS SRR
4 [s% DORADOROB New >
4 % DORADO*ROB.
[ ALLOC-COMP-DEBUG.ELT MAR 15, 203 Lis
E ALLOC-COMP.ELT MAR 14, 2017 4:43 P Open in Read-Only Mode
[ ALLOC-COMPACOB.ELT JUN 19, 2016 3 Open With ’
[y ALLOC.COB MAR 14, 2017 5:05 PM
@ DEFMAS.COB MAY 2. 2013 1:42 PM Remowve from Context Ctrl+ Alt+ Shift+ Cown
L : Y 3, :
% DORADOROB.ELT MAR 15, 2017 1:53 PH Mark as Landmark Ctrl+ Alt+ Shift+ Up

If the user tries to update the element, the following prompt is received.
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(i) Warning - Make file writable |

File "\DORADOROE\DORADOROB.ELT is read-only. Do you wish to make it writable?

| Ok | ’ Cancel

The user can decide whether they want to proceed and change the element so it can be updated.

Using the Save option
To save an element, you can

a) click the diskette icon in the tool bar,
b) right-click in the editor pane and select ‘Save’ or
c) use File > Save.

Eclipse uses CIFS to update the OS 2200 program file element. The following example shows using
the diskette icon: Clicking the single diskette icon will save the current program. Clicking the multiple
diskette icon with save all updated elements.

[ eclipse-2200-4-6-
File Edit Scurce

O~ B & &

The next example using right-click in the editor pane appears in the next screen snapshot:

Open Declaration...

Undo Ctrl+Z
Revert File
|zl Save Ctrl+5

Finally you can use File > Save.

E eclipse-2200-4-6-0-160920 W5 - OS5 2200 - ROBI*WORKFLE.ALLOC
File | Edit Mavigate S5Search Project Run Q52200 Window |

Mew Alt+Shift+N »

Mew Text File

Open External File With ...

Create Mew Element

I

L

Open File...

[} Open Projects from File System...

Cloze Ctrl+W

Close All Ctrl+5Shift+W
|zl Save Ctrl+5

Save As.., 3
5 Sawe All Ctrl+5hift+5

Using the Save-As option
Eclipse provides the ability to use a Save-As function with 3 options:
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1. Save to the Workspace
2. Save to Local Disk
3. Save to a Configured Server

Go to File -> Save As...
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - ROBJ*WORKFILE.ALLOC ON RS02.RSVLUNISYS.COM - Eclipse
[File| Edit Mavigate Search Project Run 052200 Window Help

Mew Alt+5Shift+MN » B e ey
2 New Text File
Open Beernal File With ... =N X
[# Create New Element i _I“+““1““'
Open File... 2 IDENTIF,
[, Open Projects from File System... ? PROGRAM
Close Ctrl+W 2 Eg:II:EEEJI
Close All Ctrl+Shift+W 7 SOURCE -1
- 8 DBIECT -1
|zl Save Ctrl+5 g SPECIAL
Save As... » Save To Workspace
5] Save All Ctrl+5Shift+5 Save To Local Disk
Revert Save To Configured Server

Save To Workspace

This option allows you to save the source file to a project defined in your workspace. For OS 2200
Projects, it does not save the source to the associated OS 2200 work file. Highlight the destination
project, change the file name if required and then click OK.

Page: 66 of 158
Version: 4.1 File: Eclipse OS 2200 IDE Getting Started v4.1.docx



.
UN[SYS ClearPath OS 2200 IDE for Eclipse Getting Started Guide

FE [ e

Save As
€3 Mo folder specified.

Enter or select the parent folder:

. (¥ APPSVMPROCS
. ¥ DORADOROB
. ¥ DPSPROCS

. i FTN

. ¥ QRPROG

. R

. ¥ ROBJ

File name: | [RsleNae]:}

|

Save To Local Disk

Use this option to save the source file to any folder accessible by your workstation. You can browse to
select the drive from the “Save in:” text box. The File name and file type can also be changed if
required. Then click OK.
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-

Save As
@@! &+ Computer » OSDisk (C9) »
Organize » New folder
& OneDrive “  MName Date modified Type Si*
Bl Desktop .
A, 09a09db4759dcf473859 10/22/20159:30 PM  File folder
o 11 125c515477abel382f7052 10/15/201512:55 ... File folder
7 Libraries .
| cBE8140cffa5683beb 2/16/2016 9:05PM  File folder
@ Documents . . l
J’ . L CSVDir 9/20/2014 4:13 PM File folder
e Ji Demo-MonitorDirectory 9/21/2014 1:40 PM  File folder
[&5] Pictures R 0 :
i - 1. Demo-MonitorDirectoryDelete 9/20/2014 4:.07 PM File folder
ideos
1 Disable_IE_11AU 0/22/20149:34 AM  File folder
. 3975144266177 ccllc16f2 1/22/2016 2227 PM  File folder
Lol Computer . i )
ﬁ 0SDisk (3 | Eclipse 2200 4-4-1-IC2 W5 3/14/2017 4:26 PM File folder
isk (C:
1 eclipse-2200-4-6-0-160920 3/4/2017 9:55 PM File folder -
-~ s < | n | b
File name: [AESelefalel: -
| Save as type: ’*.* v]
(% Hide Folders [ Save I [ Cancel ]

Save To Configured Server
This option will save the file to the selected OS 2200 host.
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E Save As To Configured Server

==

Connection | S0CS0

7 |

=

Share

@ Share Marme () Worlkfile Share

052200

File
Create Mew Warkfile

STDe SHARED#

DORADCO*ROB.DEFMAS

-

[l

MOTE: Mew file would be created with 262143 tracks,
unless created manually(Try '"™New WorkFile' option].

[
-

©)

G0

/|

Cancel

b

Select the connection if you want to save on a different OS 2200 host.

Select the CIFS share name.

If a new OS 2200 work file is required, click Create New Work File.
Finally enter the OS 2200 element name (including optional version) and click GO.

If the destination element exists, Eclipse will report this:
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ﬂ File already Exiskts x|

Crverwrite existing file:
h_"'/ MISYS*ROB, DEFMAS

COBOL Content Assistant and Auto Completion

The Editor template also provides for content assistance and auto-completion to assist the
programmer. For example, a programmer is developing a new program and cannot remember the
format of certain COBOL structures and statements. The programmer can hit ‘Ctrl-Space”’ or select
Edit = Content Assistant from the menu bar. Eclipse will display a pop-up with the COBOL
statements as shown below. The statements are limited to the COBOL division that you are working
in.

DATA DIVISION header - DATA DIVISION header |4 [PROGRAM-ID. Programiame.
DECLARATIVES header - DECLARATIVES format |+ I3 COMMON PROGRAM 1
USE statement (AFTER EXCEPTION) - USE statem | = I5 IMITIAL PROGRAM

ACCEPT statement - ACCEPT stakement

ADD statement - ADD statement

A0D statement (GIVIMG) - ADD skatement

A0D statement (CORRESPOMDIMG) - ADD skakem
CALL statement - CALL statement

CAMNCEL staterment - CAMCEL stakement

CLOSE staterment - CLOSE skatement

COMPUTE skatement - COMPUTE statement W

£ >

The programmer can then scroll thru the list to find the required statement. Hitting ‘Enter’ will result
in Eclipse putting a template of the statement in the program source where the cursor was positioned.

If the programmer knows the first character/s of the verb but not the rest of the statement, then they
can use auto-completion via the content assistant to help. For example, if you enter ‘STR” as the first
characters on a new line and then invoke the content assistant (Ctrl-Space), Eclipse will show a pop-
up with only those COBOL statements that begin with ‘STR’.

a9 IHNTD GLE-REASON.
110 sTH|
111 EXT STRING statement - STRING statement STRING Identifier1 DELIMITED BY Identifisr2
112 . INTC Identifiers
*= WITH POINTER Identifier
113 FETCH-E *= 0N OVERFLOW
114 * M *=  Skatement
- . - *x MNOT ON OYERFLOW

ﬂ *x sbatement
- _ * =EMD-STRING N
i Tasks ﬂ"’_ Problems (ﬂ 4 o
1osk Mame L
iL CO01 . MAUIS, UNISYS. COn

By transmitting ‘Enter’, the STRING statement template as shown in the right pop-up is inserted in
the code.
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Ltuz
110
111
112
113
114
115
116
117
113

R=
Rl=
Gd=3
Rd=3
Rl

ALY STLLUT LMY .

STRIHG ISnstsiSal DELTMITED BY (Identifierz
IHTO (Identifiers

WITH POINTER Identifier
OM OVERFLOW
Jtatement
NOT ON OVERFLOW
statement

*FEND-3TRING

The cursor is moved to the Identifier field where the programmer can type the appropriate variable
name. If the statement has more than one variable, Eclipse will display multiple Identifier fields that

can be tabbed to.

Searching Files, Projects and Workspaces

There are two search features — OS 2200 Search is for generic use while TDATES$ Search is to assist
in TDATES remediation work.

0OS 2200 Search

Eclipse provides an inbuilt searching capability that works on files, projects and workspaces. It does
not work on data files or OFE opened elements.

Go to the Menu -> Search
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - DORADO*ROB.

File Edit Mavigate | Search | Project Run Q52200 Wi

At e N = '
05 2200 Search Ctrl+Alt+E
+ 052200 Explorer 23 4" Search.. Cirl+H
. [ APPSVMPROC|El®  File..

.

e mAR AP ARAR

Select Menu = OS 2200 Search or use the short cut CtI+Alt+E.
Or use right-click in the OS 2200 Explorer tab:

¥

€ % LE

Mew

Open

Open in Read-Only Mode

Open With

Remowve from Context Ctrl+ Alt+ Shift+ Down
Mark as Landrmark Ctrl+Alt+ Shift+ Up

Copy
Paste

Delete

Move...

Import...
Export...

Refresh

05 2200 Search

Version: 4.1
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Another option is to right click in the OS 2200 File Explorer tab:

Open
Open in Read-Only Mode
Create L
Delete
[% 05 2200 Compare
Copy 05 2200 Path
e Copy
Paste
%' 05 2200 Search
These options will show the following dialog:

r@ Search l (=] |$Jﬂ|

Yy 052200 Search |‘*f;r' Git Search | U5 Java Search I P57 JavaScript 5earch| Al

Containing text:

IPFSPROCY « | [] Case Sensitive

{* = any string, ? = any character, \ = escape for literals: * 2%) [ Regular Expression

[] Match whaole word only

Expand Result(s)
Mumber of line(s) above and below the result:

Scope

i@ Selected resources () All open editor(s)

® Search l ’ Cancel

The Scope will search through selected resources in the OS 2200 Explorer or OS 2200 File Explorer if
checked or thru the open editors. Note that searches using OS 2200 Explorer or open editors only
search thru cached files.

The Expand Results (Number of lines) is useful when viewing the matches in the results pane.

A search for ‘move’ returned these results in the example. Notice the two lines before/after the
matched line.
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5, 052200 Host Manager View - CIFS  J=| Tasks 5. Problems @ COBOL Code Guidelines Y’ 05 2200 Search 3

‘mowve’ - 304 line(s) matched in open Editor(s)

4 [ DEFMAS.COB [L/DORADOROE/DEFMAS.COEB] (283 line(s) matched)
4 o 571 MOVE 1 TO THREAD-FLAG.
569 IMPART.
570: OPEM ALL USAGE-MODEIS RETRIEVAL.
571: MOVE 1 TO THREAD-FLAG.
DTJ) e
573: ™ Access RDMS5 USE, DECLARE, OPEM and INITIAL FETCH

MOVE 0 TO THREAD-FLAG.
MOVE IM-TRANS-CODE TO RR-TXMCODE,

* Mowe DPS Scratch Area fields to output buffer. Set indicator
MOVE "InitSession " TO O-51{1:20).

[= LY, |
[¥a]
[X=]

>

]

(=]
=]
Ln

]

The results can be expanded to show the element and line number. Double click the line number to
open the element in the editor and position the cursor on the line.

Notice the Icon |7 next to all lines that matched the search.

TDATES Search

The TDATES$ search will search for predefined patterns that will assist in TDATES remediation
efforts. Various search criteria can be maintained and used. The search can be performed on selected
resources or editors as required.

From OS 2200 Explorer view, right click to get the context menu and select TDATES$ Search.

Mew 3

Open
Open in Read-Only Mode
Open With 3

Rernowve from Context Ctrl+ Alt+ Shift+ Down
Mark as Landrmark Ctrl+Alt+ Shift+Up
2| Copy
Paste
Delete

¥

Move...

Import...
Export...

Refresh

05 2200 Search
TDATES Search

¥ % FF

From OS 2200 File Explorer view, right click to get the context menu and select TDATE$ Search.
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Open
Open in Read-Only Mode
Create r
Delete

BRy 052200 Compare
Copy 05 2200 Path

e] Copy

Paste

]:5' 05 2200 Search

[@ TDATES Search

@ Send Using E-mail

Or use the ic! icon from the menu.

The following dialog is displayed:

([ TDATES Search S |

T
it
,H_.
,H_.
,H_.
He
H:
,H_.
,H_.
,H_.
,H_.
,H_.
,H_.
,H_.
H:
H
H
,H_.
,H_.
,H_.
He
He
,H_.
,H_.
H
H:
H
H
He
He
H:
,H_.
,H_.
H:
H
H
,H_.
,H_.
H:
H
,H_.
,H_.
,H_.
,H_.
,H_.
,H_.
,H_.
H
H
,H_.
,H_.
,H_.
He
He
,H_.
*

# This is a sample file containing a search string.

m

# The content of the search string must conform to Java regular expression.
#1f there are any reserved character, it must be escaped using a backslash.

’ Clear ] ’ Load Sampletd

Save
[] Case Sensitive
Expand Result(s)
Mumber of line(s) above and below the result:
Scope
@ Selected resources () All open editor(s)
'i?;' Search ] ’ Cancel

L

By default, the Sample.txt search criteria is displayed. This file is located at:
C:\<Eclipse install folder>\plugins\com.unisys.tde.ui_4.6.0.20170220\Sample.txt

Check the Selected resources field if the search is using OS 2200 Explorer or OS 2200 File Explorer
files or elements. Check the All open editor(s) to only search the source in the editors.

Comparing different source versions

As mentioned earlier, Eclipse maintains different source versions in the workspace on the
workstation.

Configuring Compare Tools
The OS 2200 IDE for Eclipse comes with a configured default compare tool:

Cormpare Toel | ECLIPSE DEFAULT COMPARE TOOL-<DEFAULT = -
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Clients can configure other compare tools. Select Menu -> OS 2200:
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - DORADO*ROE.DEFMAS ON 10.121.0.23 - Eclipse

File Edit Source Mawvigate Search Project Bun [QSEZW] Window Help

mE

+ 05 2200 Explorer &5 E 052200 F

|-;=-|||ml' l..l-:-_'."-:_

. % APPSVMPROCS
4 7% DORADOROB

N A L Tt T

Select Configure Compare Tool:

: Set ECL Mapping
Add a Telnet Session bound to this project.
Clear Problem List Markers

Update 05 2200 Project

Configure Compare Tool

& e 0

4 Configure Compare Tool ﬁ
Mame Path
ECLIPSE DEFA.. ECLIPSE DEFAULT COMPARE TOOL add
Edit
Remowve
Make Default
?\ QK ] [ Cancel J

Click Add and then browse the necessary executable on the workstation. After this, one of the

available tools can be selected as the default.

0OS 2200 Compare

The OS 2200 Compare utility can be invoked from a variety of methods:

e Click the icon in the menu

e Use Menu -> 0S 2200 -> OS 2200 Compare
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - DORADO*ROB.DEFMAS ON 10.121.0.23 - Ed

Eile Edit 5Source Mavigate Search Project Bun [QSEZ’DU] Window Help

=+

;Fﬂ'@

+ 052200 Explorer 32 [2]

E1|.m§- l

—— e =

b QA LT

. [* APPSVNPROCS
4 ¥ DORADOROB
4 ' DORADO*ROB.

=L Al W -COMP-DIFRI NG FIT BMAR TS 20171

Set ECL Mapping

Add a Telnet Session bound
Clear Problem List Markers
Update 05 2200 Project
Configure Compare Tool

05 2200 Compare

&3 e 17 T O
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e Right click in the OS 2200 Explorer pane and select OS 2200 Compare

Mew

Open
Open in Read-Only Mode
Open With

Remowve from Context

Mark as Landmark

|l=

Copy
Paste

Delete

b

Move...

Import...
Export...

Refresh

Q5 2200 Search
TOATES Search

B¢ & FFE

Copy 05 2200 Path

BR 052200 Compare

Ctrl+ Alt+ Shift+ Down
Ctrl+ Alt+Shift+Up

4

e Right click in the OS 2200 File Explorer pane and select OS 2200 Compare

Open
Open in Read-Only Mode
Create k
Delete
BRy 052200 Compare

Compare Sources in Different Editors

Set focus on one editor. This becomes the base file. Launch the OS 2200 Compare using the icon as

per above.
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Mo BT TN A Bttt Q@ o

DEFMAS.COB 37 [ ALLOC.COB  [f) MLFTM.FOR [ DORADOROB.ELT DEFMAS.COB

P -

% Compare w : ﬂﬂ

Base File DORADO*ROB.DEFMAS

D Swap
™

Compare File ROBJ"WORKFILE.DEFMAS

ROBJI"WORKFILE.ALLOC
DORADO*ROB.MLFTM
DORADO*ROB.DORADOROE

ROBJI"WORKFILE.DEFMAS

Compare Tool | ECLIPSE DEFAULT COMPARE TOOL<DEFAULT = - ]

@ [ ok || canca |

——

Then select the other editor to be compared to, select the compare tool and then click OK. (Use the
Swap button the exchange the base and compare files.)

The results are shown in an editor pane:

DEFMAS.COB ALLOC.COB  [F) MLFTNFOR ¥ DORADOROB.ELT DEFMAS.COB A0 Comparing DORADO*ROB.DEFMAS and ROBIWORKFILE DEFMAS 52 =g
|=| Text Compare gk A T
DORADO*ROB.DEFMAS ROBJ*WORKFILE.DEFMAS

597 * END THREAD. 594 PERFORM TXN-STATS THRU TXN-STATS-EXIT.
598 COPY END-THREAD IN PROCLIB. 595

599 MOVE @ TO THREAD-FLAG. 598 DEPART.

6088 STRING Test DELIMITED BY test 597 * END THREAD.

601 598 COPY END-THREAD IN PROCLIB.

682 WITH POINTER Identifier 599 MOVE 8 TO THREAD-FLAG.

603 ON OVERFLOW / 600

684 Statement 681 *#**  Terminate DPS =
685 NOT ON OVERFLOW 602 PERFORM DP5-TERM THRU DPS-TERM-EXIT. 4
605 statement 603

687 END-STRING 684 **%* Terminate this transction. Different logic in multi-inital.

) 6@5 FINISH.

689 686 STOP RUN.

610 *=* Terminate DPS 687

611 PERFORM DPS-TERM THRU DPS-TERM-EXIT. 688 MAIN-LINE-EXIT.

612 609

613 *** Terminate this transction. Different logic in multi-inital. 610 * Process the message received from ePortal

614 FINISH. 611 PROCESS-MESSAGE.

615 STOP RUN. 612 * Add your lecal logic here te identify the transaction type

616 613 * The 88 levels in INBUF will be used.

617 MAIN-LINE-EXIT. 614

618 615 * Check if the session is ative. If not, send init output.

619 * Process the message received from ePortal 616 * PSW@2 sets flag in scratch area

628 PROCESS-MESSAGE . 617 IF NOT SESSION-ACTIVE

621 * Add your local logic here to identify the transaction type 618 * DISPLAY “NEW SESSION" UPON PRINTER -

4 » 4 b

Code changes are identified and the right border indicates the changes.

Compare Sources in OS 2200 Explorer Projects

Select the base and compare files in one or more projects and right click then select OS 2200
Compare.
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Compare Sources in OS 2200 File Explorer

Select the base and compare files from the displayed item list and right click then select OS 2200
Compare.

Referencing COBOL COPY Procedure Source

Eclipse provides a method to define the locations of the COBOL copy procedures used by the COPY
statements in a program. You can refer to the COBOL compilation stream to determine what files are

used. For example, there may be an @USE to COB$PF or an @USE to a use name that appears on

the COPY <name> IN/OF <PDP file>.

Go to Menu -> OS 2200 -> Configure COBOL Procedures
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - DORADO*ROB.DEFMAS ON 10.121.0.23 - Eclipse

File Edit Source MNavigate Search Project
Inb A ER=) N5 5
i
+ 052200 Explorer 3 &
. % APPSVNPROCS ]
+ DORADOROB
' h_, ..a

4 % DORADO*ROB.
& ALLOC-COMP-DEBUG.ELT MAR 15, 2017 1 [ﬂa
i ALLOC-COMP.ELT MAR 14, 2017 4:49 PM | 'C
% ALLOC-COMPACOB.ELT JUN 19, 2016 12:0
[, ALLOC.COB MAR 14, 2017 5:05 PM
[ty DEFMAS.COB MAR 19, 2017 6:25 PM
E DORADOROB.ELT MAR 15, 2017 1:53 PM
[By MLFTN.FOR MAR 18, 2017 4:59 PM

. * DPSPROCS i
. [* QRPROG i3
a @R i

4 ) ROBJI"WORKFILE.
& ALLOC-COMP MAR 16, 2017 4:58 PM
L& Al QC.cORMAR 14 2017 505 PM
Select the host connection name.

Bun | 052200 | Window Help

Set ECL Mapping

Add a Telnet Session bound to this project.
Clear Problem List Markers

Update 05 2200 Project

Configure Compare Tool

05 2200 Compare

Reload Editor

Yiew Log
Save Log
Set Log Level

05 2200 Resource Adapters
Set to Javal.b

Setto Javal.7

Configure Editor Scalability
Configure COBOL Procedures

In the WorkFile Paths, enter Q*F.,Q*F., etc. Unlimited number of files can be entered.

[ Configure COBOL Procedures I. 5] &J

ConnectionMame: ISOCSO v]
Associated Projects: | APPSVNPROCS, DORADORCE,DPSPROCS,QRPROG

Share

@ Share Name () Warlfile Share

052200

WorkFile Mame: SYSSLIBS*F'ROCS.,S?SSUBS*DPSSALTSPROC.,UDSISRC*PDPSLIB.

'fzj' [ oK ] ’ Cancel

e

When you click OK, Eclipse starts the process and shows a progress dialog:
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Progress Information

i ) Copy procedure mapping For workfile : UDSSRC*PDP$LIEB,

[--------------------------- ]

Cancel

There is a complete message for the host connection:

W Information

!

i ) Successfully configured COBOL procedures for SOCSO

Eclipse will build information into either of the following folders:
C:\Users\<User-id>\AppData\Local\Unisys\0s2200\dd
If you check the DD folder, you will see the following files.

Mame Date modified Type
|=Z| CopyProcxml 3/19/2017 7:57 PM AML Document
|| SOCS0 3/19/2017 7:57 PM File

The ‘CopyProc.xml’ file contains the files from the wizard as shown below:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<nsZ:copyProcConnMap xmlns:nsZ2="Copy Proc">

% <copyProcHap>

= <entry>

<key>S0CS0</ key>

<value>
<shareState>1l</shareState>

<sharelame>0852200</ sharelame>

{1}
LI

- </wvalus>
- </entry>
= </ copyProcHap>

Le/n=2:copyProcConnMap>

Size

1KB
17 KB

<wrk>SYSSLIBS*PROCS. , SYSSLIBS*DPSSALTSPROC. ,UDSSRC*PDPSLIB. </wrks>

If you open one of the host connection files, you will each COBOL procedure entry name and the
element it is found in including the host IP address, share, qualifier, filename and element name.
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-1 & N b b R

[T = R i}

[4 U R S ]

[
-1 & i

[
(551

L0

EEBTURE—KEYFOUND—PKT YW\10.121.0.23%032200\syv=51ib%\procS$\ fkevfounddef.ucob
CRLL-FP-ACQ-ELT-INFO-LONG “\10.121.0.23\0=2200\sy=s21ibs \procé\fpfacgeltint.cob
CALL-FP-ACQ-ELT-INFO-SHORT “\\10.121.0.23%0=52200%=sy=sS1ibs\procs\ fpacaeltint. cob
FP-ACQ-ELT-INFO %,\10.121.0.23\0=2200\=sy=s$1libs\procé\fpfacgeltinf.cob
CALL-FP-ACQ-FILE-INFO-LONG \\10.121.0.23\022200\3ys381lib&\proci\fpfacgfilinf.cob
CALL-FB-ACQ-FILE-INFO-SHORT “\10.121.0.23\0s2200\svs$libS\procs\fpSacgfilinf. cob
FP-ACQ-FILE-INFO %\10.121.0.23\0s82200\=ys51ibs\procs\fpSacqfilinf.cob
CALL-FP-ACQ-FILE-LIST-LONG %410.121.0.23%052200%sy=s81ib8 \procs)\ fpacafillst . cob
CALL-FE-RCQ-FILE-LIST-SHORT %\10.121.0.23\0=2200\sv=s$1libS\procs\fpfacgfillst. cab
FP-ACQ-FILE-LIST 4\10.121.0.23%0=2200%\sy=s51ibs\procs\ fpfacafillst.cob
CALL-FP-ACQ-OM-EP-LCNG “\%10.121.0.23\0=52200\=sy=s51ibs\procs\fpfacqgomen. cob
CRLL-FP-ACQ-OM-EP-SHORT “\10.121.0.23%0=s2200%sy=51libs\procé’\fpfacgomer. cob
FP-ACQ-OM-EP-INFQ “\10.121.0.23\0=2200 \=y=s$1libs \proci\fpfacgomep.cob
CALL-FP-ACQ-BASIC-PF-INFO “\10.121.0.23%022200\=2ys$1ibs\proci\fpfacgpfinf.cob
FP-ACQ-BASIC-PF-INFO \\10.121.0.23%\0=22200\=syv=s51libs\procé\fpfacgpfinf.cob
CLLL-FP-LCQ-COB-PROC-INFO-LONG \\10.121.0.23\022200\sv=$1ibS\procs)\ fpsacqproc. cob
CALL-FP-LCQ-COB-PRCC-INFC-SHRT Y4,10.121.0.23\0s52200%sy=s81ibs \procd\ fpacaproc. cob
CALL-FP-LCQ-PROC-INFO-LONG “\10.121.0.23\0=s2200\=sys21libs\procsh\fpfacaproc.cob
CALL-FP-ACQ-PROC-INFCG-SHORT \\10.121.0. 23\052200\5ys$11h$\proc$\fp$acqprnc cob

With the COBOL source open in the editor, hover the cursor over the COPY Procedure name . In the
following example, this is INFO-BUFFER. A dialog with options to select the COPY procedure
source element appears. Note an element could contain many COBOL procedures.

289
218
211
212
213
214
215

COPY DPSSTATUSCOB.
COPY
corY | sys$lib$*procS.dps-status.cobp
COPY | ave$lib$*dpeSaltSproc.dps-

status.ucobp

) »

COPY treorees

Select the desired copy procedure

If no COPY Procedure has been associated with the name, then an error is displayed in the status line:

Mo copy procedure found,

By selecting an entry in the list, Eclipse will open the element in the COBOL editor and position the
cursor at the PROC statement. Note this element is not part of a project.

DEFMAS.COB DP5S-5TATUS-UCOBP.COB 3

B--—+ 123 ST S U S -SSR, S S
le‘SSTATLISCGE PROC [ SYSSLIBS*DPSSALTSPROC.DPS-STATUS/UCOEP ON ll'.] 121.0.23 ?
2 /

3 * THIS PROCEDURE D::IH:5 DPS'S STATUS WORD;

4 DP5-5TATUS IS A GENERAL I:ED VERSION OF

5 DP5-DEF-5TATUS H”D STATUS-WORD.

6 o o o o

7

8 a1 DP5-5TATUS.,

£ a5  STATUS-WORD.

1a 18 STATUS-INDICATOR PIC X(1) VALUE SPACE
11 88 STATUS-0K VALUE SPACE
12 38 STATUS-FATAL VALUE 'F'
13 88 STATUS-WARNINMG VALUE "W'.
14 18 STATUS-FUNCTION PIC 1(9) BIMARY-1 WVALUE @.

15 18 STATUS-CODE PIC 9(5) BINARY VALUE #@.

16 @5 STATUS-EXTEMSION.

17 18 EXTENSION-CODE PIC 9(5) BINARY VALUE @.

15 18 FILLER PIC 9(5) BINARY VALUE @.

19

28 END

21
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Note that if a COBOL source has been opened with OFE, this feature is unable and the following
error is shown on the status bar:

Copy procedure can't be opened iF the element is nok assaciaked with a praject

Processing COPY Procedures When Saving

When saving an active UDT editor (typically elements of type ELT), you can process the element for
COPY Procedures using @PDP. This is useful if you have updated the element and
modified/created/deleted any Procedure.

You can process an active editor in the following ways:

e Automatic: Go to Window -> Preferences -> General -> Editors -> Text Editors -> UDT
Preference Page and select the Check for PDP Copy Proc after save check box. This
enables you to process the Unisys Common Editor every time it is saved. With every save on
the Unisys Common Editor which is a COBOL copy procedure, the PDP Copy Proc dialog
box appears.

e Manual: Click OS 2200 -> PDP Copy Proc. Alternatively, you can click from the tool bar

menu icon . A PDP Copy Proc dialog box appears.
[ 3 PDP Copy Proc s [ESEEE)

Do you want to PDP the COBOL proc?
You may choose to overwrite options and specify the filename to be PDPed to.

@PDP,UC SYSSLIBS*PROCS.CONFIG-BUFF/COBP

@ [ ok ][ cancea |

The @PDP statement can modified e.g. change the command options and/or specify the file name
where the copy procedure will be processed. Note: By default, the text box in the PDP Copy Proc
dialog box is prefilled with the command @PDP,UC and the OS 2200 file path of the active editor.

If the element has not been saved, Eclipse will prompt if you want to save before doing the @PDP. If
you do not save, then the last saved version on the OS 2200 system is processed.

L4 Save » (X

"6" Do you want to save the file before PDP?

—— ——

If the editor is not a COBOL procedure, Eclipse prompts if you still want to continue. Click Yes to
continue to process the active editor. Only files that contain ‘~~PROC’ and ‘~END’ (where ~ is a
space) are considered as COBOL procedures. For files without these words, PDP can be done by the
manual method.

m Information ' L__Jnr:h

"6' There is no active editor or the active editor does not support PDP
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In the background, the command is sent to the host of the active editor and executed. When the output
is generated, it is displayed in the PDP Copy Proc view. This view is refreshed with each element that
is processed. The data of the previously processed copy-procs is not maintained.

%5, 052200 Host Manager View - CIFS y=| Tasks 3/ Problems |_Eq COBOL Code Guidelines @ 05 2200 End Surnmary View [J Memory il Registers @ PDP Copy Proc View &
These are assigned via X selection, TPR587 MAPPER TAPES run.

***Message Updated: March 5, 2817 at 15:38 CST

Current session number: 7@@

Previous session was: SUN 19 MAR 2817 @@:41:39 CDT

DATE: 2817-83-19 TIME: 23:27:18 (DT

>@PDP,UC ROBI*WORKFILE.TEST-PROC

PDP 13R2D (@B8@925 2154:35) 2817 Mar 19 Sun 2327:11

Copyright (c) 1994 Unisys Corporation.

ALl rights reserved.

UNISYS PROPRIETARY

>@EOF

SI IS NOT SIR TYPE SDF *VX@@[NAMESS

END PDP. Errors: @ Fatal @ Syntax @ Warning
Lines: 3 Entry Points: 1  Time: 2.124 Storage: 7878/8/7878/8187661

>@FREEM

End FREEM (version 1.2).

>

Miscellaneous OS 2200 Perspective Features

Splitting the Editor Pane

Sometimes a developer is coding the business rules in the Procedure Division but needs to reference
some other code in the program e.g. the Working Storage section. Eclipse provides the functionality
to split the editor pane into two panes. Modifications made to one pane are reflected in the other pane.
If you save one pane, it saves the common course displayed in both panes.

To perform this, right click on the editor pane tab e.g. GETB8A.COB in the picture below.

I K GETESA.COP 7
o Eesbare =
H___+ Marve .
155 Size b
D156 Minimize -
@157 Maximize -
3155 r
15D Close r
160 Close Othets
161 Close Al o
1laz2
@163

Then click New Editor.
Or go to the menu Window - New Editor.

| esss—]

I | Window Help

i Mew Window
Mew Ediktor

Eclipse will open a new COBOL editor pane as shown below. Both panes are displaying the same
source. Updating the source in one pane will also update the source in the other pane. In fact there is
only one source being edited but two panes used for editing.

E
GETESA. COR ( GETESA.COB 52

IDEHTIFICATION DIVISION.

PROGRAM-TD . GETESA.

AUTHOR. Mnisys - Rob Jamieson.
DATE-WRITTEH. Octoker 2010.
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Now with the cursor on the tab, hold down the left mouse key and drag the editor pane down the
screen. When the cursor is close to the bottom of the edit window, you will see a dotted line across the
middle of the edit window and a bold black down arrow on the screen. Release the left mouse key and
you will have two editor panes for the same source.

f GETESA.COB 53
T S S
S0 05 EMPE-EMAIL PIC Xi(30).
51 *  Pad out to 4,000 chars
52 05 FILLER PIC X(377a).
53 03 EMPE-INFO.
L4 05 EMPE-TOTLAL PIC 99,
=11 05 EMPE-MCEE PIC X.
=1 05 EMPE-LDETAIL OCCURS 40.
57 07  EMPE-ICHO PIC Xi(lz).
s 07 EMPE-NAME PIC Xi45).
59 07 EMPE-AMT PIC 99.99,
a0 *  Pad out to 4,000 chars
61 05 FILLER PIC Xi45).
4
=
GETESA.COB 3
-—t---1-t-——-z——R 3 g 4 5
Loy PREIA-EAEMAFLUYRR.
155
@156 MOVE EMPE-NO TO EOD-NO IN BSA-MLS.
@157 FETCH ESA-MAS RECORD OH ERROR O TO NO-ESL-MLE.
3155 MOVE 1 TOD EMPE-INX.
159 MOVE TN TO EMPE-MCEE.
160
161 FETCH-BSL-DETAIL.
162
165 FETCH HEXT ESL-DETAIL WITHIN ESA-DETAIL-3FET SET
164 OH ERROR. GO TOD EMFLOYEE-EXIT.
@155 MOVE IC-LO TOD EMFPE-ICHO [(EMPE-INDX) .
(x SNAH - MNYE MLML TN FMPE-MLMF (EMPE—THDE .

Each pane can be manipulated independently but both panes are working on the same source element.
In this way, one pane could show part of Working-Storage and the other pane might show part of the
Procedure Division. This is useful if you can’t remember data names when coding the program.

There is another method of achieving split panes. The editor for the required source must be in open
and in focus.

Go to Menu -> Window -> Toggle Split Editor (Horizontal). Or use Ctrl+_.

Help

New Window PR~~~ 5 v | = B
Editor 2 Toggle Split Editor (Horizontal) Ctrl+_ [
Appearance * Toggle Split Editor (Vertical) Ctrl+{

| Teggle Split Editor (Horizontal) l

Show View 3 27

The result is two panes for the same editor that can be independently scrolled and updated.
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|=] TEST-PROC.ELT TEST.COB DEFMAS.COB 2 = 0
I---+----1----+----2----+----3----+----4----+----5----+----6----+----?----+----S----+----9----+----e----+--

1177 ™ Fetch the employer record from DMS i

1178 PERFOR.M FETCH-EMPLOYER THRU EMPLOYER-EXIT.

1179 IF EMPLOYER-NOT-FOUND

1136 J'ﬂD‘u"E "Employer not found"™ TO O-EML-TXT

1181 GO TO EML-CUTPUT.

1182 PERFORM MOVE-CHECK. —

1183 ™ Assign file and write header info L

1184 M display "assign file" upon printer.

1185 PERFORM PARA-ASG-FILE.

1186 PERFORM WRITE-DEPHDRL.

1187 PERFORM WRITE-HEAD. =
4 3

i -e*ch the errplc-e .
1178 PERFORM FETCH-EMPLOYER THRU EF'.PLOYER EXIT.

1179 IF EMPLOYER-NOT-FOUND

1136 MOVE "Employer not found™ TO 0-EML-TXT

1181 GO TO EML-OUTPUT.

1182 PERFORM MOVE-CHECK. —

1183 * Assign file and write header info L

1184 * display "assign file" upon printer.

1135 PERFORM PARA-ASG-FILE.

1136 PERFORM WRITE-DEPHDRI.

1187 PERFORM WRITE-HEAD. -
] 3

Or to split vertically, go to Menu -> Window -> Toggle Split Editor (Vertical). Or use Ctrl+(.
EWindow Help
New Window lﬂvgvipi; & v m 5 | = BB

Editor [ Teggle Split Editor (Horizontal) Ctrl+_
Appearance » Toggle Split Editor (Vertical) Ctrl+{
b --6- -t Tt -
i Clone
Show View 4 | Toggle Split Editor (Vertical) |

| e A B e

The result is two panes for the same editor that can be independently scrolled and updated.

|=] TEST-PROC.ELT TEST.COB DEFMAS.COB &3 = 8
1177 *| Fetch the errplc,e’ record from I3 15 = 1177 * Fetch the errplc,e’ record from I3 15 it
1178 PE RM FETCH-EMPLOYER THRU EMPLOYER-EXIT. 1178 PERFORM FETCH-EMPLOYER THRU EMPLOYER-EXIT.
1179 IF EMPLOYER-NOT-FOUND 1179 IF EMPLOYER-NOT-FOUND
1188 MOVE "Employer not found” TO O-EML-TXT 1188 MOVE "Employer not found™ TO O-EML-TXT
1181 GO TO EML-OUTPUT. 1181 GO TO EML-OUTPUT.

1182 PERFORM MOVE-CHECK. 1182 PERFORM MOVE-CHECK.
1183 *| Assign file and write header info 1183 * Assign file and write header info

1154 * display "assign file™ upon printer. 1154 * display "assign file™ upon printer.
1185 PERFORM PARA-ASG-FILE. 1185 PERFORM PARA-ASG-FILE.
1186 PERFORM WRITE-DEPHDRIL. 1186 PERFORM WRITE-DEPHDRIL.
1187 PERFORM WRITE-HEAD. 1187 PERFORM WRITE-HEAD.
1188 *| Prepare the defaulter info in the letter 1188 * Prepare the defaulter infoc in the letter
1189 PERFORM FETCH-DETAIL THRU DETAIL-EXIT. 1189 PERFORM FETCH-DETAIL THRU DETAIL-EXIT.
1196 * @sYM the file to send to EOM e 1198 * @SYM the file to send to EOM ais
1191 PERFORM SYM-LETTER. W[ 1101 PERFORM SYM-LETTER. A
1192 MOVE "Email sent successfully™ TO O-EML-TXT. 1192 MOVE "Email sent successfully” TO O-EML-TXT.
1193 *| Store an audit record 1193 * Store an audit record
1194 EML-INSERT-AUDIT. 1194 EML-INSERT-AUDIT.
1195 | TIMESTAMP is default value in table 1195 | TIMESTAMP is default value in table
1196 MOVE 1196 MOVE
1197 MOVE 1197 MOVE
1198 MOVE Ir 1198 MOVE Ir
1199 EXEC SQL 1199 EXEC SQL
1288 INSERT INTO DEF LTRAUDIT (MAJIKAN, USERID, f 12@8 INSERT INTO DEF LTRAUDIT (MAJIKAN, USERID, f
1281 VALUES (:EML-MAJIKAN, :EML-USERID, :EML-E! s 1281 VALUES (:EML-MAJIKAN, :EML-USERID, :EML-Ef il
1747 FMN_FYEr 1727 FMN_FYFEr
< T | b < I | b

Navigating your COBOL Program Source
Eclipse provides a couple of methods to simplify the navigation of your COBOL program source:

1. Using the Outline View
2. Using Sections and Paragraphs
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Outline View

In the COBOL editor, you select the Outline view to see the program structure. Go to Window >
Show View - Other.

1 | Window  Help

i Mt Window
Mew Editar

-

& - |-

SRR

e |

Show Wig

Open Perspective k
ld & O35 2200 Console

Fe=

2 Customize Perspective. .. + 052200 Explorer _

; Save Perspective As. .. j___, 05 2.2EIEI Haost Manager Wiew - CIFS |

5 Reset Perspective. . o= Dutline: Alk+3hifk+g, O
,  Close Perspective |2 Problems Alt+Shift+G, ¥
5 Close All Perspectives E Tasks

2 Mavigation b a2 TelnetVisw

z Preferences

Then select General and expand the node. Then click on Outline.

r@ Show View

BN

type filter text

s CFC+H+

- = COBOL

» = Code Recommenders
» [ Data Management

» = Fortran Views

4 [ General

L_[]] Bookmarks

4" Classic Search

& Console

@] Error Log

@ Internal Web Browser
[:; Markers

o Mavigator

B= Outline
w Palette

m

Cancel

b

The perspective will show the program outline with the different COBOL divisions and paragraph

names.
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e Ty
0= Qutline 532 > | o 2 K ¥ = O

= DEFMAS ~
=-E ENVIRONMENT

= COMFIGURATION

B SPECIAL-NAMES

E-E=l mPUT-0UTRUT
L B FILE-CONTROL

=% DaTA
-[Z] SUBSCHEMA

FILE
b WORKING-STORAGE | |
=& PROCEDURE
E1-&a THE-OMLY
----- MAIMN-LIME
----- EEGIM-THREAD
----- PROCESS-TRANSACTION
----- FIMISH
----- MAIN-LIME-EXIT
----- PROCESS-MESSAGE
----- PROCESS-MESSAGE-EXIT
----- SESSION-INIT
----- SESSION-CTRL
----- SESSION-OLUTPUT
----- SESSION-EXIT
----- GDO-IMIT
----- GOD-DATABASE
----- EDD-OUTRUT
----- GDD-EXIT
----- GTM-INIT
----- ETM-CUTPUT
----- GTM-EXIT
----- GTA-INIT |

Drag this view to a suitable location on your workbench. My preference is to have this open on the
right side of the editor view.
Note the refresh icon, e , can be used to refresh the outline as program editing is performed.

Clicking on an entry in the Outline will position the Editor pane at that location in the program. This
provides a quick navigation method to areas of the code.

Using Sections and Paragraphs

This feature requires the Outline view to be active for the editor file. Highlight the section or
paragraph name in a PERFORM or GO TO statement.

578

579 * EXEC 3QL

580 ! USE DEFAULT QUALIFIEER CONTRIES

581 * END-EXEC.

582 COPY USE-CCNTRIE IH PROCLIE.

583

554 PROCESS-TRANSACTICH.

5585

1= FEE O WMait and receive a wessage Lo process
587 PERFORM |O3=ERN0RINN THREU [DFS-INFUT-EXIT.
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To navigate to the section or paragraph, press F3.
Or right-click and select Open Declaration:

FEF O Walt and receive a messSage Lo process

PERF OFM T T
Cpen Declaration ..

lmdm =hEl -7
Another method is to <CtrI>+Click and then hover over the section/paragraph name and select the
hyperlink.

The cursor is positioned to the section or paragraph name.

1841 CALL 'DEGETICR' USIHG DP3-3TATUI SCRALTCH-LREL.

1542 IF STATUS-WARNING

1543 PERFOFM FLATFORM-WAFRNING-EIIT.

1544 IF 3ITATUS-FALTAL

1845 GO TO PLATFORM-ERROR-EXIT.

1846 * display "GScrateh =" SCRATCH-AREL (1:50) "« UPCH PRINTEE.
1547 DPS-INIT-EXIT.

1545 EXIT.

1849 e el ol el el e
1ss0| DPS-INPUT.

1851 * 03 2200 DPE buffer (and not a DPS forwm) receives a wmessage

Use the Go Backwards icon ~ (or press <Ctrl>-Q) to return to the PERFORM or GO TO
statement.

Auto Tag in Columns 1-6

The Auto Tag feature allows for up to 6 characters of data to be placed in columns 1-6 of each
updated line of code in the COBOL source. Often these columns are used for version information.

The value to be used is defined in the Properties 2 Preferences 2 COBOL options. Go to the
Reference Format tab. Key you value in the field and check the “Default to Auto Tabbing” box. In
the example below, RJJ is the value entered.

Settings for AukaTag

Tagin Columns 1-6

[w Defaulk to Auto Tagging
R

Then as you update the source (modify or insert), the tag value is automatically inserted in columns 1-

B 1 IDENTIFICATION DIVISIOH.
2 PROGRAM-TID. GETESL.
3 ABUTHOR. Mnisys - Rob Jamieson.
4 DATE-WRITTEH. o©Octoher Z010.
5
& RJJ # Changed to & TCOE 3/R So it can he called from EAE
TRIJ * Another comoent line
S RIJ * This i= a new comoent line

If you need to toggle whether the tag value appears, right click in the edit pane and select Toggle
Update Tag. Lines can be highlighted as well.
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TRJJ * Another comoent line
S RJJ % Thi=z iz a new comment linel
g Undo Ckel+-Z
10 ENVIROHMENT DIVISION. Revert File
11 CONFIGURATION SECTION. (5/save Ctri+5
1z SOURCE-COMPUTER. UNIVAC-1100-71 )

Qpen tith r
13 OBJECT-COMPUTER. UNIVAC-1100-71 Show In AlE+-ShifE+- '
14 TCOB SPECIAL-HAMES.
15 TCOB CARD-REALADER IS CARD-READEER Zuk: 12k
16 TCoOB FEINTEER IS5 PRINTEER Copy (Zhr| T
17 TCOB CONSOLE IS CONIOLE. Paste Chrl+Y

& 18 IHPUT-0UTPUT SECTIOH.

Run As k
19 DATA DIVISION.

Debug As 3
20 SUBSCHEMAL SECTION. )

Profile As r
21 IHVOFKE 2UESCHEMAL BSA-3IUBICH IH Validate
22 OF SCHEMAL S30OC3I0-23CHEML Team .
23 COPYING RECORDS IHTOD WORET] )

] Compare \ith r

24 COPYING DATA-NAMEZ IHTO T )

Feplace With r
25 EUN-TNIT-ID IS GETESLA
26 DMCL IS WOREING Preferences. ..
27 ERROR. EECOVERY IS GEN-ERE-! T
25 ROLLEBACK IS R-PLRL. R

Notice that when a new line was created, the tag was not entered as shown below.

R HAIJLIIEL CSUIIIO=ElL. L L=

S RJJ * This iz a new coment line
o]

in

Auto Tag in Columns 73-80

Some sites want to use columns 73-80 instead of columns 1-8 to store some data like a version
number.

i 05 2200 - Eclipse

File Edit Mavigate Search Project  Run Im Window  Help
J “iz Jf fdd a Telnet Session bound ko this project,
— [ Clear Problem List Markers

12 Update 05 2200 Project

=% coot-RoB
-2 UMISYS*ROB.

o CITACHG-TXT.ELT
S CITACHGETAT.ELT

View Log
Save Log

Set Log Level

" CITACHGCTXT.ELT
7y DEFMAS, COB

[ GETBSA-COMP,TXT
iy GETESA.COB

[y GETPROC.COB

i IBTEST.CORB

The following prompt appears:

" ©5 2200 Resource Adapkers L

B Set b Java 1.6

SBUE e ot B Jaa 1.7,
Configure COBOL Procedures

Configure Tag For ]

Ckrl+-Shift+FS
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iU Tagging x|
Tag in Calumns 73-30 I YER1 vI

Ik I Cancel |

Data can be entered which is converted to Upper Case. The last 10 values are stored and can be
selected.

When you highlight text in the Cobol editor, using <CtrI>-T will place the selected value in columns
73-80.

42 THPUT-0UTPUT SECTIOH.
43 ILE-COHTROL .
44 SELECT PRT-FILE ASSIGH TO DISC TPEIMNT.

JRT-FILE ASSIGH TO DI3C SRT-DEFAULT.
46 DATA DIVISIOH.

Block Comment and Uncomment of Code

One or more lines of code can be marked as a comment (* in column 7) by highlight the lines of code
and then doing Ctrl + /. Commented lines can be uncommented by the same process.

Literal Length

Often in COBOL, the length of a literal is needed e.g. to make sure the destination field is sized
correctly. This is achieved by highlighting the code:

6a5 MOVE "pessRe=1SElERlals " TO IMN-TEANZS-CODE.

In the status line, the length of the highlighted field is displayed:

Length:11

Viewing the COBOL Areas

The different COBOL areas can be clearly indicated in the COBOL Editor by setting the Show
Margins options. Go to Windows = Preferences > COBOL - General and you will see the
settings for the Print margin column.

W Show print margin
Prink margin calummn; I 6,7,72,80

Note how the “Print margin columns” field contains 6, 7, 72 and 80. The editor will show a vertical
line after these columns to indicate where the different COBOL areas are. You could modify these
values for your own use.

*GETESA.COB 52

————+——=—1————+————2————+————3————+————4————+————5————+————6————+————T-‘————+————El————-
(X} IDENTIFICATION DIVISIOH.
PROGRAM-TID . GETESA.
AUTHOR. Unisys - Rob Jamieson.

DATE-WRITTEH. OCctober 2010,

n & LMo

Reloading the Editor Content

Note: This feature only applies to files/elements opened with OS 2200 File Explorer.

At times the developer might want to refresh their editor contents with the version of the data file or
element from the OS 2200 host. This can be achieved by Menu -> OS 2200 -> Reload Editor or by

clicking F5 from the OS 2200 File Explorer. The elements in the project are locally cached for
performance reasons hence reloading the editor will reload the cached contents. The sync mechanism
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in the OS 2200 Explorer will check for the element consistency while opening or saving an element.
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - DORADO*ROBE.DEFMAS ON 10.121.0.23 - Eclipse

File Edit Source Mawvigate Search Project Run | 052200 | Window Help

Inb e & | b | ho E5 Set ECL Mapping
E

Add a Telnet Session bound to this project.
For  Clear Problem List Markers
. [+ APPSVNPROCS i |pdate 05 2200 Project
4 ¥ DORADOROE ay
2 %% DORADO*ROB. E’B
|5 ALLOC-COMP-DEBUG.ELT MAR1S, 20171 ™
[ ALLOC-COMP.ELT MAR 14, 2017 4:49 PM ||} Reload Editor

+ 052200 Explorer &3

Configure Compare Tool

05 2200 Compare

Automatic Refresh when Host Contents Changed

Eclipse will be notified when the data file or element contents on the OS 2200 host are changed. In
this case, a prompt is shown to allow the developer to take the necessary action.

] File Changed - ||

The file "“\rsl2.rsvlunisys. comt 0522000 ROBMNALLOC has been changed on the file
systern. Do you want to replace the editer contents with these changes?

Yes || Mo

Select Yes to refresh your editor with the latest host contents. This will result in any unsaved changes
being lost.

Select No to keep working on your editor contents.

COBOL Field Size

Often COBOL programmers want to know the field size (or data allocation) of the variables that are
defined in the Data Division. This can be achieved by highlight the variables required or the entire
variable name.
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DEFMAS.COB 3 DPS-STATUS-UCOBP.COB

- T T TS
457

458 b1

459 @83 ARG3 PIC 1{36) BIMARY-1.
408 a3 LINE-CTR PIC 99.

451 a3 vy PIC 99.

462 83 5SUB PIC 999,

463 83 SUB1 PIC 999,

464 83 IND-TAJUK PIC 9.

485 83 FIRST-TIME PIC 9.

466 83  NUM-WRT FIC 9({4).

467 83 Ws-POSTCODE PIC 9(5).

468 @83 TALLY PIC 9(5).

459 @3 EMPLOYER-CODE-1 PIC X(9).

478 83 EMPLOYER-CODE-2 REDEFINES EMPLOYER-CODE-1.
471 85 EMPR-OFF-CODE PIC X(3).

472 85 FILLER PIC X(B}.

473 @3 EMPLOYER-CODE-3 REDEFINES EMPLOYER-CODE-1.
474 85 FILLER PIC X.

475 a5 W5-EMPRKOD PIC X(7).

478 85 FILLER PIC X.

477 83 WS-BULAN PIC 9(6).

478 83 WS-BULANR REDEFINES WS-BULAN.

479 a5  Ws-YY PIC 9(4).

488 a5 Ws-MM PIC 9(2}.

481 83  WS-M5G PIC X(58).

482 @3 WS-M5GR REDEFINES W5-M5G.

483 a5  MsG1 PIC X{23).

484 a5 M3G1A PIC X(9).

&~ AR B

Then use Menu -> OS 2200 -> Field Size.

eclipse-2200-4-6-0-160920 WS - OS5 2200 - DORADC*ROB.DEFMAS ON 10.121.0.23 - Eclipse

File Edit Source Mavigate Search Project Run [QSZZDG}] Window Help

N ES NN SN N EC RO S
i

+ 05 2200 Explorer &3 05 2200 File Explorer b
i [ APPSVNPROCS i

4 [* DORADOROE ay

+ % DORADO*ROB. a‘;

|5 ALLOC-COMP-DEBUG.ELT MAR 15, 2017 1
[ ALLOC-COMP.ELT MAR 14, 2017 4:49 P | 20
5 ALLOC-COMPACOB.ELT JUN 19, 2016 12:0
[ify ALLOC.COB MAR 14, 2017 5:05 PM

[ify DEFMAS.COB MAR 18, 2017 6:25 PM

|5 DORADOROB.ELT MAR 15, 2017 1:53 PM
(R MLFTM.FOR MAR 18, 2017 4:58 PM

» ¥ DPSPROCS g

Jaua

i ¥ QRPROG i3

Jana
1.7

a ¥R
4 %% ROBJI"WORKFILE.
& ALLOC-COMP MAR 16, 2017 4:58 PIM
L8 ALLOC.COB MAR 14, 2017 5:05 PM
[ify DEFMAS.COB MAY 3, 2013 1:42 PM
5y RENAMED.ELT MAR 19, 2017 4:02 PM

S

Or use the icon
Or use Ctrl+Alt+S

Set ECL Mapping

Add a Telnet Session bound to this project.
Clear Problemn List Markers

Update 05 2200 Project

Configure Compare Tool

05 2200 Compare

Reload Editor

Yiew Log
Save Log
Set Log Level

05 2200 Resocurce Adapters »
Set to Javal.b

Set to Javal.7

Configure Editor Scalability
Configure COBOL Procedures
Configure Tag for Col 73-80
Field Size

Ctrl+Shift+F5
Ctrl+Alt+5
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Eclipse presents the variable and field size. The offset can be changed to one of 3 options with
Decimal Characters as the default.

r ~
(1] Field Size -— (=
81 WORK-AREA. -
83 ARG2 PIC 1(3&) BINARY-1. ‘_l
83 LINE-CTR PIC 33. e
-ENN A PIC 99.
83 sUB PIC 993.
83 SUBl PIC 999.
83 IND-TAJUK PIC 9. =
7] b
Offset Display Type: [Decimal Characters v]
————————— Decimal Bits
selection } offset value ol
Bl work-ap Octal Words - starts @ bytes, size 95 bytes
@3 ARG3 PIC 1(36)} BINARY-1. - Starts @ bytes, Size 4 bytes
@3 LINE-CTR PIC 99. - Starts 4 bytes, sSize 2 bytes
83 Y PIC 99. - Starts & bytes, Size 2 bytes L
83 SUB PIC 9939. - Starts 8 bytes, Size 3 bytes 3
83 SUBL PIC 999. - starts 11 bytes, size 3 bytes
83 IND-TAJUK FIC 9. - starts 14 bytes, size 1 bytes
@3 FIRST-TIME FIC 9. - starts 15 bytes, size 1 bytes
83 NUM-WRT PIC 9(4). - starts 16 bytes, size 4 bytes —
23 WS-POSTCODE PIC 9(5). - starts 2@ bytes, size 5 bytes
83 TALLY FIC 9(5). - Starts 25 bytes, Size 5 bytes
83 EMPLOYER-CODE-1 PIC X(3). - Starts 3@ bytes, Size 9 bytes
83 EMPLOYER-CODE-2 REDEFINES EMPLOYER-CODE-1. - Starts 3@ bytes, Size 9 bytes
85 EMPR-OFF-CODE FIC X(3). - Starts 3@ bytes, Size 3 bytes
85 FILLER FIC X(&). - Starts 33 bytes, Size & bytes
End of @3 Group EMPLOYER-CODE-2 - Starts 3@ bytes, Size 9 bytes
83 EMPLOYER-CODE-3 REDEFINES EMPLOYER-CODE-1. - Starts 32 bytes, Size 9 bytes i
ac__CcTiICD oTr W Ctarte 30 hutac  Civa 1 hurtac
@ 0K ] [ Cancel ]
h

Sending Elements/Files as Emails
Often source code needs to be emailed as an attachment to others.

Use the menu icon g.
Or right click on a file/element in either OS 2200 Explorer or OS 2200 File Explorer and select the
following from the context menu:

Send Using E-mail

The following draft email is created:
B H = E-rnailing: ALLOC - Message (HTML)
FILE MESSAGE INSERT OPTIONS FORMAT TEXT REVIEW

Cut zlal [ 3 LUJ D‘ |"F0|I0\c\rUr.Jv
1 % 0 z ! >

Copy . ! High Importance
Paste Address Check  Attach Attach Signature Zoom  Apps for
- Format Painter Book Mames File Ttem~ - ¥ Low Impaortance Office
Clipboard ] Basic Text Mames Include Tags = Zoom Add-ins
To..
Cc..
Send
Bee.
Subject E-mailing: ALLOC
Attached & siocE ke
ALLCOC DORADO*ROE.ALLOC on 10.121.0.23

NOTE: The files attached to the email may not be in sync with the corresponding files/elements on the OS 2200 system.
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COBOL Code Guidelines
When defining the OS 2200 Preferences, various priorities were set for COBOL Code Guidelines.

These guidelines are be used when editing a COBOL source by clicking the menu icon il or by
using Menu -> OS 2200 and then selecting Display COBOL Guidelines:
[ eclipse-2200-4-6-0-160920 WS - OS 2200 - ROBJ*WORKFILE.TEST ON RS02.RSVLUNISYS.COM - Eclipse
File Edit Source Mavigate Search Project Run [OSZZDU] Window Help
il gLﬁ]"&JEl i & Lb TR Set ECL Mapping
% Add a Telnet Session bound to this project.

[ Clear Problem List Markers

+ 052200 Explorer &3 ECSZZ.’.’ File Ex

m
(=]
[=]

. [ APPSVNPROCS #  Update OS 2200 Project
+
’ b_/ DORADOROB »  Configure Compare Tool
. [ DPSPROCS 06 2200 C
. [+ QRPROG ey ARA[FEDE
. ¥R ", Reload Editor
+
‘ b_/ ROE! View Log
4 ROBJ*WORKFILE.
& ALLOC-COMP.ELT MAR 16, 2017 4:58 PM saveLog
L ALLOC.COB MAR 14, 2017 5:05 PM 5et Log Level
L& TEST-COMP.ELT MAR 16, 2017 5:44 PM 052200 R Adaot X
[ TEST.COB MAR 16, 2017 5:42 PM g Esource Adapters

2 Set to Javal.b

Ja
[

Set to Java 1.7

=I5

Configure Editor Scalability

Configure COBOL Procedures

Configure Tag for Col 73-80 Ctrl+Shift+F5
Field Size Ctrl+Alt+5

£i, Display COBOL Code Guidelines

As an example, let us consider the following COBOL code:

21 FROCEDURE DIVISION.

22

23 Aaaa-CONTROL.

24 display “start alloc” upon printer.
25 MOVE "A"™ TO W5-FLDIL.

26 MOVE "A"™ TO W5-FLD2.

27 MOVE "A"™ TO W5-FLD3.

28 display "WS-FLD1: ™ WS-FLD1 upon printer.
29

38 END-PARA.

31 5TOP RUNM.

32

33 HULL-PARA.

34 TEST-PARA.

35 PERFORM NULL-PARA.

36 IF WS-FLD1 = "A™

37 DISPLAY "WHY" UPOM PRINTER
38 END-IF

39 FETCH EMPLOYER.

48 G0 TO LAST-PARA.

41

42 HULL-PARA.

43 LAST-PARA.

= @0 TO END-PARA.

45 FINISH-IT SECTIOM.

Now select the Display COBOL Guidelines as described above. The results are:
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B 05 2200 Host Manager View - CIFS |_-;j COBOL Code Guidelines =3

4 ROBJ"WORKFILE.TEST OM rs2.rsvl.unisys.com
4 Duplicate Paragraph and Section Mames: Priority - 1
42:: MNULL-PARA.

4 Discouraged GO TOs: Priority - 1
4 GO TO LAST-PARA,
44 GO TO END-PARA,
4 Mull Perform: Priority - 1
ELTH PERFORM MULL-PARA,
4 Indentation Issues: Pricrity - 2
EFt DISPLAY "WHY" UPOMN PRIMTER
4 Mo Error Checlz Priority - 3
39 FETCH EMPLOYER,

4 Unreferenced Section: Pricrity - 1
45 FIMISH-IT SECTIOM,

The tool only reports the suspect code but takes no action. The programmer can use these guidelines
to review the code.

Note the COBOL Code Guidelines pane has icons at the right to expand/contract the results, remove
matches and save the results:

@ % = =

The user can double click on a line entry and Eclipse will position the editor to the same line of code:

[ | NULL-PARA.

LAST-PARA.
@0 TO END-PARA.
FINISH-IT SECTIOM.

el el o SR SR
LRI o R ]

(SR TV 5 I =

4

&, 05 2200 Host Manager View - CIFS J=| Tasks 5. Problems Eil COBOL Cede Guidelines 52

4 ROBIFWORKFILETEST OM rsD2.rsvl.unisys.com
4 Duplicate Paragraph and Section Mames: Priority - 1
42 NULL-PARA,
4 Discouraged GO TOs: Priority - 1
40 GO TO LAST-PARA,

Copying Full OS 2200 Path Name
This feature allows you to copy the full OS 2200 file name in case it is needed to other use.
From the editor, right click and select the option in the context menu
Copy OS 2200 Path Ctrl+ Alt+C
As per above, there is a shortcut key for the editor in Ctrl+Alt+C.

From OS 2200 Explorer or OS 2200 File Explorer, right click on a file/element and select the Copy
OS 2200 Path entry.

If the selected file is a program file, Eclipse will issue an error:
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L Warning )

- -

ACOB-TIPLIB is not a file/element and cannot be copied.

!'\

Using Templates

Eclipse can support the use of Templates to save coding. We have already seen how auto-completion
can allow us to select the desired COBOL statement or command and then insert the code into our
program source. Unisys has developed templates for UCOB but a client can define their own
templates. For example, you might require a complete program template or you might want to define
site standard code for database error handling etc.

If the following section, the creation, maintenance and sharing of templates is discussed. Note that
this section only applies to using templates with the COBOL editor.

Creating Templates

To create your own templates, you need to go to Window - Preferences in the menu bar. Then
example the COBOL entry and click on the Template entry.

_inix]

| bype filker bexk Templates =] Y

- General

ANk

C)C+ = templates, xml (=TT

SZOBOL EIEI Reference
- Editor -] IDENTIFICATION DIVISION
‘. Templates (2] ENVIROMMENT DIVISION

-[rata Management IEI DATA DIVISION

-Fartran -] PROCEDURE DIVISION Import. .,

‘Help - Comman
-Install{Update Export, ..

-Java

-Java EE

- Java Persistence
- Javascripk

- Mylvn

- Plug-in Developrnent Description: | Unisys UCS COBOL
i Plus Preferences el I
-Remoaote Syskems

-RunDebug Pattern preview:

- Server ﬂ

-Team

i Terminal
-- IUsage Data Collectar
Yalidation

- Web

- Web Services _ILI
- ML K| y

Reskore Defaults | Apply

@:I (0] 4 I Cancel |

Zategorization of kemplate:

Edit. ..

Remove. ..

il

Export All...
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The template structure consists of categories and then templates. Categories can be nested. So for our
case, let’s create a new category under the Reference category. Highlight the Reference folder and
then click “New”.

Select the Category radio button and then enter meaningful name and description. Click “OK”.

x

Parent category name: | Reference

i+ Categary

i~ Template

Mame: | MyDemo Templates

Description: | MwDemo Templates|

Kewword: |

Pattern: ;I

-
4 F

(04 I Zancel |

Now we need to create our template. With our category highlighted, click the New button. Enter a
meaningful name and description. The most important field for the template is the Keyword. The
Keyword is used by Auto-Completion (Ctrl + Space) to present entries matching the keyword (or the
leading characters that have been entered.) So it is recommended to use a prefix on the keyword that
easily identifies your local templates. In the following example, MyDemo- was used as the prefix. So
if the user types “MyDemo” and then clicks Ctrl+Space for auto-completion, they will see all
templates with a keyword beginning with MyDemo.

x

Parent cateqory name: | MyDemo Templates

T Cateqorsy

¥ Template

Mame: | DPS Txn

Descripkion: I Template For DPS Exn

Keyword: | MyDemo-DPS

Pattern: IDENTIFICATION DIYISION, |

PROGRAM-ID, wxwxxx
* This is the skeletion For a DPS Txn.

-
4 k

Ok I Zancel |
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Click OK to save.

Templates

Cateqaorization of kemplate:

=l =P templates. xml

=2 Reference
=] IDENTIFICATION DIWISION
=] ENVIROMMENT DIVISION
1:2] DATS DIVISION
|:2] PROCEDURE DIYISION
=] Common
=[] MyDemo Templates

--f=P DPS Txn

Description: | Template for DPS kxn

Kewword: | My Demo-0FPS

Pattern preview:

IDEMTIFICATION DIVISION,
PROGRAM-ID, xxxexx
* This is the skeletion For a DPS Txn.

It is recommended to use a prefix on the keyword that easily identifies your local templates. In the
following example, MyDemo- was used as the prefix. So if the user types “MyDemo” and then
presses Ctrl+Space for auto-completion, they will see all templates with a keyword beginning with
MyDemo as shown below. (We only need enough characters to match the category hence the demo
shows “myd”.)

F—
ik *NEWDPSTRN.COB 52

— B i
1 mgrdl
2 DPS Txn - Template for DPS kxn IDEMTIFICATION DIVISION,
c Batch - Template Far Batch program FROGRAM-ID, ey

— * This is the skeletion for a DPS Txn.

So if we double-click on the DPS TXN entry, the template will be copied to our editor working pane
as shown below.

g —
it *GETESA.COB f@ HEWDPSTHN, COB 53

e T c SR
IDERTIFICATION DIVISIOH.
PROGRAM-TD . xxxxxX
% This i= the =skeletion for a DP3 Txn. I

[y N

TIP: Turn off Auto Tag when using templates.

For this example, we also created a Batch template called Batch. The result shows how we have our 2
templates under our category of MyDemo Templates.

Maintaining and Sharing Templates

Now that we have defined our templates, we may need to share them with other users. Currently the
templates only exist on the local workstation. Eclipse provides Export and Import functions to assist
in maintaining your templates. (Refer to the previous screen and you will see the Export/Import
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buttons on the right side of the window.) The Export function will create a XML file in a directory
that you select by specifying the location in the Save In field. You can export categories or templates.

Sawve in: I@Desktnp j @ ‘ﬂ' % [-

My Documents
{i My Cormputer
* My Metwork Places
ePortalDermoitorkirea
RIEMPRDataSource

Deskiop

Ky Documents

W
-

by Computer

File name: r-.-1 yT emplates. km j
Save as lype; I"_:-:ml j Cancel |
F

To share with other users, this export file needs to be provided to the other users so they can import it.
If you maintain an OS 2200 file that contains your Eclipse information (All-In-One file, manuals,
JDK installation file etc) then this might be a good vehicle to make the file easily accessible to other
users.

So the other users need to do an Import as shown below.
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Laok. ir: I@ Desktap j € V5

My Documents

Q My Compuker

My Mebwork Places
ePortalDemovorkarea
RIEMPR.DataSource

[y Temp

lates . xml
Desktop

ty Documents

L
-

ky Computer

File narme; IM_I,IT emplates. smil j
j Cancel |

Filez af wpe: I“.:-:ml
E

Templates and New Eclipse Releases

If you do use local templates, remember to export them from the current Eclipse environment when
upgrading to a new Eclipse release. These local templates will not be in the Unisys Eclipse release
files.
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Building an OS 2200 Project

At this stage we have coded our program and now we need to build the project. When you build a
project in Eclipse, a predefined set of ECL commands is sent to the OS 2200 host via a Telnet session.
These commands could compile and link (MAP) one or more programs plus do other OS 2200 tasks
like using SUPUR to update a TIP transaction library file.

Configuring the Build and Brkpt properties

Earlier when we used the wizard to define a new project, we skipped the screen that requested Build
and Breakpoint information. We will now update these properties of the project as it is the Build
commands defined in these properties that are submitted to the OS 2200 host.

From the menu bar, go to Project = Properties and click.

E eclipse-2200-4-6-0-160920 WS - OS 2200 - DORADO*ROB.DEFMAS ON
File Edit Mavigate Search |Preject| Bun 052200 Window Helg

P R

™ = | = Open Project

Close Project
+ 052200 Explorer 32 | [Z] 05
oy Build All Ctrl+B

Build Project

. [* APPSVNPROCS
4 |-* DORADOROB

4 .@. DORADOFROE, Build Woarking Set »
E& DEFMAS.COB M Clean...

(R MLFTM.FOR IMA
«, DORADOROB.EL
5 ALLOC-COMP-C C/C++ Index 3

[fy ALLOC.COB MA
% ALLOC-COMP.E

Build Automatically

Properties

Or right click on the project in the OS 2200 Explorer view and select Properties from the displayed
windows:
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m eclipse-2200-4-6-0-160920 WS - O5 2200 - DORADO*ROB.DEFMAS ON 10.12

File Edit

m

Mavigate

lml & L

—

Search Project Run

Q52200 Window Help
Moo | ESRIBIE

4 05 2200 Exy

Or use Alt+Enter.

Mew
Open in New Window

Remove from Context
Copy

Paste

Delete

Move...

Rename...

Import...
Export...

Refresh
Build Project
Close Project

05 2200 Search
TDATES Search

Index

Build Configurations

Validate

Ctrl+Alt+ Shift+ Down

Convert to Fortran Project

Run s
Debug As
Profile As

Restore from Local History...

Sort By
Sync
Qs 2200

Run C/C++ Code Analysis

Team
Compare With
Configure

Source

Properties

k

Alt+Enter

This results in the following screen being displayed for an OS 2200 project.
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r ~
[LJ Properties for DORADOROE 5 [t
type filter text 0S 2200 Project Properties - A
> Resource p—

Builders 14
» CfC++ General Project Name DORADOROB

Legging

257900 ExechBropecies 05 2200 Connection 50Cs0

Project Facets

Project References 052200 Work File DORADO*ROE.

Run/Debug Settings Build will be the standard build.
> Task Repository

Task Tags Build Stream | Bript Files | OS 2200 Debug Setup
> Validation

@ . ENTER YOUR 05 2200 BUILD S5TREAM HERE. -

4 [}

[ Show Flexible Build Stream

Generate Build Stream

[ Restore Defaults] [ Apply ] |3

@ [ ok ][ concel |

Configuring the Build Stream

Note that the Project Name, OS 2200 Connection and OS 2200 Work File are fields that are not
updateable.

User Defined Build Stream

At the Build tab, we can enter various ECL statements that will be used to build our project based on
what the programmer wants to do. In the above screen, there is the default entry. Below | have
updated the Build Stream to @add an element. However you could have an @SSG call here, or
compiler commands etc. Any valid ECL is allowed — just like you would do in a demand session.

Build Stream | Brkpt Files | 05 2200 Debug Setup |

@ADD,LP DORADO*ROB.ALLOC/COMP

It is important to note the build type. If it is a standard build, the screen shows:
05 2200 Project Properties
05 2200 Connection

05 2200 Work File
Build will be the standard build.

Later we discuss a debug build which changes the screen to:
05 2200 Project Properties
05 2200 Connecticn

05 2200 Work File
Build will be the debug build.

The above screen shows this is a standard build as opposed to a debug build.
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Note: If you want Eclipse to report Error, Warning and Information messages as described later, you
have to set the L option on an @ADD or other processor options that generate listings.

Creating a Default Build Stream

Eclipse can generate a default Build Stream based on your project details. Click on the Generate Build
Stream button at the bottom of the wizard:

Generate Build Stream |

The result in my example is:

E eclipse-2200-4-6-0-160920 WS - 05 2200 - DORADC*ROB.DE

File Edit Source Mavigate Search Project Run 0522

= SAREE o n e
.

+ 052200 Explorer &3

. [ APPSVNPROCS
4 % DORADOROB
4§ DORADO*ROB.
[& DEFMAS.COB MAR 18, 2017 6:25 PM
[y MLFTN.FOR MA 017 4:59 PM
|5 DORADOROB.ELT MAR 15, 2017 1:53 PM
5 ALLOC-COMP-DEBUG.ELT MAR 15, 2017 11:11 Al
[y ALLOC.COB MAR 14, 2017 5:05 PM
[E ALLOC-COMP.ELT MAR 14, 2017 4:49 PM
[ ALLOC-COMPACOB.ELT JUN 19, 2016 12:05 PM
. [+ DPSPROCS
. [* QRPROG
4R
4 ¥ ROBIPWORKFILE.
[ RENAMED.ELT MAR 19, 2017 4:02 PM
& ALLOC-COMP MAR 16

[ Properties for DORADOROE

58 ALLOC.COB MAR 14, 2017 5:05 PM

type filter text

> Resource

Builders

. C/C++ General

Legging

05 2200 Project Properties
Project Facets

Project References
Run/Debug Settings

> Task Repository

Task Tags

> Validation

0S 2200 Project Properties

05 2200 Connection 50CS0
0§ 2200 Work File
Build will be the standard build.

DORADO*ROE.

Build Stream | Brkpt Files | 0S 2200 Debug Setup

@DELETE,C SECRET*BKPT.

@CAT,P SECRET*BKPT.F///9999

@. SET BREAKPOINT-FILE IN 'BRKPT FILES' TAB
@BRKPT PRINTS, SECRET*BKPT.

@. CLEAR (DELETE & CATALOG) THE OBJFILE BEFORE EACH BUILD (RECOMMENDED)
@DELETE,C SECRET*OBJFILE.

@CAT,P SECRET*OBJFILE, F///9999

@CYCLE SECRET*OBJFILE.

@UCOB DORADO*ROB.ALLOC, DORADO*ROB.
@COPY,A DORADO*ROB.ALLOC, SECRET*ORIJFILE.
@UCOB DORADO*ROB.DEFMAS, DORADO*ROEB.
@COPY,A DORADO"ROB.DEFMAS, SECRETOBJFILE.
@UFTN DORADO*ROB.MLFTH, DORADO*ROB.
@COPY,A DORADO*ROB.MLFTN, SECRET*OBJFILE.
@BRKPT PRINTS

The default Build Stream creates UCOB and UFTN compiler statements for each COBOL and
Fortran element in the project. This might not meet your site standards but maybe a starting point that
can be edited for your requirements. For example, you might want to assign PDP COPY Proc files,
use specific compiler options, obtain compiler output or do a static LINK.

Flexible Build Stream

This feature allows the programmer to review/modify/save/load the require build stream. Check the

box at the bottom of the build stream:

Show Flexible Build Stream

[Generate Build Stream ]

[ Restore Defaults] [ Apply ]

When a project build is performed, Eclipse will send this dialog:

Version: 4.1
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E Flexible Build Stream - DORADEROB

|

[@DELETE,C SECRET*EBEPT.

@CAT,P SECRET*BKPT, F///9999

@. SET BREAKPOINT-FILE IN 'BREPT FILES' TAB
@BRKPT PRIMTS, SECRET*BEPT.

@. CLEAR (DELETE & CATALOG) THE OBJFILE BEFORE EACH BUILD
(RECOMMEMNDEL)

[@DELETE,C SECRET*OBJFILE.

@CAT,P SECRET*OBJFILE. F///9999

@CYCLE SECRET*OBJFILE.

@UCOE DORADOFROB.ALLOC, DORADO*ROE,
@COPY A DORADCOYROB.ALLOC, SECRET*OBIFILE.
@UCOB DORADO*ROB.DEFMAS, DORADO*ROB.
@COPY A DORADCYROB.DEFMAS, SECRET*OBJFILE.
@UFTM DORADC*ROB.MLFTN, DORADC*ROE.
@COPY A DORADCYROB.MLFTN, SECRET*OBJFILE.
@ERKPT PRIMNTS

Clear Save

[ Load | Project Properties

[ Do not show this dialog again

@ o ]|

Cancel

The user can use the displayed build stream and just click OK.

Or they can update the build stream and click OK to use it. Optionally the modified build stream can
be saved by clicking Save. This saved build stream is displayed on the next build.

By clicking Load, a saved build stream will be restored and used for the Build. The user can browse

to the location of the saved build stream:

The flexible build stream could be useful where the project contains many source programs and only a
subset of these need to be compiled. Or the site has developed SSG routines where the programs to be

compiled are entered as parameters.

Configuring the Brkpt Files
Now go to the Brkpt Files tab that looks like the following screen:
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Build Stream | Bript Files | 05 2200 Debug Setup

05 2200 Breakpoint Filename
Yiew name (optional)

Delete after use. CIFS Mame

Add | | Replace | | Remove | | Move Up | | Move Down

If your Build Stream commands (or the elements they use) create a brkpt file, then you can enter the
OS 2200 Breakpoint Filename here. (Actually it could be any valid OS 2200 data file.) Note that if
you enter a View name, then Eclipse will open a pane in the diagnostic window with the contents of
the Brkpt file at the end of the project build process. Be careful with the ‘Delete after use.” check as
the Brkpt file will be deleted if this is checked. Note that multiple Brkpt files can be defined.

Note that Eclipse does a timestamp check on the Brkpt files and will only process and display the file
if the last reference timestamp is after when the build was started.

| Build Stream | Brkpt Files | OS 2200 Debug Setup

0S 2200 Breakpoint Filename
View name (optional) ROBIJBRKPT
Delete after use. CIFS Name

\\  <Osa200@sddess>  \OS2200\ROBABRKPT

Composed entry ROBJ*BRKPT.ROBJBRKPT

!Add lReplacery ‘Remove Move Uy biMoveiDownr

ROBJ'BRKPT, ROBJERKPT

BYRAPPDK*BKPT, VIEW

By highlighting a Brkpt file, you can modify the settings.

Configuring the OS 2200 Debug Setup

Click on the OS 2200 Debug Setup tab. Eclipse shows the setup information for a debug build. Debug
builds are used with the Eclipse debugger module to provide an interactive debug session. Programs
must be complied with a UCS compiler like UCOB and using the appropriate compiler options.
DEBUG/FULL and NO-OPTIM are mandatory. The Eclipse PADS library compatible with the
Eclipse IDE release must be installed on the OS 2200 host. Check with your system administration for
the name of the installed Eclipse PADS library file — it is needed for debug builds.
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(0% 2200 Connection RS02 -

05 2200 Work File ROBJ*WORKFILE.
Build will be the debug build.

| Build Stream | Brkpt Files | 05 2200 Debug Setup

Use Debug Build

Debug Callback ID ROBJ.3249315
Debug Callback Port Mumber 1023 Add the below lines to the static link
INCLUDE ROBJ*WORKFILE.ROE
Callback IP address 129.23.176.72 INCLUDE ECLIPSE2200*PADSSLIE46. DEBUGING
MASM Elerment Name 208) CREATE REFERENCE RTSSPINIT

RESOLVE RTSSPINIT, TCASSS5 USILCM

CHAMGE REFEREMCE (PADSSINIT) TO PADSSINITEC2
RES ALL REFS USI LOCAL_DEFS,LCN

COMCEAL MESSAGES 108

05 2200 Debug Library Name ECLIPSEZ200"PADSSLIB4G

Link File Mame BYRAPPDK*OBIFILE.2021.

[] Debug autormatically without Telnet view

@. CREATE DEEUGMSMELT >
[@DELETE,C BYRAPPDK*BKPT.

@CAT,P BYRAPPDK™BKPT. F///9999

@. SET BREAKPOINT-FILE IN 'BRKPT FILES' TAB

@ERKPT PRIMTS, BYRAPPDK*BKPT.

@MASM ROBIMWORKFILE.ROBI,.

@. CLEAR (DELETE & CATALOG) THE OBJFILE BEFORE EACH BUILD (RECOMMENDED)
[@DELETE,C BYRAPPDK*OBJFILE.

@CAT,P BYRAPPDK*OBJFILE, F///9999

@CYCLE BYRAPPDE*OBIFILE.

@UCOB ROBFWORKFILEALLOC, ROBI"WORKFILE.,, DEBUG/FULL,NO-OPTIM
@LINKE ,BYRAPPDK*OBJFILE.202124146D

INCLUDE ROBJ*WORKFILEALLOC

IMCLUDE ROBJ"WORKFILE.ROE)

INCLUDE ECLIPSE2200"PADSSLIBA6.DEBUGIMNC

CREATE REFEREMCE RTSSPINIT

m

m

4 [

["] Show Flexible Build Stream

’Generate Build Stream ]

[Restore Defaults] [ Apply ] |:

| ok || cancel |

Note that when the Use Debug Build checkbox is selected, the build type is changed to indicate this
will be a debug build.

Build will be the debug build,

The Debug Callback Id is used when creating your debug session. Use a unique value but a good
practice is to choose a value that matches your program to be debugged.

The Debug Callback Port Number is the port number used by PADS to send data to the Eclipse
debug session running on a workstation. Generally use the default value.

The Callback IP address is the IP address of the workstation where the Eclipse debug session will be
run. (PADS will send information to this port.) Generally it is your local workstation IP address.

The MASM Element Name is the name of the element in your Project file (OS 2200 work file)
where Eclipse writes the MASM element required for PADS to interface with the Eclipse debugger.
Different elements can be created but the default is the Project Name. If you are debugging multiple
programs in the same OS 2200 work file, then use a value to identify each program e.g. ABC/DEBUG
for program ABC.
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The 0S2200 Debug Library Name is the name of the Eclipse PADS library file on the 2200.

The Link File Name is the target output object module from the @LINK in the debug build stream.
This can be copied to make it easier to use in a debug runtime session.

Eclipse creates a set of LINK statements that must be used in the @LINK of the program. You can
copy/paste these statements as required.

In the edit window, Eclipse creates a default compilation build stream that is required for a debug
build. You can edit this as required. (Note that this build stream is used for a debug build and not the
build stream under the Build Stream tab but only if the Use Debug Build box is checked.) It is
necessary to call the MASM processor to generate an object module from the appropriate MASM
element. The LINK statements are also essential.

Before a UCS executable can be debugged:

e A special debug element must be created. This element contains information the PADS
subsystem will use to call back to the PC at startup.
e The executable needs to be static linked to:
o Include the special debug element;
o Include a certain debug library OM;
o Cause a special PADS entry point to be called at start time.
Refer to the section on UCOB Debugging for more details. For now, leave the Use Debug Build
unchecked.

Doing the Project Build

Now that we have defined the build commands, we can perform the project build. Go to the Explorer
pane and right-click on the project name. Or go to the menu Project = Build Project.

-
+ 05 2200 Explarer 53 = 8| [
Lf Mewrob
¥ Rob
i-i2¥ Robz
S
E[& Mt
Qpen in Mew Window
Remowe From Context !
= Copy
Paste
Delet
Bl tes| 90 DoBt2
Maove. .. .
0S 2200 - Test/GETBSA.COB - Eclipse
Rename...

File Edit Mavigate Search | Project Run  ©S52200
=g Import, ., J — | - Open Project
= Export. . o - Close Project

4 05 2200 Explorer &3
Qéh Refresh e Build &ll

Eiwild Project ILE Mewrab Build Project

Click the Build Project entry. Eclipse will pop-up a dialog with the build status.
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" Build Project _|O] =
Ak

\i,) 052200 Build: Test

|

Invoking '05 2200 Add Stream Builder' on 'fTest',

[ Always run in background

| Run in Background I Cancel Details ==

You will notice that Eclipse has opened a new pane called the OS 2200 Console. After the Build
Project process has finished, this window appears at the bottom of the workbench as a tab in the
diagnostic window.

SEE

File Edit Mavigate Search P t Run 052200 ‘Window Help
= |G lrEle- | EBESE |~ %-0-Q-eF |/ we- -85 9 T e e >
+ 052200 Explorer £3 =8 GETBAA.COB £1 ] GETBSA-comp.ELT ) [F] MLFTH.FOR W =g
¥ Newrob -1 1
wG¥ Rab 8 o5 DISPLAY 'ERROR-NUN = ' ERROR-NUM UPOH PRINTER. alm
¥ rebz 8 7 DISPLAY 'ENPR-CODE = ' EMPR-KODE UPOH PRINTER. |
gﬁgﬁst (X QTS MOVE nErraan GLE-STATUS.
i B unisysrob. B o3 STRING "ERR-STiL " ERROR-STATUS
H - [ E-TESTELT B100 " EER-NUN " ERROR-NUN
[ GETEA-comp.ELT 9101 INTO GLB-REASCHN. -
iy GETBSA,COR 810z DEPART. EXIT PROGRAM.
- s MLFTN-COMP ELT 103 I
R mFT FOR 104 R-FARL.
H [ Flestrt-sgs.ELT 8105 DISPLAY 'ROLLDBACK ERRCR-STATIS = ' ERROR-STATUS UEON PRINTER.
BHE testml 8106 DISPLAY 'ERROR-NUN = ' ERROR-NUM UPON PRINTER. =l
8107 STRING "ERR-STA " ERROR-STATUS
B10s " ERR-NUM " ERROR-NUM
B109 INTO GLB-REASCH.
110 EXIT PROGRAM. =
111 * é
112 FETCH-EMPLOYER. E
113 | MOVE EMPR-IN TO EMPLOYER-NUMBER. N
114 5 COPY CALC-EMFR-CODE.
115 # MOVE EMPR-KCDE TO EMPLOYER-CODE.
B115 MOVE EMPR-IN TO EMPLOYER-NOQ.
117, | MOVE EMPLOVER-CHECE-DIGIT TO CHECE-DIGIT.
118, | MOVE EMPLOVER-ZONE-CODE TO ZONE.
118 ®  PERFORM CONPUTE-EMFR-AREAS. "
120 =
8121 SET DE-I T0 1.
Biz22 SEARCH L-BUKAL-DB-AREL =
123 AT END GO TO EMPR-ERROR
iy HMEH RN VRO (AR = NRSTASCANE (TRSTE _'ILI
| Tasks @L Problems fi ©F 2200 End Summary View m Memory f&i‘A? Registers fﬁ Eclipse 2200 Log fa‘, 52200 Host Manager Yiew - CIFS fél History fl Test:05 2200 Consdls g N =0
Bpre, i N
FURPUR 32RS (091002 1444:20) 2012 Jan 28 Sat 0100:13
RIJ*TPF§ (0) ,SCDISK, T
>Badd, 1| unisys*rob.getbBa/conp
RIJ*TPF§ (0) , SCDISK, T
0
BUCOB,S UNISYS*ROB.GETESL, TPF§.GETBESA, ,, COMPLT, SUBPROGRAN
UCOE- 12RI1E(100402) L$5- 14R2¢(100402) 120120 01:00:14 _,j
4 >

Jo? |

As you can see, this OS 2200 Console pane shows the results of the build process. Firstly Eclipse has
performed a @PRT,I and then submits the Build Stream ECL that we defined earlier. Note that if a
Brkpt file was defined and it had a View name, it would appear as a pane next to the OS 2200
Console. You can enlarge this pane or use the scroll bars to look at the output. However Eclipse does
check the OS 2200 Console and any Brkpt files for you looking for Errors, Warnings and
Informational messages.

There is a pane titled “OS 2200 End Summary View” that contains the output for all lines beginning
with END. (In a demand session using @ED, you may have issued FC END to get this info.) You can
quickly check if any errors were reported.
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&, 05 2200 Host Man...

type filter text

End Line

> END UCOB- 0 ERRORS{MAJOR]) 0 ERRORS(MINOR) 32 REMARKS(CLARIFICATION)
» EMD LINK, LINES: 4, ERRORS: 0, WARNINGS: 0, XREF5: 0.

- EMD DELETE.

END UCOB- 11 ERRORS(MAJOR]) 0 ERRORS(MINCOR]) 2 REMARKS(CLARIFICATION)
» END UCOB- 2 ERROR3(MAJOR) 3 ERRORS(MINOR) 1 WARNING(USAGE)

| Tasks )

Problems

& 052200 End Sum...

% [0 Memory

1141 Registers

& ROBJ-05 2200 Co...

& ROEJ/ROBI

Project name Build Qutput Set Output Line
ROBJ ROBJ*BREPT. 685
ROBJ ROBJ*EBRKPT. 858
ROEJ BYRAPPDK*BE... 3
ROEJ BYRAPPDK*BE... 53
ROEJ BYRAPPDK*BE... 87

Note that OS 2200 End Summary View contains the output from many project builds. This can lead to
confusion so you can clear this view by clicking the following icon on the right side of the pane title:

By clicking on the Problems tab, you will see a summary of the results of these checks.

v"— Tasks r*. Froblems &3

A2 errors, 3 warnings, 9 others

Descripkion =

3 Errors (62 items)
& Warnings (3 ikems)
I 1Infos {9items)

| Jel;

You can expand each type of error by clicking on the ‘+

> sign.

i Ak
4 Tasks |5 Problems &2

62 errors, 3 warnings, 9 others

& 05 2200 End Summary ".I'IEW\I D Memnrﬂ

Reglsterq || Eclipse Z200 Lu:u;ﬂ -s'

AT i m e =

Descripkion = | Resource | Path | Location | Tvpe |
El @ Errors (62 items)

3 L55-C5IMZ0161: Procedure EMPRCODE GETESA.COB | [Test line 29 Problem

3 L55-CSIMZ0161: Procedure KAWTAE mi GETESA.COB | [Test line 30 Praoblem

€ UCOB1404: 'EMPE-MORE' is nok Iegal at GETESA.COB | [Tesk line 176 Prablem

3 UCOB1404: '"GEM-ERR-STATUS = 'is no GETESA. COB ,I'Test ||ne a5

F'ru:-l:ulem

Eclipse prints the error/warning message, the path indicates the project with the problem and the

source line number.

The navigation pane will also indicate the project files with errors by placing the same error icon on

the name. A programmer can easily see which files have errors.

)
+ 05 2200 Explorer E?E\\_

TL,»+ Mewroh
#-¥ Rrob
#-1¥ Rabz
IElfg_,»+ Test
= E? urisys*rab,
""" |5m E-TEST.ELT

it GETESA.COB

...... [pl'_i, MLFTM.FOR
...... |5m files1rl-sgs ELT
B estmlj

----- |'m GETBS&-comp.ELT

|5 MLFTMN-COMPLELT

As a programmer, you would want to go to that line to correct the problem. By doubling-clicking on
the problem line, Eclipse will open the element in question and position the cursor on the line in error.
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175 MORE-EMPLOYEES.
@176 MO¥E "¥" EMPE-MORE.
177 SUBTRACT 1 FROM EMFPE-TINDZX.

178 ENPLOYEE-EXIT.

179 MOVE EMPE-INDX TO EMPE-TOTAL.
&y1s0 EXIT.

151 *

132

[T

T~ '
+=| Tasks ||.E'.f_~, Problems &3 & 035 2200 End Summary '-.-'iew) a Memnrﬂ aih Registers} 1 Eclipse 2200 Lu:uﬂ B

B2 errors, 3 warnings, 9 others

Description = | Resource | Fath | Location | Tvpe |
E @ Errors (62 items)

3 L55-CSIMZ0161: Procedure EMPRCODE GETBSA.COB | [Test line 29 Praoblem

@ L55-CSIM20161: Procedure KAWTAE i GETESA.COE | [Test lime 20 Praoblem

3 UCOB1404: 'EMPE-MORE' is nok legal at GETESA.COB  [Test lime 176 Problem

B e s am o L e e - —————— [EE— I —_—— -

In the above case, the problem entry for line 176 was double clicked and the COBOL editor opened
the GETBB8A file and positioned the editor at line 176. Notice the editor also indicates lines with
problems — different icons are used for errors, warning and informational.
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Interactive Debug for UCOB

Follow the procedures described earlier for performing a debug build for the project.

Perform the Debug Build

The UCS interactive debugger operates by causing the OM or ZOOM to call back to the PC doing the
debugging during the normal run of the OM or ZOOM. To accomplish this action the executable must
be static linked to include certain OMs and cause PADS to be invoked through a special entry point.
This is accomplished by the debug build. The OM or ZOOM is acting as a TCP/IP client and the PC
as the listener. It is necessary then that the 2200 be configured to allow calling out and that firewalls
do not prevent a PC from receiving connection requests from the 2200.

Debug Build Best Practice

The OM or ZOOM output with the debug settings should be placed in a different file to where the
UCOB source program is located. If the source and OM/ZOOM are in the same file when the debug
session is run, problems can occur.

Defining a Debug Configuration

There are a number of ways to initiate the debug session but first we need to define a debug
configuration. The OS 2200 Project to be debugged must be highlighted in the OS 2200 Explorer tree.
On the main icon, click on the debug ‘bug’.

T

Then select Debug Configurations.
ﬁvﬁv%vb '.;,"v -
¢ 1ROE

(¥ 2DORADOROB

Debug As k
Debug Configurations...

Organize Favorites...

Or go to the menu Run -2 Debug Configurations.
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‘Run] 052200 Window Help
[l Resume Fa&
Suspend
B Terminate Ctrl+F2
Disconnect
. StepInto Fa
Step Into Selection Ctrl+F5
i Step Owver Fa
Step Return F7
Run to Line Ctrl+R
T Use Step Filters Shift+F5
Q. Run Crl+F11
4. Debug F11
Run History r
Run As J
Run Configuraticns...
Debug History »

Debug As
Debug Config

Q. Exdernal Tools

urations...

b

The Debug Configuration dialog is shown. Double click on the OS 2200 Launcher entry to
automatically create the debug configuration for this OS 2200 Project.

[tt] COBOL Application
& Eclipse Application
E# Eclipse Data Tools

Eh] Java Applet

3] Java Application

Ju JUnit

Ju JUnit Plug-in Test

= Launch Group

n MNeodejs Application
4 (3 052200 Launcher

The dialog is filled in with information for this debug configuration from the OS 2200 Project

properties. Multip

Click the required
is selected.

le configurations can be defined. Eclipse will define a definition from a debug build.
debug configuration under the 0S2200 Launcher if the wrong debug configuration
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E Debug Configurations &

Create, manage, and run configurations

=X | B 3p - Name: ROBI
type filter text unspecified

[©] C/C++ Attach to Ap| = Project
[E] C/C++ Postmortem ROB)
[©] C/C++ Rernote Appl Debug Identifier
[te] COBOL Application ROBL3249315
& Eclipse Application Port Number
E3 Eclipse Data Tools 1023

EG) Java Applet

3] Java Application

Ju JUnit

Ju JUnit Plug-in Test

@ Launch Group

n MNodejs Application

(& 052200 Launcher
{¥ DORADOROE
& ROE)

& 05Gi Framework

E Remote Java Applica

% Remote JavaScript

%ﬂ Rhino JavaScript

() Stop on first line @ Stop on first line if no breakpoint () Stop on first breakpoeint

m

[

b MSL 4
€| i +
. . Revert Apply
Filter matched 21 of 21 items
@' [ Debug l [ Close ]

If a new debug configuration, define a meaningful name. The Project, Debug Identifier and Port
Number should match the information used in the project debug build stream.

Note that the first place where the debug stops is controlled by the following selection:

() Stop on first line @) Stop on first line if no breakpoint () Stop on first breakpoint

You may need to change this setting depending on what your debug intentions are.

Running a Debug Session

Starting a Debug Session
Click on the ‘bug’ and select the debug configuration to be used.

# - ﬁ - % - I[:_I:F} Q;I TI -
¢ 1ROE
(¥ 2DORADOROB

Debug As »
Debug Configurations...

Organize Favorites...

Eclipse will open the Debug Perspective and use the selected debug configuration.
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[ eclipse-2200-4-6-0-160920 WS - Debug - ROBJ'WORKFILEALLOC ON RS02RSVLUNISYS.COM - Eclipse = 52

rce Navigate Search Project Run OS2200 Wi Help
‘@i e n BN |eEBi- -0 Q- EE - Fy e o @ e e Quick Access || 13 | 4 & 2 (@)

|# ¥ = O 6 Variables 2 9 Breakpoints Bt E| |lcder »=1o

rminated>ROBJ [0S 2200 Launcher]
ing for program to start
3 Waiting for program to start

[ Progress Information = ®
‘ﬁ‘ Starting Debug Session
Listening for connection from executable.
| ROBJELT | BKPT.ELT ALLOC.COB 52 o vER 2 v=0O
b

NVIRONMENT
4 B CONFIGURATION
@ SOURCE-COMPUTER
i OBJECT-COMPUTER
i@ SPECIAL-NAMES
4 ® DATA
WORKING-STORAGE
4 (&P PROCEDURE
4@ A000-CONTROL
H i@ END-PARA

No consoles to display st this time.

Writable Smart Insert 85:1 § 1emorsem [
e —

Note the perspective icons in the upper right.
+ & 2

You can easily navigate to the OS 2200 Perspective and then back to the Debug Perspective using
these icons.

Then following dialog is displayed.
rE Progress Information l | (=] |_ihr

Starting Debug Session

Listening fer connection from executable.,

Cancel
L

At this stage you need to execute the debug OM/ZOOM on the 2200. For demand or batch jobs this
can be done from the Eclipse Telnet client. For full-screen programs or transactions it must be done

from an emulator. Launch a Telnet session (use icon “* from the Debug menu icons) and select the
host for this debug session. Then enter the program to be executed. (Note this is where the Link File
Name saved in the debug build stream creation is useful.)

El Console | Tasks | Problems {2 Executables o+ RS02 i

a4 s e o e e e o e e de o o e o s o o s ofe oie s e e e e e e e o e e die o o s s e s s o ofe o e e e e e ke e die o o e s o o o o e oie e e e e e e e e o ke e e e

R582 running in Eagan TIC data center starting 3/5/2817 at 15:38.
Please use Tennnn VTS tapes for writes on RSG82.
These are assigned wia X selection, TPRS@7 MAPPER TAPES run.
***Message Updated: March 5, 2817 at 15:38 CST
Current session number: 713
Previocus session was: MON 28 MAR 2017 @8:12:17 CDT
DATE: 2817-83-28 TIME: ®B8:23:25 COT
=gt BYRAPPDK*OBIFILE.2821241456D
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Submit the command or run the transaction.

The OS 2200 program will communicate with Eclipse. VVarious messages are displayed in the dialog
indicating that information is being downloaded from the 2200 to the Debug session.

{*Progress Info _ Ol x|
\]‘}) Starting Debug Session

Setting Start line breakpoint.

Zancel

The Debug Views
The following views of the debugging session are provided on tabs in the upper right pane:

e Variables view:
Shows the variables that are currently in scope. That is, it shows global variables and
variables that are local to the current stack frame. If a variable contains other variables (that
is, if it is the root of a structure), it is displayed as an expandable node.

e Registers view:
Shows the A, X, and R registers of top stack frame of the program. The registers are global;
that is, registers do not change from frame to frame.

e Breakpoints view:
Shows the breakpoints that are set currently. If you have multiple projects in your workspace,
the breakpoints for all projects are displayed, not just the breakpoints for the projects being
debugged.

e Expressions view:
Contains a list of variables that should be watched independently. You can add them to the
watch list from the variables view.

Using the Debug Perspective

Eventually the Debug session will pause with the source code in a pane and some variables listed in
the Variables view.

45 Debug &2 i ¥ = O (= Variables 32 ]
4 (¥ ROBJ[05 2200 Launcher] Name Value
4 (¥ ALLOC Main Program
4 3 TaskB47127640505
@ Suspended BreakpointROBJWORKFILE ALLOC<ALLOC> line: 77

o WS-DISP

& WS-TEST

o WS-WORD Click Here for value
o WS-WORD4

& WS-WORD6

ROBLELT BKPTELT @ ALLOC.COB 2 =0 SE Outline 2

I———+————1————+————2————+————E————+————4————+————5————+————E————+————7————+————8————F————9————+————B————+————1————+————2————P———3————+————4————+————5————+————E— 4 B ALLOC
71 ’ - 4 77 ENVIRONMEN
4 5] CONFIGUF
@& SOURC
@ OBJEC
@ SPECIA

4 9, DATA

] WORKING

4 &P PROCEDURE
display "WS-FLDL: " WS-FLD upon printer. & AOD0-CON
# END-PARS
END-PARA.
[ =) STOP RUN.

NOTE: The time it takes to call back can vary. A demand program over a fast connection generally
calls back almost immediately. A transaction can take over two minutes. The speed of the connection
to the 2200 effects the callback time.
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The upper left of the debug perspective shows the stack. These is a pane showing the editor for the
debug program. In the upper right is a pane which holds the variables, breakpoints, registers, and
watch views. The variables view displays all local and global variables in the selected stack frame.
The registers are global, that is, registers do not change from frame to frame.

Adding Breakpoints

Breakpoints can be added to source by going to the required line in the editor and doing a right click.
Note that you right click just inside the start of the line — in the example, this is the top left corner of
the pop-up.

|Z] ROBLELT (=] BKPT.ELT ALLOC.COBR
I———+————1————+————2 ———————— e s
71 mowve 12
72 mowve 1
73 move 14
74 mowve 1
75 mowve 16
76 mowve 1
77 move t mpls.
78 MOVE WS-FLD1
870 MOVE “A" TO WS-FLDZ2
26 MOVE “A" TO WS-FLLO
o Ad rm T mae "™LIC S0 " T DI
Teamn 3

Add Bookmark...
Add Task...

Show Quick Diff Ctrl+5hift+Q
¥ Show Line Mumbers

Preferences... |

¢ Add Breakpoint
f 1
i Enable Breakpoint

Breakpoint Properties...

-~

Selecting Add Breakpoint marks the line with an indicator.
831 display "WS-FLD1: ™ W5S-FLD1 upon printer.

An entry is also written to the Breakpoints view.

i#)= Variables @ Breakpoints 1

@ 'ROBRALLOC.COB [line: 77]
@ ‘ROBMALLOC.COB [line: 79]
@ 'ROBRALLOC.COB [line: 81]
@ ‘ROBRALLOC.COB [line: 85]

Enable/Disable Breakpoints

Breakpoints can be enabled or disabled in many ways. Using the Breakpoint view provides the ability
to enable/disable one or more breakpoints. Right click in the view and the breakpoints are displayed.
Using the check box controls whether a breakpoint is enabled or disabled. This can be done on
individual breakpoints. You can right click on one or more breakpoints then right click and use the
Enable or Disable option. By using Select All, the action can be performed on all breakpoints.
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()= Variables  ®g Breakpoints &3 ® 5% E T, | ==

& ‘ROBMALLOC.COB [line: 78]
& \ROBMNALLOC.COB [line: 81]

@ \ROBMALLOC.COB [line: 85]
Go to File

Hit Count...

Enable
Disable
Mo details to display for the current selectio ¥ Remove
3& Remowve All
Select All Ctrl+A

Another option is the right click on the editor line (same place where breakpoints are set) and then
select with Enable Breakpoint or Disable Breakpoint.

—_—

move 1 to test-compls.

[ Wk MOVE A" T0 WS-FI DI
Teamn 3
Add Bookmark...

Add Task...

Show Quick Diff Ctrl+5Shift+Q
v Show Line Mumbers

Preferences...

Remowve Breakpoint
Disable Breakpoint
Breakpoint Properties...

When disabled, the breakpoint check box is unchecked and the indicator is a white circle.

©g Breakpoints 53

[] o “ROBMRALLOC.COB [line: 78]
& \ROBMALLOC.COB [line: 81]

In the editor, the disabled breakpoint appears with the white indicator:

77 move 1 to test-compls.
078 MOVE “A"™ TO WS-FLD1
79 MOVE "A" TO WS-FLD2

Removing Breakpoints

Breakpoints can be removed in many ways. Using the Breakpoint view provides the ability to remove
one or more breakpoints. Highlight one or more breakpoints. Right click in the view and select
Remove.
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()= Variables  ®g Breakpoints 3 i Sﬁ 8 |
@ "ROBMALLOC.COB [line: 78]
@ \ROBMRALLOC.COB [line: 81]
@ \ROBMALLOC.COB [line: 85]

Go to File

Hit Count...

Enable
[ Disable
Mo details to display forthe e 3§  Remove
% Remove All

By using Remove All, all breakpoints are removed.

ix)= Variables | ®g Breakpoints 3 4 S& o &

@ "ROBMALLOC.COEB [line: 77]
@ "ROBMALLOC.COEB [line: 73]
@ \ROBMRALLOC.COB [line: 81]
@ ‘\ROBMALLOC COR Mine 851
o Goto File

Hit Count...

Enable
Disable

Mo details to display fo
Remowve

R X O

Remowe All
Select All Ctrl+ &

ALLOC.COB 2 Copy Ctrl+C

- I —

Paste Ctrl+W

)

Import Breakpoints...

i@ @

@ Export Breakpoints..,
Properties

Or click the Remove or Remove All icon in the Breakpoint view.
X%E | EBE

[ Remowve All Breakpoints }

Another option is the right click on the editor line (same place where breakpoints are set) and then
select with Remove Breakpoint.
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76 move 1 to test-compl?.
77 move 1 to test-compls.
78 MOVE "A" TO Ws-FLDl.|
Team 3
q Add Bookmark... -
Add Task...
Show Quick Dnff Ctrl+5Shift+ Q)

v Show Line Mumbers

Preferences...
C ;
M Remove Breakpoint
Disable Breakpoint |

Breakpoint Properties...

Breakpoint Hit Count

The Breakpoint Hit Count can be used to control when the program is suspended. Right click on the
breakpoint indicator and select Breakpoint Properties:

=] (T W] =L LI o) [l = W

Teamn 3

Add Bookmark...
Add Task...

Show Quick Diff Ctrl+5Shift+ Q)
v Show Line Mumbers

Preferences...

Remowve Breakpoint

Disable Breakpoint

Breakpoint Properties...

The properties dialog is shown:
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[ COBOL Line Breakpoint Propert... eS|

COBOL Line Breakpoint Properties®

File path: “ROBMALLOC.COB

Line number: 78

Enabled

Enable Hit count

Hit count: 1

ok || cancel |

Or from the Breakpoint view, right click:

(%)= Variables ®g Breakpoints 3 b 4 % {_,'q-:,;" E‘.}__-|

@ 'ROBRALLOC.COB [line: T&]
@ 'ROBRALLOC.COB [line: 81]
@ ‘ROBMALLOC.COB [lines 85]

o= Gote File
Hit Count...

Select the Hit Count option to define a hit count for the selected breakpoint.
m Set Breakpoint Hit Count 2

Enter the new hit count for the breakpoint
1

Enable Hit count

Ok ] ’ Cancel

The Hit Count option is used to determine when your program should suspend on that breakpoint.

If a breakpoint has a hit count of N, execution will suspend when the breakpoint is encountered for the
Nth time. After being hit, the breakpoint is disabled until either it is re-enabled or its hit count is
changed.

Viewing and Updating Variables

The Variables view lists the variables defined in your source. You can change the value of a variable
by highlighting the variable and doing a right click.
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(%)= Variables i2 | ®g Breakpoints !} Registers E = | 3 | = ==
MName Walue
4 o WS-DISP
o WS-FLD1 A
o WS-FLD2 . Select All Ctrl+A
o Ws-FDZ = Copy Variables Ctrl+C
> @ WS-TEST Enable
o W5-WORD Click Here for v )
Disable
< | 1]
A View Memaory

Find... Ctrl+F
4 ChangeValue...
Add Global Variables...

= B 2= Qutline i
— Remove Global Variables

[P p S Fomfom - oo TR &- 2
* * * * * 4 ALLOC Remove All Global Variables
- Pl EN oy
- 4 =?IEI Watch

After clicking Change Value, the following dialog is displayed. The current value is displayed. Enter
the new value then click OK.

@ Set YValue 22
Enter a new value for W5-FLD1:
i A
4 b
?\ [ Ok ] [ Cancel

The Variables view is updated:

(%)= Variables 57  ©g Breakpoints 1il] Registers

Mame WValue

4 o W5-DISP
o W5-FLD1 Z

- AN R

Watching Variables

It is also possible to ‘watch’ the value of selected variables. This is useful if your program has a lot of
variables and you are only interested in ‘watching’ the values of a few variables. Right click on the
variable name and then select Watch:
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(%)= Variables 57 @g Breakpoints &7 Expressions i} Registers E = | 1
Mame Value
4 o W5-DISP
o WS-FLD1 'z
o WS-FLD2 "
& WS-FLD3 Select All Ctrl+A
. @ WS-TEST =| Copy Variables Ctrl+C
o W5-WORD Click H Enable
. - Disable
View Memory
Find... Ctrl+F
h @, Change Value..
= O EE Ou Add Global Variables...
"2 e a & Rermove Global Variables
i = 4 Remowve &ll Global Variables

XY Watch

The Watch list is updated in the Expressions view:

(%)= Variables @g Breakpoints €% Expressions 57 Y Registers

Mame Value
& "ws-FLD1" z
& "ws-FLD2"

o0 Add new expression

As the program is debugged, the value of the “Watch” variables may change depending on the logic.

(%)= Variables 9g Breakpoints €9 Expressions 22 MY Registers

Marme Value
& "ws-FLD1" z
¥ "ws-FLD2" A

o0 Add new expression

Controlling the Debug Session

There are a number of ways of stepping thru the logic. From the debug view one can “resume”, ‘step
into’, ‘step over’, ‘step out’ or ‘terminate’.

e ‘Resume’ “# proceeds until a breakpoint is hit or the program exits.

e ‘Stepinto’ - goes to the next executable statement whether it is in the same subroutine or
a different subroutine.

e ‘Step over’ = goes to the new executable statement in the current subroutine or the calling
routine. If the next statement is in a subroutine be called by this routine, it will perform the
subroutine and return, unless there is a breakpoint in the called routine.

e ‘Step out’ will finish executing the current subroutine and stop in the next line in the
caller unless a breakpoint is hit along the way.
e “Terminate’ ® will cause the program to exit and the debugging session to end

Debugging with Subprograms

It is possible to debug with subprograms. The subprogram must have the correct compiler options as
well. Below is an excerpt from the generated Eclipse debug build stream for a simple example:

@UCOB ROBJ*WORKFILE.TEST, ROBJ*WORKFILE.,,,DEBUG/FULL,NO-OPTIM
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QUCOB ROBJ*WORKFILE.TESTSUB, ROBJ*WORKFILE.,,,DEBUG/FULL,NO-

OPTIM, SUBPROGRAM
@LINK,E ,BYRAPPDK*OBJFILE.63135610D
INCLUDE ROBJ*WORKFILE.TEST

INCLUDE ROBJ*WORKFILE.TESTSUB

INCLUDE ROBJ*WORKFILE.RJTEST

INCLUDE ECLIPSE2200*PADSS$SLIB46.DEBUGINC
CREATE REFERENCE RTSSPINIT

RESOLVE RTSS$PINIT, TCASS$S USI LCN
CHANGE REFERENCE (PADSSINIT) TO PADSSINITEC2
RES ALL REFS USI LOCAL DEFS,LCN

CONCEAL MESSAGES 108

@EOF

When running the debug session, the control will pass to the subprogram. Variables can be monitored,

changed and watched.

45 Debug 53 &
4 (¥ RUTEST [0S 2200 Launcher]
s ¥ TEST Main Program
4 ¥ Task647127640505
@ End StepROBJ*WORKFILE TESTSUB<TESTSUB> line: 23
(¥ End StepROBJ"WORKFILE TEST<TESTIT> line: 34

|=| TEST-PROC.ELT TEST.COB DEFMAS.COB =] REBUILD.ELT [E] TEST-SSGELT |=| ALLOC-COMP.ELT

- R N N e e e B i i B A e R e .

aRII CONSOLE IS CONSOLE.

16R33 DATA DIVISION.

11RJI WORKING-STORAGE SECTION.

12RI1 | P1  ws-dummy pic x.

13R31 | Pl ws-name pic x(2@).

14 LINKAGE SECTION.

15 Bl ws-param pic x(28).

16RI] | PROCEDURE DIVISION using ws-param.

17R31 | A@8@-CONTROL.

18R33 display "start testsub” upon printer.

19 move ws-param to ws-name.

20 display "Testsub ws-n <-name upon printer.

21R33 Move “FatBoy” to ws-name.

22R33 display "Testsub ws-name: " ws-name upon printer.
» 23 move ws-name to ws-param.

24RJ1 | END-PARA.

25R33 exit program.

i# v=n

] 1 & T
[ TESTSUB.COB 37 | [m) TEST.COB ™ =g

—

& Expressions 52

Name
@ "Ws-NAME"
b Add new expression

e e e T -

i

Value
FatBay

C= Outline
a4 @ TES
a 711

Note that the Variables and Expressions views only contain variables from the current program or

subprogram where the program control is active.
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Other 3GL Editors

Eclipse can support many types of editors that maybe used for OS 2200 and other development. This
section describes some of the other editors.

Fortran Editor

The Fortran editor is invoked if an OS 2200 element is given an editor type of FOR. Unisys does not
provide a Fortran Editor plug-in like we do for COBOL but instead uses the Photran editor available
from the Eclipse community.

[F] MLFTM.FOR 53

WRITE (6,1200)
1200 FOBRMAT (' Conwvert octal seconds since midnight (TDATES) to time')
100 WRITE (&6,1100)
1100 FOBMAT (' Giwve octal time (6 digits)!')
READ (5, 1000, END=999) T
1000 FOBRMAT (O8]
IHE=I/3&00
IREM=I-IHR*3 600
IMIN=IREM/ &0
IREM=IREM-IMIN*50O
WRITE (6,1001) I, IHER, IMIN, IREN

1001 FORMAT (1¥,'0',06,' = ', J2,':',J2,':',J2)
G0 TO 100

299 STOP
EHD

When you open the element, similar features as the COBOL editor in terms of colour coding are
available. The editor preferences can be found from the menu Window - Preferences - Fortran.
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& |
E Preferences - . E— - - l oy

type filter text Editor - - -
Code Guideli -
gde DHideines [¥] Enable folding
Editor
Templates Enable horizontal ruler
. Code Recommenders [¥] Convert tabs to spaces
» Data Management Tab width (0 to use the workspace default) 0
4 Fortran . .
CDT Integration Fixed-form line length i2
Editor Comments E
Templates
. Help Identifiers E
- Install/Update .
Intrinsics E
- Java
> Java EE Keywords E
> JavaScript =
. JSOM Strings E
» Log Vi
0g Viewer Mumbers and Punctuation E
» Mylyn
» Oomph C Preprocessor Directives E
052200
. Plug-in Development OpenMP/OpenACC Directives E
Plus Preferences
> Practically Macro Optic
> Run/Debug
. Server B
> Team
Validation
. |'|.wnl-. — — [Restore Defaults] ’ Apply ]

@' @:l [ oK J ’ Cancel ]

C Editor

The C editor is invoked if an OS 2200 element is given an editor type of C. Unisys does not provide a
C Editor plug-in like we do for COBOL but instead uses the C editor available from the Eclipse
community.
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T P

?| #include <fpiacgfilinf.h>

?| #include <fpirtnifile.h>
J* HEADER for TIP calls */f
#include <config.hs>
finclude <tip.h:>

#define TRUE 1
#define FALSE O
#define DEEUG TRUE

J#% PROTOTYPE Definitions of all function */

void trim(char *trim str,char *trim char):

void begin threadichar *application):

void end thread():;

void check rsa error (rsa error code type valus returned);

void report schema (char *zchemansme):

void =a report (char *schemansme,char *sa,char *file type):

char *get walue(char *atype,char *enames,char *schemaname)

void do_exec (char *task):

void get info ssgector (char *usename,int *buffer,int *word count,
int *ssector):;

void get RDMS intern(char *filename,char *qgualifier,int tip num,
int *file size,
int *page size,int *index lewvel,int *pages free):

When you open the element, similar features as the COBOL editor in terms of colour coding are
available. The editor preferences can be found from the menu Window - Preferences > C/C++.
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' N
@ Preferences - - - - l =l &J

type filter text Editor =l v v
» General -
. Ant il C/C++ Editor Preferences. General preferences may be set via Text Editors,
a4 C/C++ General behavior
Ap.pearance Srnart caret positioning in identifiers
 Build . Report problems as you type
Code Analysis o )
. Code Style [¥] Highlight matching brackets
. Debug [¥] Highlight inactive code
> | Editor When formatting code with an empty selection:
File Types (@ Format the entire file
Indexer

(") Format the statement on the current line
Language Mapp.mgs [¥] Ask for confirmation
> MNew C/C++ Project

> Property Pages Setti| - Appearance color options:
e Color: [
Template Default Va Inactive code highlight
> COBOL Completion proposal background
» Code Recommenders Completion proposal foreground
. Data Management Parameterh!ntbackgru:uund
. Fortran Parameter hint foreground
Source hover background
> Help
> Install/Update
> Java Decumentation tool comments
> JavaBE Select the documentation tool to be used to determine editor behaviors when
> JavaScript no project preference overrides exist
> JS0OMN
. Log Viewer i Workspace default: | Mone =
> Mylyn
> Qomph
052200

v

Plug-in Development
Plus Preferences

> Practically Macro Optic -
1| m | 3

@ @® [ ok || canca |

[ Restore Defaults] ’ Apply ]

General Text Editor

This editor is used for files with the ELT subtype etc. This is just a basic text editor with no special
features. The preferences can be updated by Window = Preferences = General > Editors = Text
Editors.
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r |
E Preferences - —— . - _— uﬂ‘éj
type filter text Text Editors =T v v

G | -
4 henem — Some editors may not honor all of these settings.
: Appearance
Build See 'Celors and Fonts' to configure the font. |
Capabilities
Compare/Patch Undo history size: 200
Content Types Displaved tab width 4
4 Editors Isplayed tat widkh:
Autosave [|Insert spaces for tabs
File Associations [¥] Highlight current line
» Structured Text E [T] Show print margin
» | Text Editors 80
Error Reporting =
Globalization [¥] Show line numbers
Keys Showrangeindicator
> Metwork Connectio [] Show whitespace characters (configure visibility
Motifications Show affordance in hover on how to make it sticky
Perspectives
Search When mouse moved into hover: | Enrich after delay -
> Security [¥]Enable drag and drop of text
Service Policies [¥] Warn before editing a derived file
» Startup and Shutdov [¥] Smart caret positioning at line start and end
Tracing
Ul Respensiveness b Appearance color options:
ser Storage Service
Line number foreground Calor
Web Browser Current line highlight E
> Workspace Print margin
. Ant Find scope
. CfC++ ge:ect@on Lorekgrounddcollor
election background coler
» COBOL Background celor
» Code Recommenders Foreground color
- Data Management Hyperlink
» Fortran
» Help More celors can be configured on the 'Colors and Fonts' preference page.
» Install/Update
- >
70 ava = - [Restore Defaultsl [ Apply l
®® ] .

Turning Off the Spell Checker

By default, Eclipse turns on spell checking. When editing an ECL, SSG or similar element, many
words are underlined in red as they are not matched by the spell checker. For OS 2200 elements, this
often applies so readability is affected. Also when you copy the contents and paste to Microsoft Word,
the highlighted words are inserted with underlines!

It is easy to turn off the spell checking function.
Go to Window = Preferences = Editors = Text-Editors = Spelling and uncheck “’Enable

Spelling Check’.
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~
rE Preferences - _——— - _— l E] |-
type filter text Spelling oo - v
“ an.;:;earance - [C]Enable spell checking
Build Default spelling engine
Capabilities
Compare/Patch .
Content Types Optiens
4 Editors Ignore words with digits
Autosave Ignore mixed case words
File Associations| Ignore sentence capitalization
» Structured Text E Ignore upper case words
4 Text Editor.s - 3 Ignore internet addresses
i;;eost:fi!l:i Ignore non-letters at word boundaries
Hyperlinking Ignore single letters
Linked Mode Ignore Java string literals
Quick Diff Ignore ‘&' in Java properties files
E'.IFI]JE'Il'hI:rgeferer Dictionaries
Error Reporting English (United States)
Globalization 8
Keys Browse... Variables...
» Metwork Connectior
Motifications
Perspectives i
Search @ Default (Cpl252) i
» Security Other: | Cpl252
Service Policies
» Startup and Shutdow Advanced
Tracing 1000
UI Responsiveness I
User Storage Service e
Web Browser
» Workspace
> Ant
- ’l%. - > [ Restore Defaults] [ Apply l
@' @j [ OK ] [ Cancel l

ECL Content Assistant

There is auto-completion available when editing an element for ECL commands. After typing “@”,
then do Ctrl+Space and the content assistant dialog is displayed showing the available ECL
commands:

*TEST.COB

1@

|Z] *TEST-ECL.ELT &3

-

5

@ADD format - Adds partial canned runstreams

@ADD,L format - Adds partial canned runstreams

{@ASG formatl - Assigning filesi

@ASG,UP format? - Assigning files

@EBRKPT formatl - Diverts output to a user-defined print file
@BRKPT,E format2 - Diverts output to a user-defined print fi
@CAT formatl - Catalogs a mass storage/tape file

@CAT,P format2 - Catalogs a mass storage/tape file
@®CHG format - Changes Element Name and its properties
@CKPT format - Saves a complete or a partila copy of run's ¢

@CLOSE format - Writes a hardware EQOF mark
1| 1] | 3

lom | »

@ASGOPTIONS FILEMAME

The list of possible commands can be filtered by specify the starting characters after the “@”. For
example, entering “@A” and then Ctrl+Space results in:
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*TEST.COB |Z] *TEST-ECLELT Z3

i

@ADD format - Adds partial canned runstreams @ADDOPTIONS FILENAME

@ADD,L format - Adds partial canned runstreams
@ASG formatl - Assigning files
@ASG,UP format2 - Assigning files

Double clicking on an option results in the command being written to the editor. You can tab to a
parameter and replace with the required value.

*TEST.COB  [2 *TEST-ECLELT 37
i TElC0PTIONS

Note you will have to enable the “,” after the ECL command where OPTIONS are required. Further
changes can still be made to the editor.
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OS 2200 File Explorer

Using OFE

Often an OS 2200 developer will need to review the contents of a data file or perhaps need to review
source elements quickly without the use of a project. Unisys has added the OS 2200 File Explorer
(OFE) feature to handle these types of activities. As this feature is outside of the planned use of
Eclipse as an IDE using projects, some other features may not be available.

OFE is part of the OS 2200 Perspective and is a separate tab to the OS 2200 Explorer in the Explorer
pane:

E eclipse-2200-4-5-0-160920 WS - 05 2200 - Eclipse
File Edit Mavigate Search Project Bun 052200 Window H

ﬁ'_é.} ..|,u1¢§ | &=F | .ﬁf
+ 052200 Explorer 2] OS 2200 File Explorer 53 = 0
Connection [SOCSO - =
Share

i@ Share Mame () Workfile Share
052200

File
STD# () SHARED#

?, ~ and & are wildcard characters

Detail View - updating...
Date modified [ Size

[] Minimize the view
Displaying iterns for \W10.121.0.234,052200

Marme Date modified Size -

= S85CIPHERSSS bl
[=- S5CIPHERSS
[= 555IMANSS
L= SIMITIALTZES

The Connection has all of the configured OS 2200 hosts in a list box. Select the host to be accessed:

Connection | S0C50 x| =

R302
SOCDR
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The icon is used to clear the information used by OFE about this host and files/elements. The
date and time when the cache was last cleared is displayed.
The Share parameter allows the user to select the CIFS share name to be used.
For the File parameter, if the system is configured for MHFS then the directory option is enabled.
In the text box under File, provide your input, as follows:

e If you provide the input as a qualifier, then the list of files with the qualifier are listed.

e If you provide the input as a fully qualified element name or data file, then the file opens in

the relevant editor.

o If you provide the input as a program file, then the list of elements appears. (If in Windows ->
Preferences -> OS 2200, the Show Absolute Elements is checked, then the absolute names are

also listed.)
The File search criteria can be entered in either OS 2200 format or Posix format as shown below:
File File
STD# SHARED# STD# SHARED#
ROBJ"WOREFILE. - ROBIMNWORKFILE -
?, ~ gnd & are wildcard characters ?, =~ gnd ¥ are wildcard characters

Wildcard Characters

You can use wildcard characters such as ?, ~, and % to reduce the scope of the available options, as
follows:

e '?” Represents a single character. For example, if the searched string is A?C, the result can be
ABC but not ABDC.

e ‘~’ Represents any number of characters. For example, if the searched string is A~C, the
result can be ABC and ABDC.

e ‘%’ Represents the presence of a key string anywhere within the name of the entity. For
example, if the searched string is AB%, the result can be ABC, CAB, and CBABD.

Note the last 10 searches are stored in the File list box:
File
STD# () SHARED#

-
LIBMGRSA*LIEMGR-DIAGS
DORADO*ROB.GETESA/COMP
DORADO*ROE.BSASTUE/COMP
DORADO*ROE.DORADOROE
PADSLIBSTR*170315140701.

[” SECRET*BKPT.
UNISYS*ROB.
L ROB*TESTSK,
| DORADO*ROB.BBASTUB//ABS

Detailed View
Use the Detailed View to display Date Modified and file Size information.

The following example shows the source elements for program file DORADO*ROB with the options
for date modified and size checked:
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File
STD# () SHARED#
DORADO*ROE. - >

} ~ gnd ¥ are wildcard characters

Detail View
Date modified Size

[T] Minimize the view
Displaying itermns for DORADCO*ROE,

Marne Date modified Size i
Ll =

|=| 0-BREAK/SECRET May 4, 200912:20 ... 6 KB

= 4D222 Oct20, 2011 6:01 ... 2KB

|= 4D222/D4350 Junl7, 20161:34 ... 2KB

= TATIMY Sep 20,2004 5:02 ... 4 KB

|= ADSDOC Dec9, 2004 243 AM 618 KB

|= ADS-TXMNS Aug 20, 2004 5:30 ... 1KE

|= ALLOC Marld, 2017 5:05.. 4KB

=l ALLOC/COMP Marl4, 2017 4:43 ... 1KE
=l ALLOC/COMP...  Jun19, 201612:05.. 1KE
ALLOC/COMP-... Marl5, 2017 11:11... 1 KB

Note be default the list is sorted in Name order but can be sorted by Date modified or Size by clicking
the sort column heading. The date modified timestamp for each file/element is displayed in the local
workstation time.

Opening Files/Elements

By double clicking on an entry, the file is opened in the editor. But by right clicking on an entry, the
context menu of actions is presented. Many of these are the same as the OS 2200 Explorer tasks.

Displaying itermns for DORADC*ROE.

Mame Date modified Size -
= DECOMP/RSS  Jun30,20122:48.. 5KB
. = DEFMAS Mar19, 2017 8:45 ... 97 KB
= DELETE/GEMFIL... Oct20,200911:46.. 1KB LR
= DEPCON Aug12, 200411:5... 1KB Open in Read-Only Mode
=] DEPCON/DR Nov 24, 2016 8:51 ... 1KB Create »
= DEPCON/PARA... Augld4,20049:11.. 1KB Delete

EIDORADOROB  Marl5,20171:53 .. 1KB  |Bpy 02200 Compare

|=| DPS3/TERMFILE  Sep 30, 2004 2253 ... 1KE Copy 05 2200 Path

=| DPS-CHG Dec 2, 2011 8:33 AM 40 KB )
2 DPS-CHG/WON  Dec2 201112:46 .. 58 KB e] | ~OPY
= DPSCHGZ3FEB/... Feb23 201311:25.. 23KB Paste

=/ DPSCHG21-34/..  Jul7,20121:30 PM 50 KE Y7 052200 Search
|= DPSCHG42-44 Jull, 2013 2:03 PM G KE ] TDATES Search

= DPS-COMUS Dec2,20119:22AM 34KB | 5 Send Using E-mail
NPS-FRR Merc 2 200171 323 AR 44 KR e
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OFE also supports the ability to display SDF files. In the following example, the qualifier 0-BREAK
was used as the search criteria and the matching files displayed. Then 0-BREAK*SECRET was
double clicked and Eclipse opened it in an editor.

[ eclipse-2200-4-6-0-160920 WS - OS 2200 - 0-BREAK*SECRET. ON 10.121.0.23 - Eclipse
File Edit Source MNavigate Search Project Run 052200 Window Help

Eie w0 |a E Bt~ 0- G- 3 5 - O

+ 05 2200 File Explorer &3 = 4 |51 SECRET.ELT &3 =t

1[BUCOB,L  DORADO*ROB.ALLOC,TPF$.ALLOCOM, , ,COMPAT, DEBUG/ FULL,NO-OPTIM .
2 UCOB- 12R2(141201) LSS- 14R4(141281) 2817 Mar 15 1112:14

3

4 OPTIONS: ALLOC, APPLICATION/UDSSRC, NO-AUXPROLOG, CACHE/D®, NO-CALIGN, NO-CLEAR, CODE, NO-CODE-LVE, COMPAT, (
5 DOUBLEQUOTE, SINGLESPACE, ERRCHECK, NO-ERREXIT, EXTENDED, NO-I18N-I0, NO-IR-DIFF, WO-LEVEL, LINKINFO, LISTCOF
& MAIN-PROGRAM, MAXERRORS/18@80@, NO-MONITOR, MULTI-PF, OBJECT, OBI-PKT, NO-OPTIM, OPTICNS, NO-PARMCHECK, NO-Ri

:ﬁvgi Q‘nm: 2 w

Connection [SOCSO

Share 7 NO-RECRDER, NO-RUNCHECK, SEARCH-PF-SI, NO-SEGCODE, NO-SHIFT, SIGNON, SOURCE, NO-TRACECOPY, NO-TRACEMSG, NO-TF
5 NO-UREP-XREF, WARNING, WIDE, XREF, NO-MIN-ALS
@ Share Name () Workfile Share 9
12 *REMARK (CLARIFICATION) UCOB1493: The COMPAT option does not make UCS COBOL fully compatible with ASCII COBOL
052200 11 for differences
12 *REMARK (CLARIFICATION) UCOB1494: With the selected COMPAT option, data allocation is on word boundaries rathe
File 13 *REMARK(CLARIFICATION) UCOB1495: HIGH-VALUE is set to @177
141
STDF (O SHARED® 152 1 IDENTIFICATION DIVISION.
163 PROGRAM-ID. ALLOC.
" - . il
0-BREAK*SECRET. - & M
3, ~ and % are wildcard characters 5 ENVIRONMENT DIVISION.
196 CONFIGURATION SECTION.
Detail View 207 SOURCE-COMPUTER. UNISYS-2200.
== - 218 OBJECT-COMPUTER. UNISYS-2268 MEMORY 3 MODULES.
| Dat dified [¥]Si
ate modie =€ 229 SPECIAL-NAMES.
. . 2318 PRINTER IS PRINTER
[CIMinimize the view 2411 CONSOLE IS CONSOLE.
2512
Displaying items for 0-BREAK™ 2613 DATA DIVISION.
Name Date modified Size 2714 WORKING-STORAGE SECTION.
28
B . 29 *REMARK (CLARIFICATION) UCOB1499: PIC 1 is treated as if USAGE BINARY-1 was present
B cay Jun13,2016 5:44... 28 KB 30 Vf )
3115 91 WS-WORD PIC 1(36). g
[ pBA Jun 13, 2016 5:46... 252 KB < = v
[= ePORTA Jun 21, 2016 818.. 28 KB
[21Boss Jun13, 2016 5:44... 532 KB % 052200 Host Manage... 2 E =t
Emazn Jun 13,2016 5:44.. 28 KB @ FR- -
SECRET Mar15, 2017 11:...  132KB
= UNUE ) arzu ’2016 140 B KB | Host Name Connection Status User-ID Qs
= un b 49, =

Selecting a File Using File Cycle Value

Note that OFE also allows file cycles to be specified as part of the search criteria. The absolute or
relative Fcycle value can be used. In the following example, 0-BREAK*SECRET(-1) was specified:

E eclipse-2200-4-6-0-160920 WS - OS 2200 - 0-BREAK*SECRET(-1). OM 10.171.0.23 - Eclipse
File Edit Source Mavigate Search Project Run 052200 Window Help

N u=|m: < ‘ 3 5 @ M B~ By \Q&]\Zniﬁ.-equ:b $ - = - ¥5 5 - v|
+ [=] 05 2200 File Explorer 52 = B  [5 SECRET.ELT | [2 SECRET(-1JELT 12 =0
1{@UCOB,L DORADO*ROB.ALLOC, TPF$.ALLOCOM, , ,COMPAT, DEBUG/FULL ,NO-OPTIM -

2UCOB- 12R2(141281) LSS- 14R4(141281) 2817 Mar 15 1111:23

3

4 OPTIONS: ALLOC, APPLICATION/UDSSRC, NO-AUXPROLOG, CACHE/D@, NO-CALIGN, NO-CLEAR, CODE, NO-CODE-LVE, COMPAT, CC
5 DOUBLEQUOTE, SINGLESPACE, ERRCHECK, NO-ERREXIT, EXTENDED, NO-I18N-IO, NO-IR-DIFF, NO-LEVEL, LINKINFO, LISTCOP*
6 MAIN-PROGRAM, MAXERRORS/100808, NO-MONITOR, MULTI-PF, OBJECT, OBJ-PKT, NO-OPTIM, OPTIONS, NO-PARMCHECK, NO-REl
7 NO-REORDER, NO-RUNCHECK, SEARCH-PF-SI, NO-SEGCODE, NO-SHIFT, SIGNON, SOURCE, NO-TRACECOPY, NO-TRACEMSG, NO-TR/

Cennection [SQCSO A

Share
5 NO-UREP-XREF, WARNING, WIDE, XREF, NO-MIN-ALS
'@ Share Name () Workfile Share ]
16 *REMARK (CLARIFICATION) UCOB1493: The COMPAT option does not make UCS COBOL fully compatible with ASCII COBOL
052200 11 for differences
12 *REMARK (CLARIFICATION) UCOB1494: With the selected COMPAT option, data allocation is on word boundaries rather
File 15 *REMARK(CLARIFICATION) UCOB1495: HIGH-VALUE is set to 8177
141
S 152 1 IDENTIFICATION DIVISION.
0-BREAK*SECRET(-1). - 2 ,fi PROGRAM-ID. ALLOC.
2, ~ and ¥ are wildcard characters 185 ENVIRONMENT DIVISION.

Opening a File/Element from an Editor

OS 2200 File Explorer can be launched with parameters to open a file/element selected in an editor.
For example, a runstream might be open in a text editor. A file/element name can be highlighted.
Then right click in the editor and select Open Data-File/Element or enter Shift+F7.
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[=] SECRET.ELT [=] SECRET(-1).ELT
1 @delete,c robj*brkpt.
2 [@cat,p robj*brkpt.
3 luse brkpt,robj*brkpt

4 f@brkpt print$/brkpt
LA - ch FworkTile. allo peu e somash

|=| ALLOC-COMP.ELT &3

6 @link,l ,robj*workfile.all Undo Ctrl+Z

7 include tpf%.allocom . Revert File

8 resolve all references usin

9 DELETE ALL DEFIMITIONS EXCE Save Ctrl+5

18 process for extended

11 f@eot Open With 3

12@brkpt prints Show In Alt+Shift+W »
Cut Ctrl+ X
Copy Ctrl+C
Paste Ctrl+V
Resource Configurations »
Open Data-File/Element Shift+F7

OFE is populated with the selected file/element and the correct host connection. The user just needs to

submit the request.

+ 052200 Explorer 05 2200 File Explorer &3

Connection ’HSHZ

Share

@ Share Mame () Workfile Share

052200

File
STD# SHARED#
ROBFWORKFILEALLOC -
?, ~ and & are wildcard characters

Detail View
Date medified Size

[] Minimize the view

-

= 0O
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Eclipse and Rolled-Out Files

If an OS 2200 file (program or data) is stored on Fixed disk, it may be subject to be rolled-out when
mass storage reaches a threshold. When using Eclipse project or OFCS methods to access a file, the
handling of a rolled-out file can be impacted by the system security level and a CIFS parameter. The
information below is a summary of how Eclipse handles rolled-out files in these cases. If you are
using the Eclipse Telnet session, then the same handling as per any Demand run is performed.

Fundamental Security

CIFS does not initiate a ROLBAK since the CIFS subsystem runs in privileged mode
Error status returned to Eclipse and user gets error dialog saying file is not accessible and
maybe rolled-out

User must manually initiate the ROLBAK using a demand session e.g. @ASG,A
Recommend CIFSSWAITROLBAK be set to 1 so Eclipse responds immediately

Note CIFS 8R4C will initiate a separate job to initiate a ROLBAK..

SECOPTnN Security

CIFS will initiate a ROLBAK. (If not, CIFS not installed correctly. In this case, it is likely the
privileges for the userid that owns and runs the CIFS subsystem are incorrect.)
CIFS waits until the earlier of 2 events. Note Eclipse will show no activity during this time.
1. File isrestored to text and CIFS then continues with Eclipse request e.g. to open the
file.
2. CIFSSWAITROLBAK timer expires. Error status is returned to Eclipse and user gets
error dialog.
Recommend CIFS$WAITROLBAK in CIFS-BACK runstream be set to 1. This would avoid
the Eclipse user thinking Eclipse is ‘hung’. The default value is 600 seconds.
System profile should set CIFS$WAITROLBAK to default 600. This is for OS 2200 batch
and demand connections to CIFS.
If other CIFS network connections require a longer CIFSSWAITROLBAK period, a userid
profile should be created with the appropriate value.

Contact your system administrator to modify the CIFS-BACK runstream to set the
CIFSSWAITROLBAK to 1 second. The following example shows the suggested change to the
SYS$LIB$*RUNS.CIFS-BACK runstream:

fzifzut

Set

set CIFISWAITREOLELAK=1
ffrees STISLIBS*CIFSSLIE
[@xct modps—-g
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Using the RDMS JDBC Client

This section provides some guidance in using the JDBC interface located in the Data Source Explorer
view of the J2EE perspective in Eclipse. This can be useful for RDMS programs where the developer
wants to test a SQL command before including it in a program. However this section will also prove
useful to Java developers.

It is assumed that the JDBC-RDMS software has been installed and configured on the OS 2200 host
plus the relevant background service jobs are running. Review to the Relational JDBC Driver for
ClearPath OS 2200 User Guide for information on the installation and configuration of the OS 2200
software. Consult your system administrator if unsure.

Configuring the JDBC Client

Refer to the section 4 of the ClearPath OS 2200 IDE for Eclipse Application Development Guide for
Java EE. It is assumed a folder “C:\Database Drivers” has been created and the appropriate jar files
copied into this folder from the <appl group>*JDBCS$CLIENT installed file.

Open the Java EE perspective and click on the Data Source Explorer tab.

L
— =
(%1 Markers (._. Propetties (ﬁ’& SErvers ( Data Source Explorer 23 B Snippets}

o[ Database Connections :
Ell:b QDA Daka Sources
----- [= Flat File Dakta Source
----- [=> Web Services Data Source
720 ¥ML Data Source

Right click on Database Connections and select New.
The following dialog appears.
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{"¥New Connection Profile 10l x|

Connection Profile

__"\._1{

Create a Generic JDBC connection profile,

—Conneckion Prafile Twpes:

| kvpe filker text

éDEZ For Linux, UMIX, and Windows -
E4DB2 for i5/05

E4DE2 for 2j05

@Derby

4 Generic JDBC

EdHsoLoe

@Inﬁ:rmix

élngres

£ MaxDB

EdmysoL

@Oracle

@F‘DstgreSQL

@SQL Server

B4 sqLie o
éﬁybase B354 ;I

Mame:
| coO1 RDMS

Description (optional;
| JDBC For CDO1 ROMS|

@ < Bach I Mexk = I FEimist Cancel

Select the Generic JDBC connection profile type.

Enter a value in the Name field to identify this connection. Optionally enter a description. Then click
Next.

{"¥New Connection Profile —|Oj =

Specify a Driver and Connection Details —

@ Define and select a driver from the drop-down lisk ko continue,

Drrivers: I j @ s

Click the @ icon to the right of the Drivers field. A dialog showing available drivers is displayed.

Page: 138 of 158
Version: 4.1 File: Eclipse OS 2200 IDE Getting Started v4.1.docx



.
UN[SYS ClearPath OS 2200 IDE for Eclipse Getting Started Guide

{"¥New Driver Definition x|

Specify a Driver Template and Definition Name

@ Driver files not specified in driver definition,

Mame/ Type |J.ﬁ.R List | Properties |

fvailable driver templakes:

Mame = | Swystem Mendar | Swskem Yersion |
= Database

Generic JDEC Driver Generic JDBC

Driver narme:

| Generic JDBC Driver

Driver tvpe:
| Generic JDBC Driver

@:I ] 4 I Cancel

Select the Generic JDBC Driver.
Click on the JAR List tab so the JAR files copied into the C:\Database Drivers folder can be added.

Mame Type IR List |F'rn:||:|erties I

Crriver files:

Add JAR/Zip. . |

Click on the Add JAR/Zip button and browse to the C:\Database Drivers folder. Select the
rdmsdriver.jar file.

Repeat for the unsiys-jca.jar file. The result should look like below.

MameType JAR List |Prnperties I

Driver Files:
C:\Database Driversirdmsdriver, jar add 18R/ Zip... I
Ci\Database Driversiunisys-jca.jar

Edik 1400 Fin I

Click the Properties tab.
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Name,l'T';.-'pel J4R List  Properties |

Properties:

Property | Walue |

= General
Connection URL  jdbe:rdms:host=C001, M&, LIS, UNISYS . COM; port=1544; varchar=+varchar; schema=o5upplyStare

Database Mame  SAMPLE
Driver Class
User ID

In the Connection URL, type jdbc:rdms:host=name; port=1544; varchar=varchar;
schema=0OSupplyStore
where
name is the name of your OS 2200 host.

1544 is the default port number for application group 3; your port number can differ
if you are using an application group other than 3 or are not using the default port.

The schema name should match the RDMS schema you want to access.
Highlight the Driver Class field and click the icon in the right edge of the field.

L’} Available Classes from Jar Lis _|O] x|

Provide the name of the driver class or seleck a class from the available jars.

™ Tvpe class name

{* Browse for class

com.unisys, 052200, rdms. jdbc. RdmsDriver

(0] 4 I Cancel

Click on Browse for class and highlight com.unisys.0s2200.rdms.jdbs.RdmsDriver.
Click OK.
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{"¥New Connection Profile 10l x|

Specify a Driver and Connection Details

Select a driver from the drop-down and provide login details For the [
conneckion,

Drrivers: IGeneric DB Driver j *EF' M

—Properties

General | Optional |

Database: | SAMPLE

LIRL: | jdbcirdms:host=C001, WA, UTS, UMISY S, COM; port=1544; varchar=yvz

Lser name: | jarmieson

Password: | TIIIY

¥ Conmect when the wizard completes Test Conneckion |

[T Conmect every time the workbench is skarted

@:l = Back Mext = | Einish I Cancel

Enter your OS 2200 credentials.

At this stage, we can test the connection. Click Test Connection. If OK, the following pop-up
appears.

x

- Fing succeeded!
i)

Click OK and then click Finish.

The Data Source Explorer pane will now show the connection details that we have just defined as
shown below.
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=
EA Markers (ﬂ Properties ﬁﬂ: SEervers ﬁ Riii iiHiii iii iiii ﬁ i = Snippets

E-[-= Database Connections
P D01 RDMS (ROMS v, 0.0,0)
; #- [ SAMPLE
== ODa Data Sources
----- [ Flat File Data Source
----- [= Weh Services Data Source

------ [ ML Daka Source

Retrieving RDMS Schema Information

Expand the database name entry. In this example, it is SAMPLE. This make take a little time as the
JDBC driver is used to read key information from the RDMS catalog on the 2200.

.
(2 Markers (El Propetties (&tﬂ Servers ﬁ Eiii iiHiii iii arer ﬁ 5 =1 Snippets

[El-[Z Database Connections
Iél--ia 001 ROMS (ROMS . 0.0.00
=[] saMPLE
----- [T authaorization IDs
=~ Schemas
#-85 pMs-5v5-CF
-85 DBCHCATALOGZ
#-55 0sUPPLYSTORE
+-55 rpms
+-55 RDMS_CATALOG
E_? TCS
=25 upep
-85 URer_saL
E-= CDa Data Sources
2= Flat File Data Source
[ Web Services Data Source

------ [= ¥ML Data Source

Expanding the Schemas entry shows the available schemas.

Only RDMS schemas are displayed including internal RDMS schemas that describe DMS schema
information.

Expand a RDMS schema entry and then a table entry for this schema.
You will see the columns defined for the table and their data definition.
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-
EA Markers (ﬂ Properties ($'?$ SErvers (ﬁ Data Source Explarer &3 =1 Shippets =

SAMPLE

El[E:- Database Connections
&4 CDO1 RDMS (RDMS v, 0,0.0)

. [ authorization IDs
=7 Schemas

-8 DMs-svs-CF
-85 JDBCHCATALOGE
-85 0sUPPLYSTORE

I:I Dependencies
I:I Stared Procedures
=71 Tables

=] STORECUSTOMER.

el

-8

5 E - E
008 008 008 008 008 008

El[:l Columns

#8 CUSTOMERID [CHAR(E) FK]

FMAME [CHAR( 18] Mullable]

LMAME [CHART18) Mullable]
STREETADDRESS [CHAR(25) Mullable]
CITY [CHAR{2E) Mullable]

STATE [CHAR(Z) Mullable]

ZIPCODE [CHAR(S) Mullable]

MOTES [CHARI40) Mullable]

-7 Conskraints
#-[J Dependencies
#-[7 Indexes
I:I Triggers

]E STOREIMVENTORY

B STOREMANAGER
w5 STORESUPPLIER
- [E] USERACCESS

-7 User-Defined Functions
() User-Defined Types
S iews
-5 ROMS

B8 ROMS_CATALOG

Highlight a table entry, right click, select Data and then Sample Contents.

IIlﬁ | lear-Mafimed Frinckinne

A new view called SQL results is opened and the data in the table is displayed.

-
E_l, Markers (E Propetties ﬂ?&- Servers ﬁ Hiii iiiiii iii iiii ﬁ i E= Snippets}

EI---?E OSUPPLYSTORE

I:I Dependencies
I:I Stored Procedures
ElI:| Tables

I B e - .
Laad...
Gk Enerace
E STOREMAN: ":EI G ke DDL —
erres — II
] STORESUPR Rafrash - _
- USERACCES S Sample Conkents

[51 Markers (El Properties H?é- Servers (ﬁ Data Source Explorer (.j‘_‘l Snippets ﬁ iii iiii ii ﬁ i b4 Sﬁ | =
ifype query expression here Stakus |Resultl I
Status | operation | pate | connetion... | | customerIn | Fruame | tname | sTREETADDRESS | ity | sTate | zipcook | moTes |
v Succeer SELECT* .., 06/03/2012 .., CDO1 RDMS 1 CUSTL Frank  Jomes 123 Main St. Mi... MM 54101 Like. ..
v’ Succest SELECT CUS... 06j03/2012 ... CDO1 RDMS g Eﬂglg le ;'tw g;?g ;_St S&d "A”‘--- m :;if I?J‘g
¥’ Succest SELECT OSU... 06/03(2012 ... CDO1 RDMS s e ne e e
v Succeec SELECT OSU... 06/03/2012 ... CDO1 RDMS
v Succest 06/03(2012 ... CDO1 RDMS
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Developing and Testing SQL Commands
Right click on the Database Connection entry.

-
E_-, Markers ﬂﬂ Properties |/$‘f'$ Servers =1 Snippets
ElIE? Database Connections
26
=[] saMpLE | omECE
L 7 autho Disconneck
ElI:I Schen Find..
Eg O work CFfline
E-l I save offline
|: Rename Fz
...[: Delete Delete
E|I:' Duplicate
E Refresh F5
I
- Open SOL Scrapbook
E Propetties Alk+Enter
H [

Select Open SQL Scrapbook. A new Window appears as shown below.

(L *5L serapback0 01 =

Type: |Generic JDBC_1.x | mame: fcoo1 RoMs | Database: SN'-'IF'LE vI Status: Connected, Auto Commit
=]

"Cnnnection profile

4 o

Use the list box to select the Type, the Name and the Database. These are the values we defined
earlier.

Right click in this window.
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Conneckion profile
lrlype: IGeneric JOEC_1.= j [anne: ICDDI RDMSj Database: ISAMPLE 'I Skatus: Connected, Aubo Commit
I =
Wndo itz
Ut el
oy L
Paste: Chrl+y
Togale Conment Chrl+f
Execute al Chrl+alk+x
Execute Selected Text filb+
Execute Selected Text As One Statement Alt+c
Execute Current Text Alk+5
Save as emplate; .
Edit in 3 ry Builder. .
Preferences...
Ea Set Connection Info
Click the Edit in SQL Query Builder entry.
The window for the SQL Query Builder opens. This allows you to manually type in the SQL
command in the upper pane or use the advanced features described below to help automate this
process.
x
SELECT * =

FROM

4 o

------ [ SELECT Statement

Ta add a table, right-click in this pane and use the pop-up menu.

[~ DIsTINCT

Calumns |C0nditi0ns I Groups I Group Conditions I

Column | Alias | Output | Sort Type | Sort Order |

Edit [ SOL Resuks |
874 | Cancel I

In the middle left pane (with the “To add a table...” text), right click and then click on Add Table.

To add a table, right-click in this pane and use the pop-up menu.

Add Table... |

Scroll to the correct database and expand the entry to show the tables.
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"t Add Table

El---EE OSUPPLYSTORE
- STORECUSTOMER.

x|
B
[T STOREINVENTORY J
=

Table name: -] STOREMAMAGER

o E STORESUPPLIER,

------ £ UsERACCESS
=55 ppMs

Table alias: |

Ik I Zancel

Highlight the required table and click OK.

A small box appears with the table name as the title and all columns listed. A check box appears next
to each column.

Notice how the SELECT command in the upper pane now has this table added to the FROM clause.

-I:PSIJL Query Builder

JELECT *
FRCOM O3UPPLYSTORE.STORECTITOMER

(Zuk:

Copy

Paste

Conkent Assisk Ckrl+Space
Content Tip Ckrl+3Shift+Space

LI Revert o Last Correct Source
Zear to Template
hange Statement Tvpe...

STORECUITOMER

CUSTOMERID ﬂ
FNAME Run 5GL

LMAME r

CThCCTA nnnj_,
4 I I v

Right click in the upper pane and select Run SQL.

The JDBC driver will pass the command to the 2200 for processing and return the results. If the
command is in error, this is reported.

Ornik Current Schema. ..

-I:}SQL Query Builder 5'

| Type query expression here Status [Resultl ]
CUSTOMERID | FMAME

STREETADDRESS | CITY
Jones | 123 Main St
2 CusTZ Ann Tho... | 3456 Lsk Sk, M. MM 54112
3 CUST3 Paul Skep... 9876 Pine Rd. An.. MY 53111 Mew client,

Status | Operation | Dake: | Conneckion, ., |
v Succeec SELECT * ... 06/03/2012 ... CDO1 RDMS

Taotal 3 records shown

Edit | S3L Results
oK | Cancel I

Note that the bottom left of the SQL Query Builder window now has the option to select Edit or SQL
Results. If you click on SQL Results, the data returned from the 2200 based on the submitted SQL
command is shown.
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Edit | 5L Results |

Click Edit to return the query builder editor.

In the bottom pane, we can set different options for the SQL command. In the middle left pane, check
the columns that you want to display. Now look at column tab in the bottom pane. We see the
columns we selected are listed as Output is checked.

{F50L Query Builder x|
SELECT CUITOMERID, FWAME, LNAME, MNOTES ;I

FROM OSUPPLYSTORE.STORECUSTOMER

4 o

------ [ SELECT Stakement

STORECUSTOMER
/| CUSTOMERID ﬂ
| FHAME
7| LNAME

= 3
1 cTnecT ﬂnnr:r’

[ DISTINCT

Columns |C0nditions I Groups I Group Conditions I

Column | Alias | Qutpuk | Sart Type | Sart Order |
STORECUSTOMER, CUSTOMERID v
STORECUSTOMER, FHNAME v
STORECUSTOMER, LNAME v
STORECUSTOMER. MOTES v

Edit [ SOL Resuks |
oK | Cancel I

Run the SQL command and confirm that the output only contains the selected columns.
x|

| Type query expression here Status [Resultl ]

Status | operation | Date | Connection... | | cusTOMERID | FraME | LramE | noTES
¥ Succesc SELECT*..,  08/03/2012 ... CDO1RDMS 1 cusTL Frank Jones Likes Sorry products,
¥ Succeet SELECT CUS.., 06{03{2012 .., CDO1ROMS 2 qustz Ann Thomas Big customer, be nice!
3 CUST3 Paul Stephens MNew client,

In the middle left pane, add another table.

Note the SQL command is updated with the new table in the FROM clause.
Select some fields in the new table.

We can also select the fields to be used to join the tables. In the example below, SUPPLIERID is
highlighted in the STOREINVENTORY table. The mouse is held down and the cursor dragged to the
SUPPLIERID in the STORESUPPLIER table. Note that the system shows a line linking these fields.
Also note that the SQL command now has a JOIN and ON clauses added.
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-I:PSQL Query Builder

SJELECT CSUPPLY3TORE.STOREINVENTORY.ITEMIL, OCO3UPPLYSTORE.STCREINVENTORY.IUPFLIERID,
CSUPPLYSTORE . STORESUPPLIER. COMPANYINAME
FRON
CSUPPLYSITORE . STOREINVENTORY JOIN OSUPPLYZSTORE.STCORESUPFLIER
CH OSUPPLYZTORE . 3TOREINVENTORY. SUFFLIERID = OSUPPLYITCORE.STORESZUPFLIER. 3UPFLIERID

o
v
[ SELECT Statement
STOREINVENTORY STORESUPPLIER
| SUPPLIERID = . [] SUPPLIERID = 3
[] DESCRIPTION V| COMPANYNAM
[] QTY¥OMHARND [ ] STREETADDRE: ,
[] PRICE T =
- - I I *
=
[~ DISTINGT

Columns IConditions | Groups | Group Conditions I

Colurin | Alias | Cutput | Sart Type | Sort Crder |
CSUPPLYSTORE,STOREINVENTC, .. v
COSUPPLYSTORE. STOREINWENTO, ., wd
CSUPPLYSTORE,STORESUPPLIER. .. v

Run the SQL command and check the results. As shown below, we get the required information.
ITEMID and SUPPLIERID come from the STOREINVENTORY table while COMPANYNAME
comes from the STORESUPPLIER table.

-I:}SQL Query Builder

| il'ype query expression here Skatus [Resultl ]

Status | operation | Date | connection. .. | 1TEMID | SUPPLIERID | COMPARNAME
v’ Succeec SELECT * ... 08/03/2012 ... CDOL RDMS 1 ITEM1 SUPLL Anderson Supphy
 Succeec SELECT CUS.., 08{03/2012 ... CDO1 RDMS g g:mg gﬂgtg Setm EaPEfS

2Lers Fapers
v/ Succesc SELECT 05U, 08/03/2012 ... CDOLRDMS 4 I1ewe 2R Bclorso Sl

In the bottom pane, click on the Conditions tab. This is how we can easily define the WHERE clause
to apply to our SQL command. Click on the column field and only valid columns are shown. Select a
value. Then select the Operator and finally select the Value. Note the value could be a literal or a
column entry from a table.

L¥50L Query Builder |

SELECT O3UPPLYSTORE.3ZTOREINVENTORY.ITEMID, OSUPPLYSTORE.ITOREINVENTORY.3UPPLIERIL, o

OSUTPPLYSTORE .. STORESUPPLIER. COMPANYNAME

FROH

OIFUPPLYSTORE . STOREINVENTORY JOIN OIUPPLYSITORE.STORESUPFLIER ON OSUPPLYSTORE.ITORE INVENTORY.SUPFLIERII

WHERE OSUPPLYSTORE.ITCREINVENTORY.ZUPPLIERID = 'SUPL1' -

| | |
- v

------ [ SELECT Statement

STORE INVENTORY STORESUPPLIER
/] TTEMID & = [[] SUPPLIERID = rj
/| SUPPLIERID ¥ /| COMPANYNAM
[[] DESCRIPTION [] STREETADDRES ,
[ QTvoRHAND R
=
[~ DISTIMCT

Columns ~ Conditions | Groups I Group Conditions I

Colurmn | Cper akor | Eue | AMDIOR |
OSUPPLYSTORE, STOREINVENTORY  SUPPLIERID = iEUPLL

Note the WHERE clause is now added to our SQL command. We only wanted to see SUPPLIERIDs
equal to ‘SUPL1".

Run the command and check the results.
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13501 Query Builder x|
| Twpe query expression here Skakus [Resultl ]
Status | operation | pate | connection. .. | mTEMID | sUPPLIERID | CoMPANYRAME
v Succeec SELECT*...  06f03/2012 ... CDO1RDMs 1 ITEMI SUPLL Anderson Supply
¥ Succeec SELECT CUS... 06/03/2012 ... CDOLRDMs £ ITEM SUPLL Anderson Supply

¥ Succeec SELECT OSU... 08/03/2012 ... CDOL ROMS
v Succeec SELECT OSU... 06/03/2012 ... CDOLRDMS

We can still edit the command in the upper pane. This might be necessary if you want to format in a
certain way. For example, you might want to copy the command into a COBOL program and
therefore the columns restrictions of 12 through 80 apply. After editing the command, you can run it
again to make sure no editing mistakes were made.

[ *ag phook 0 53 =5
Conneckion profile
lrlype: IGeneric JOBC_1.x j Marme: ICDDI ROMS j Dakabase: ISAMPLE 'l Skakus: Connected, Auto Commit
SELECT OQSUPPLYSTORE.STOREINVENTCRY.ITEMID, OSUPPLYSTORE.3TCREINVENTORY.SUPPLIERID, ‘:J
OSUPPLYSTORE.. 3TORESUPPLIER. COMPANYMNAME
FROM

OSZUPPLYITORE . STOREINVENTORY JOIH O3SUTPPLYSTORE.STORESUPPLIER
OH O3UPPLYITORE. 3TOREINVENTORY.3UPFLIERID = OSUPPLYSTORE.STORESUFPFLIER.IUFFLIERID
WHERE OSUPPLYSTORE.STOREINWENTORY.SUPPLIERID = 'ZUPL1Y

When satisfied, you can save this command or copy the command to paste into a program source. If
pasting into a 2200 program source, remember to open the OS 2200 perspective first. Then you can
open the appropriate source program if not already open.

Changing SQL Commands
The above example referred to the SELECT command which is used by default.

In the SQL Query Builder window, go to the middle right pane and right click on SELECT
Statement:

&dd Common Table Expression (WITH)
Conwert bo FULLSELECT (IUMICH

Change Statement Tyvpe. ..

]

Click on Change Statement Type.

-I:}Ehange SOL Statement Type El

Changing the S0 Statement Type will cause the current skatement to be replaced by a new empty statement.

"Statement tvpe

]

(0] 4 I Cancel |

Expand the list box to view the available SQL commands.

{"¥Change SQL 5
Zhanging the S0L ¢
Stakement bvpe —

SELECT
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Select the required command and then click OK. The SQL Query Builder changes for the selected
command. In the following example, INSERT was selected.

-I:}SQL Query Builder x|
INSERT INTO =

WVALUES

il

To add a table, right-click in this pane and use the pop-up menu,

------ ) 11SERT Statement

& walues € Subguery Query name:l [=]
Column | Yalue |
Edt [ SQL Results |
Ok | Canicel I

Note the difference in the lower pane. You can also only have 1 table shown in the middle left pane

since we are doing an INSERT.

-I:}SQL Query Builder

INSERT INTO OSUPPLYSTORE.STORECUSTOMER (CUSTOMERID,
STREETADDRESS, CITY, STATE, ZIPCODE, NOTES)
VALUES (' ROE', 'Robert', 'Jawieson', MNULL,

NULL)
il

NULL, NULL, NULL,

FNAME, LNAME,

STORECUSTOMER

| CUSTOMERID <=
| FMAME
| LMAME

mmmnrj_l

------ [3F INSERT Statement

£ values  Subquery Query name: I

Column | Value |

FMHAME

LMAME
STREETADDRESS
CITY

STATE

ZIPCODE

MOTES

‘Robert’
"lamieson'
MULL
MULL
MULL
MULL
MULL

I
-]

Edit [ SOL Resuks |

Ok

| Cancel I

If the column is defined to allow NULLSs, then NULL is used as the default value but can be

overwritten.

Avoiding the Schema Qualification

In the above examples, each field is qualified by schema, table and column e.g.
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OSUPPLYSTORE.STORESUPPLIER.SUPPLIERID

Generally in 3GL development on the OS 2200, a developer would issue a USE DEFAULT
QUALIFIER or USE DEFAULT SCHEMA statement to define the schema name. Both options are
valid but experienced OS 2200 developers maybe more familiar with the former while new OS 2200
developers may know the latter. If the field is not qualified with a schema name, it uses this default
qualifier value.

In many database systems, the default schema name is the user ID (or Authorization ID). However, in
RDMS the default schema name is always “rdms”. If you want to avoid using the schema name to
qualify all table names, you must set the default schema (also called the QUALIFIER) for the
connection. This is done by adding a connection property when you define the connection (e.g.,
schema=OSUPPLYSTORE). You can also tell the Eclipse SQL Builder to not add schema

names. Check the “Omit current schema” box, then select the “Schema name” option and enter your
schema name that you added to the connection properties (e.g., OSUPPLYSTORE).

Eclipse by default will include the schema in the field definition but it can be configured to omit the
schema name. Go to Preferences - Data Management = SQL Development 2 SQL Query
Builder.

o

SOL Query Builder - - -
E:tneral Default values For the Omit Current Schema settings associated with S0L stakements
__ Clt+ ¥ Omit current schema in generated SOL skatements
-- COBOL Current schema
= D:ata Managernent ' puthorization 10
[#]- Conneckivity
Label Decorations " schema name:
=- 3L Development
- Execution Plan Yiew C
- General
- 5chema Ohject Editor
[ 50U Edikar
a0l Query Builder
- 50L Results Yiew Opti
[#]- Fartran

Check the “Omit current schema” box.
The result is:

SELECT 3UPPLIERID, COMPANYNAME
FROM O3UPPLYSTORE.SZTORESUFFLIER
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Obtaining Eclipse Updates

Unisys provides an Eclipse update site to provide updates to a released version. The update site is
available as a link the email that you receive after registration.

Once the update site is downloaded, the following instructions provide the steps to process the update
site. Please follow the below process to update.

1. Inthe Eclipse window, Go to “Help” menu and choose “Install new Software”. In the Install
window, click on the “Available Software Sites” as shown below.

'I:P Install |Z||E|g|

Available Software

Select & site or enter the location of a site,

9

Wik, Wil;h:6 bvpe or select a site v | [ add. .. ]

Find more software by waorking with the|"available Software Sites"|preferences.

Mame Version
F (i) There is no site selected.

Details
[]Show only the |atest versions of available software [ ]Hide items that are already installed
[Jaroup items by cateqory What is already installed?

[Jcontact all update sites during install ta find required software

@

2. Now click the “Add” button to specify the location for the Eclipse 2200 All-in-One update
site. This should bring up the “Add Site” window. Enter the URL specified above in the
Location field.

£} Add Repository [‘$_<|

Mame: |22IZIIZI-Feature |[ Local... ]

Location: |jar:FiIe:,I'D:,I'OSEEI:II:I,I'Required-Jars-Fnr-usEEDD,l'EcIipse| [ archive. .. ]

®

3. We shall choose the 0S2200-feature label from the drop-down box with the label “Work
with” at the top of the dialog. (Note : We shall make sure that the “Contact all update sites
during install to find required software” option is UNCHECKED)

4. Now the two feature should be listed in the “Name” box, namely;
- com.unisys.ca.feature
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- org.eclipse.cobol.feature

We shall choose both these features and click on “Next” and in the following window accept
the licenses and finish the update process.

If you are using C or C++ editors, you have to update Eclipse with mandatory plug-ins (CDT and
JST) from the eclipse community (www.eclipse.org). Unisys also maintains these plug-ins on our
product site. Please be advised that this is the old version of CDT and JST. In case any customer
needs the latest plug-ins, they have to download it from www.elipse.org .

Clients can check for updates if there are any PLE's released. The client will know from product site if
there are any PLE raised and what were the issue reported and the fix provided in the update. Unisys
recommends for receiving alerts when new releases or updates are available.
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Appendix A — Eclipse Shortcut Keys

Eclipse Shortcut Keys
Use Ctrl+Shift+L to display a list of shortcut keys:

: Activate Editor F12
Activate Task Ctrl+F2
Add Artifact to Target Platform Ctrl+Alt+Shift+4
Add Javadec Comment Alt+5Shift+]
All Instances Ctrl+Shift+ M
Backward History Alt+Left
Browse VPG Ctrl+Alt+Shift+B
Build All Ctrl+B
Change Method Signature Alt+Shift+C
Close Ctrl+F4
Close All Ctrl+Shift+F4
Collapse Ctrl+Numpad_Subtract
Collapse All Ctrl+Shift+ Mumpad_Divide
Commit... Ctrl+#
ConfigTagCmd Ctrl+5Shift+F5
Content Assist Ctrl+5pace
Context Information Ctrl+Shift+5pace
Copy Ctrl+Insert
Copy Lines Ctrl+Alt+Down
Copy 05 2200 Path Ctrl+Alt+C
Cut Shift+Delete
Deactivate Task Ctrl+Shift+F3

The following is a list of some shortcuts.

CTRL+SHIFT+L Show all shortcuts
Editor Shortcuts Search
CTRL+D Delete line CTRL+H Search
ALT+Up Move line up (or CTRL+] Incremental
down)
ALT+Left Previous/next CTRL+K Find next
editor/file
CTRL+SHIFT+0O Organize Imports CTRL+SHIFT+K Find previous
CTRL+1 Quick Fix
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CTRL+M Maximize tab Debugging
CTRL+I Correct Indentation F5 Step Into
CTRL+SHIFT+F Format Code F6 Step Over
CTRL+L Goto Line Number F7 Step Return
CTRL+Q Last Edit Location F8 Resume
CTRL+T Display type F11 Debug Last
hierarchy Launched

F4 Show type hierarchy CTRL+SHIFT+B Toggle Breakpoint
F3 Type declaration
F2 Show info Opening
CTRL+O Quick outline CTRL+SHIFT+T Open type

CTRL+SHIFT+R Open resource
CTRL+. Next Error CTRL+E Show open editors
CTRL+, Previous Error CTRL+F6 Open editors

CTRL+W Close editor
CTRL+Space Content Assist CTRL+SHIFT+S Save all
CTRL+SHIFT+Sp | |Parameter Assist CTRL+SHIFT+W Close all
CTRL+/ Comment CTRL+N New project
ALT+/ Word Completion
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Moving
Refactoring CTRL+F7 Move between
views
ALT+SHIFT+R Rename CTRL+F8 Move between
perspectives
ALT+SHIFT+L Extract to local
variable
ALT+SHIFT+M Extract to method Running
ALT+SHIFT+Y Change method CTRL+F11 Run application
sighature
ALT+SHIFT+Z Undo refactoring CTRL+ALT+P Publish apps
CTRL+ALT+R Run In Appserver
CTRL+ALT+D Debug In
Appserver
ALT+SHIFT+X+T
Quick Key Function
Ctrl +/ Toggle Comment (*) indicator in col 7
Ctrl+Space Auto completion mode is invoked
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Appendix B — Japanese Usage

Japanese users should be aware of the Internationalization manual available using this link:

http://public.support.unisys.com/common/ShowWebPage.aspx?id=8405&pla=ps&nav=ps&elqTrackl
d=0c8a162e81b948fdbb7e99d14ebab0c3&elq=40173231f6d74e7792e9740b7af8b751&elqaid=3209
&elgat=1&elqgCampaignld=

The site shows a link to the manual:

Internationalization of OS 2200 Edlipse IDE | 8205 7043-000 | 30-Sep-16|1.1 MB

After the Eclipse installation, Japanese users need to enable the Babel package for Japanese which is
available from the Eclipse market place. Refer to the procedures in the above manual.
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Appendix B — Troubleshooting

Debugger

The following scenario was encountered.

[ eclipse-2200-4-6-0-160920 WS - Debug - DORADO*ROB.TEST/SSG ON 10.121.0.23 - Edlipse
File Edit Navigate Search Project Run 052200 Window Help

o NEEY & PUEE e B |G R B -0 - Q- EC 5~ - - -

45 Debug 52 4 Kut|iv v= 13 9y Breakpoints 37

4 (@ <terminated>UTEST [0S 2200 Launcher] ]

@ Waiting for program to start B
O
]
B
B
B
]
[ Multiple problems have occurred | (5
E¥a Aninternal error occurred during: "Label Job".

[2) TEST-SSGELT 52 q| &Y 3 = 3 Iz outlir
1@ssg, + Anoutl
e Label Job noutine
3 *display 'Enter program...' Label Job
4 *accept,e INP
5 *display 'Input = [*INP]'

5 @eof

7sgs

8 @eof

et

16 BOB

An internal error occurred during: "Label Job”, -
Could not initialize class i
T org.eclipse.cobol.debug.ui. COBOLDebuglmages ;

E) Console =] Tasks (2 Problems (3 Executables [J Memory 52 |, 052200 Host Manager View - CIFS [
Moniters =

To resolve, answer OK and then go to the Breakpoints view. Right click and select “Remove All”.
Then highlight the last entry in the Debug view (in this case “Waiting for program to start”. The right
click and select “Terminate and Remove”.
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